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Introduction

Welcome to SmartDraw For Dummies, the book written especially for 

those who are lucky enough to have discovered the best business 

graphics program on the market and want to find out how to use it in time 

to finish that report, sales presentation, or product brochure that was due 

yesterday.

Have you ever needed to create a graph of recent sales trends, but you didn’t 

want to create another cheesy, boring Excel graph that looks just like every 

other graph you’ve seen at every other sales meeting you’ve ever been to?

You need SmartDraw!

Have you ever been put in charge of a project and didn’t want to invest 

hundreds of dollars in sophisticated project management software, such as 

Microsoft Project, just to create a simple project schedule?

You really need SmartDraw!

Have you ever wanted to rearrange the furniture and equipment in your 

office and didn’t want to spend thousands of dollars on AutoCAD just to draw 

a simple floor plan?

You desperately need SmartDraw!

Whichever your business graphics needs, you’ve found the perfect book, 

and you’re holding it right now in your formerly magic-marker-stained hands. 

Help is here, within these humble pages.

This book talks about SmartDraw in everyday — and often irreverent — 

terms. You’ll find no lofty prose within these pages; the whole thing checks 

in at about the fifth-grade reading level. We have no Pulitzer expectations 

for this book; we leave that ambition for the Woodwards and Steinbecks 

among us.

Our goal here is to simply get you going as quickly as we can with the most 

powerful and easy to use business graphics software ever created. And hope-

fully, this journey of learning won’t be a tedious or miserable experience — in 

fact, maybe it will even be kind of fun.
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About This Book
This isn’t the kind of book that you pick up and read from start to finish as 

though it were a cheap novel. If we ever catch you reading it at the beach, 

we’ll kick sand in your face. Or better yet, we’ll get Clint Eastwood and have 

him kick sand in your face. You’ll listen to him.

This book is more like a reference book than a novel. It’s the kind of book you 

can pick up, turn to just about any page, read for a page or two, and learn 

something useful. It has 22 chapters, each one covering a specific aspect 

of using SmartDraw, like printing, creating flowcharts, or transforming a 

SmartDraw graphic into a PowerPoint animation.

Each chapter is divided into self-contained chunks, all related to the major 

theme of the chapter.

For example, the flowchart chapter contains nuggets like these:

 ✓ Looking at flowcharts

 ✓ Understanding all the shapes used in flowcharts

 ✓ Creating a basic flowchart

 ✓ Splitting paths

 ✓ Creating cross-functional flowcharts with swim lanes

You don’t have to memorize anything in this book. It’s a need-to-know book: 

You pick it up when you need to know something. Need to know how to 

create an organization chart? Pick up the book. Need to know how to create 

a table? Pick up the book. After you find what you’re looking for, put it down 

and get on with your life.

How to Use This Book
This book works like a reference. Start with the topic that you want to find 

out about: To get going, look for it in the table of contents or in the index. 

The table of contents is detailed enough that you should be able to find most 

of the topics that you look for. If not, turn to the index, where you find even 

more detail.

When you find your topic in the table of contents or the index, turn to the 

area of interest and read as much or as little as you need or want. Then close 

the book and get on with it.
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This book is loaded with information, of course, so if you want to take a brief 

excursion into your topic, you’re more than welcome. If you want to know all 

about the techniques for creating floor plans, read the chapter on floor plans. 

If you want to know all about applying color to a shape, read the chapter on 

color and design themes. Read whatever you want. You paid good money for 

this book, so read every word if you want. (Just not at the beach.)

On occasion, this book directs you to use specific keyboard shortcuts to get 

things done. When you see something like “Press Ctrl+Z,” this instruction 

means to hold down the Ctrl key while pressing the Z key. (Don’t type the 

plus sign.) Then release both together.

Sometimes we tell you to use a command that resides on one of the main 

toolbar’s tabs. (SmartDraw uses a ribbon interface similar to those in 

Microsoft Office applications.) We tell you exactly how to find the command. 

For example, we might tell you something like this: On the main toolbar, click 

the Chart tab, find the Insert Chart group, and click the New Chart button.

Another nice feature of this book is that whenever we discuss a certain 

button that you need to click in order to accomplish the task at hand, a pic-

ture of the button appears in the margin. This way, you can easily locate it on 

your screen.

What You Don’t Need to Read
Some parts of this book are skippable. We carefully place extra-technical 

information in self-contained sidebars and clearly mark them so that you can 

give them a wide berth. Don’t read this stuff unless you just gots to know. 

Don’t worry; we won’t be offended if you don’t read every word.

Foolish Assumptions
We make only three assumptions about you:

 ✓ You use a computer.

 ✓ It’s a Windows computer — not a Mac.

 ✓ You use or are thinking about using SmartDraw.

Nothing else. We don’t assume that you’re a computer guru who knows how 

to change a controller card or configure memory for optimal use. These 

types of computer chores are best handled by people who like computers. 
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Hopefully, you’re on speaking terms with such a person. Do your best to stay 

there for those times when you’re working with computer stuff that’s more 

difficult than SmartDraw.

How This Book Is Organized
Inside this book are chapters arranged in five parts. Each chapter is divided 

into sections that cover various aspects of the chapter’s main subject. The 

chapters have a logical sequence, so it makes sense to read them in order, if 

you want. But you don’t have to read the book that way; you can flip it open 

to any page and start reading.

The following sections give you the lowdown on what’s in each of the five 

parts:

Part I: Getting Started with SmartDraw
In this part, you review the basics of using SmartDraw. This is a good place 

to start if you’ve never used SmartDraw, or if you’ve used it a few times but 

feel lost every time. Its five chapters take you on a tour of the SmartDraw 

windows and controls, walk you through creating a simple drawing from start 

to finish, tell you how to create simple shapes and lines and add text to them, 

and tell you what you need to know about printing your drawing.

Part II: Embellishing Your Graphics
The chapters in this part show you how to make business graphics that look 

good. SmartDraw is actually pretty good at that, but it helps to know about 

its powerful features for applying color, fancy effects, and design themes, as 

well as how to add interesting things such as tables and images to your draw-

ings. You also find out how to work with layers, one of SmartDraw’s most 

powerful features for more complicated drawings.

Part III: Creating Business Graphics
The chapters in this part focus on the most common types of graphics you 

can create with SmartDraw. We tell you how to work with charts, including 

bar charts, line charts, pie charts, flowcharts, organization charts, and proj-

ect charts. We also give you instructions for creating floor plans, mind maps, 

and Live Maps.



5 Introduction

Part IV: Using SmartDraw with 
Microsoft Office and the Web
One of the best features of SmartDraw is the way it integrates with Microsoft 

Office and the Internet. The first two chapters in this part show you how to 

use SmartDraw’s Office integration features, which let you easily transfer 

drawings from SmartDraw into Word, Excel, or PowerPoint. You also find out 

how to take your SmartDraw creations to the Web.

Part V: The Part of Tens
This wouldn’t be a For Dummies book without lists of interesting snippets. 

Thus, you find chapters with titles such as Ten SmartDraw Commandments, 

Ten Odd and Unusual SmartDraw Templates, Ten Tips for Creating Great 

Business Graphics, and Ten Things You Didn’t Think to Use SmartDraw For.

About the CD
The CD that comes with this book contains lots of stuff to help you be pro-

ductive with SmartDraw. It includes a 30-day, fully functional trial version of 

SmartDraw 2009. There are also many example files that you can use as you 

go through the book. There are also some reference materials, including the 

Encyclopedia of Business Graphics poster in PDF format and a number of 

SmartDraw best practice PowerPoint presentations.

Icons Used in This Book
As you’re reading all this wonderful prose, you occasionally see the following 

icons. They appear in the margins to draw your attention to important infor-

mation. They’re defined as follows:

 

Watch out! Some technical drivel is just around the corner. Read it only if you 

have your pocket protector firmly attached.

 

Pay special attention to this icon — it tells you that some particularly useful 

tidbit is at hand, perhaps a shortcut or a way of using a command that you 

might not have considered.



6 SmartDraw For Dummies 

 Danger! Danger! Danger! Stand back, Will Robinson!

 

Did we tell you about the memory course we took?

Where to Go from Here
Yes, you can get there from here. With this book in hand, you’re ready to 

charge full speed ahead into the strange and wonderful world of desktop 

drawings. Browse through the table of contents and decide where you want 

to start. Be bold! Be courageous! Be adventurous! Above all else, have fun!



Part I
Getting Started 

with SmartDraw



In this part . . .

Once upon a time, the term business graphics meant 

bar charts and pie charts. But now that you’ve 

decided to equip your software arsenal with SmartDraw, 

business graphics can mean so much more. With 

SmartDraw, you can create literally hundreds of different 

kinds of graphics — business or otherwise. SmartDraw 

can create a graphic to fill just about any need you can 

imagine — from flowcharts and organization charts to 

floor plans and mapping.

The chapters in this part comprise a bare-bones introduc-

tion to SmartDraw. You find out exactly what SmartDraw 

is and how to use it to create drawings and graphics. You 

discover how to create and edit simple shapes, how to 

work with text, and how to print your masterpiece.

More advanced stuff such as working with themes or 

using the advanced tools for creating specific types of 

graphics like flowcharts and floor plans is covered in later 

parts. This part is just the beginning. As a great king once 

advised, “It’s best to begin at the beginning and go on 

until you come to the end; then stop.”



Chapter 1

Welcome to SmartDraw
In This Chapter
▶ Introducing business graphics

▶ Considering how business graphics differ from other types of graphics

▶ Finding out what kinds of business graphics you can create with SmartDraw

Welcome to SmartDraw, a program that lets you create professional-

quality business graphics even if (or maybe especially if) you aren’t a 

professional business graphic artist.

Sure, you can use many programs to create business graphics. You may even 

already own some of them. But most of these programs are limited to just 

one or two specific types of business graphics. For example, Microsoft Excel 

can create pie charts, bar charts, and the like. But Excel isn’t very good at 

creating project charts to schedule the various phases of a project. You can 

use Microsoft Project to do that, but Project isn’t very good with floor plans 

or schematics. AutoCAD is really good with floor plans and schematics, 

but . . . well you get the idea.

In contrast, SmartDraw is a tool for creating just about any type of business 

graphic you might imagine. In fact, SmartDraw can create literally hundreds 

of different types of business graphics, from area charts to yearly calendars. 

(Sorry. There isn’t a business graphic that starts with the letter z — but if 

there were one, we guarantee SmartDraw could create it!)

This chapter is a gentle introduction to this powerful program. It begins with 

an overview of what business graphics are all about. Then, it jumps into the 

basics of working with SmartDraw. When you finish this chapter, you’ll have 

a good idea of the range of business graphics SmartDraw can create, and 

you’ll be ready to use it to create them.

You, Too, Can Create Business Graphics
In today’s business world, few people take the time to read 100 words, let alone 

1,000. In the era of text messaging, sometimes even just ten words are too many.
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That’s why we use business graphics. Often, you can find no other way to 

make your point clearly, persuasively, or powerfully than with a carefully 

chosen image. Business graphics have the power to convince others and 

to explain at a glance something that can be difficult or even impossible to 

express in words.

Now, you may balk at the term business graphics. Your first response might 

be, “Not for me! Fancy business graphics are great for big Fortune 500 compa-

nies, but my business is small enough that I don’t need ’em.”

Or maybe your response is, “Business graphics would be great if I had half an 

ounce of artistic ability. But every diagram I ever tried to create looks like it 

was drawn by a third grader.”

Or maybe: “I wish I had the budget to hire a professional graphic designer to 

add some polish to my reports and proposals, but the simple charts I create 

with Excel will have to do.”

Although you may not realize it, you probably use business graphics all the 

time. And not just simple pie charts you’ve thrown together quickly with 

Excel. You’ve created business graphics over the years, if you’ve done the 

following:

 ✓ Sketched a few boxes with names in them to show the chain of com-

mand in your business. If so, you’ve drawn an organization chart, one of 

the most common business graphics. (Hopefully, your name was in the 

box at the top.)

 ✓ Planned your office’s layout by sketching some lines to represent the 

walls, then drawn some rectangles to show where you want desks, 

chairs, and shelves. If so, you’ve created a floor plan. (Hopefully, your 

office was the one in the corner, with the big window overlooking the 

lake.)

 ✓ Drawn lines through a calendar to show how long it should take to com-

plete various stages of a project. If so, you’ve created a Gantt chart.

 ✓ Sketched the steps necessary to complete a task such as filling out and 

submitting a medical insurance claim, using boxes to represent the 

steps and arrows to show how one step flows to the next. If so, you’ve 

created a flowchart.

Then, maybe you’ve taken the tools that happen to be lying around — typi-

cally Word, Excel, or PowerPoint — and dropped a few clumsy rectangles or 

circles on the page, plopped down some text to explain what the shapes rep-

resent, and then scratched out some lines to connect things together.



11 Chapter 1: Welcome to SmartDraw

So you see, you’ve been creating business graphics all along. But you’ve been 

doing it the hard way. You’ve used crude drawing tools to create things that 

the tools were never intended to create, and you might have spent most of 

your time trying to get things to line up or be the right size or color. Then 

maybe you’ve added some cheesy clip art or shadow effects in an attempt to 

make your drawing look halfway decent.

Most of the time, what you end up with is a drawing that barely communi-

cates the message you originally intended, is difficult to make even the slight-

est change to later on, and looks terrible.

 

That’s where SmartDraw comes in. Unlike most other programs, SmartDraw 

doesn’t consider business graphics an afterthought. The whole point of 

SmartDraw is to create sensational business graphics — not just graphics 

that look good, but graphics that, in some cases, practically draw themselves 

because they have built-in intelligence.

And SmartDraw isn’t limited to just one kind of business graphic. It’s 

designed to create dozens of different kinds of business graphics. When you 

learn how to use the core set of drawing tools presented in the first eight 

chapters of this book, you’ll be able to draw just about any kind of business 

graphic imaginable.

Comparing SmartDraw to 
Other Drawing Programs

Before we get too far into how SmartDraw works and what you can use it for, 

we need to point out some key differences between SmartDraw and other 

kinds of drawing programs.

To start, realize that SmartDraw is designed to create business drawings, not 

artistic or technical drawings. The best known examples of artistic drawing 

programs are Adobe Illustrator and CorelDraw. These programs are designed 

to be used by professional artists and photographers to create professional-

quality art. Adobe Illustrator and CorelDraw are sometimes used in business 

to create the more artistic variety of business graphics, such as company 

logos, flyers, posters, and so on. But their primary purpose is artistic, and 

their primary users are professional graphic artists.

The best known technical drawing program is AutoCAD, made by Autodesk. 

Drafting and computer-aided design (CAD) programs are designed to create 

precision technical drawings that represent real-world objects, such as build-

ings, bridges, or roller coasters.
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Both of these types of drawing programs require great artistic or technical 

skill. And they both have a long learning curve to master. Plop a typical com-

puter user down in front of a program like Photoshop or AutoCAD and he or 

she will spend hours just trying to figure out basic things like how to draw a 

simple rectangle or how to select an object that appears to be sitting in plain 

view. These are powerful programs, but they’re anything but easy to use.

SmartDraw doesn’t fit into either of these two categories. Although you 

can use SmartDraw to create drawings that are artistically pleasing and 

encompass some degree of technical precision, SmartDraw has an entirely 

Give me a vector, Victor!
One useful way to classify drawing programs 
is the distinction between bitmap and vector 
drawing programs. SmartDraw is a vector-
based drawing program.

Here’s the skinny:

 ✓ A bitmap drawing program is a program 
that treats graphics as a big collection 
of dots called pixels. Bitmap images are 
also referred to as raster images. Adobe 
Photoshop is the best-known example of a 
bitmap graphics program.

 ✓ A vector drawing program is a program 
that treats graphics as actual shapes rather 
than as a group of pixels. The program 
keeps track of all of the characteristics that 
make up each shape in a drawing, such as 
the type of shape (for example, a circle, 
rectangle, line, and so on), as well as other 
properties like the exact size and position of 
the shape, the shape’s color, and so on.

There are advantages and disadvantages to 
both types of drawings. Bitmaps are usually 
best suited for photographs and other types of 
artistic drawings. Vector images are best suited 
for business graphics and technical drawings.

The key difference between a bitmap drawing 
program and a vector drawing program is that 

when you draw an object in a bitmap program, 
the drawing doesn’t keep track of any informa-
tion about the object except the pattern of pixels 
required to display the object. For example, a 
bitmap drawing program doesn’t know that a 
circle is actually a circle or that a line is actually 
a line. Instead, everything in the entire image is 
just a big blob of dots.

In contrast, a vector drawing program is essen-
tially a database that keeps track of information 
about all the various shapes that make up the 
drawing.

An important consequence of this is that you 
can easily scale vector drawings. With a bitmap 
image, the picture becomes coarser the more 
you zoom in. If you zoom in far enough, the 
image becomes a big blur of dots. In contrast, 
you can enlarge (or reduce) a vector drawing 
as much as you want and it still remains per-
fectly clear.

Note that the distinction between bitmap and 
vector drawing programs isn’t absolute. In par-
ticular, vector drawing programs can include 
bitmap images embedded within the drawing. 
You learn how to incorporate bitmap images 
into your SmartDraw business graphics in 
Chapter 8.



13 Chapter 1: Welcome to SmartDraw

different purpose than Photoshop or AutoCAD. SmartDraw is designed to 

create a wide variety of commonly used business graphics, diagrams, and 

charts using lines, simple and complex geometric shapes, and other ready-

made objects that you can simply drag and drop onto your drawings.

 

Here are some of the key features that set SmartDraw apart from other types 

of drawing programs:

 ✓ SmartDraw comes with hundreds of predefined drawing templates 

that you can start from to create just about any kind of business 

graphic. And we really mean hundreds — it has more than 1,900 

templates in all. In fact, one of the most challenging aspects of using 

SmartDraw is choosing the perfect template for your drawing from 

among the vast array of templates.

 ✓ SmartDraw is a vector-based program. It keeps track of the individual 

shapes that make up a drawing rather than the individual dots that make 

up a picture. (For more information, see the sidebar, “Give me a vector, 

Victor!”)

 ✓ SmartDraw requires very little artistic skill to create great-looking 

drawings. Throughout the program, you’ll find features designed to help 

you create drawings that look professionally drawn. Most of the time, all 

you have to do is drag and drop predefined elements onto a predefined 

template and apply predefined formats and themes.

 ✓ One of the most important features of SmartDraw is its built-in 

intelligence — that is, the Smart in SmartDraw. Most graphics pro-

grams are little more than digital versions of an artist’s tools: canvas, 

paint, brushes, easel, and so on. The tools are great, but you’re on your 

own to use them to create something worth looking at. In contrast, 

SmartDraw contains intelligence that actually helps you draw your 

graphics. It’s almost as if a skilled graphic artist is sitting next to you, 

nudging your mouse in the right direction as you create your graphics.

  You’ll see plenty of examples of this intelligence throughout SmartDraw. 

For example, when you create an organization chart, the software takes 

care of the tedious task of connecting the boxes to each other with lines. 

All you have to do is drop the boxes onto the page in their approximate 

locations; SmartDraw snaps the boxes into the exact right spot, then 

automatically draws the connecting lines.

 ✓ SmartDraw is less expensive than other graphics programs. Last time 

we checked, Microsoft Visio sells for about $400; Adobe Illustrator about 

$600; and AutoCAD LT — the simplified version of AutoCAD — is nearly 

$1,000. In contrast, you can purchase SmartDraw for under $300.
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Knowing What You Can Do 
with SmartDraw

SmartDraw is a powerful program that you can use to create any type of busi-

ness graphic you can conceive of. If you haven’t opened SmartDraw yet and 

looked at the list of templates in the left-hand panel, you might want to try it 

now. You find the following categories:

Accounting & Finance Human Resources

BPM & Six Sigma Landscaping

Calendars Maps

Cause & Effect Marketing Charts

Certificates Mind Maps

Charts Network Design

Decision Trees Org Charts

Education Project Management

Engineering Retail & Planograms

Event Planning Simple Diagrams

Family Trees Software Design

Financial & Estate Planning Storage Design

Floor Plans Storyboards

Flowcharts Strategic Planning

Flyers Timelines

Forms Web Design

Gantt Charts

This list doesn’t even include the subcategories that are found within most 

categories. For example, you’ll find seven subcategories under Human 

Resources, including Employment Forms and HR Scorecards. And under 

Marketing Charts, you’ll find 34 subcategories, including Affinity Diagrams, 

Competition Matrix, Competitive Analysis, Marketing Trends Summary, 

Strategy Maps, and Venn Diagrams. 
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In short, SmartDraw can create almost anything you can imagine, and prob-

ably quite a few things you never imagined. You’ll probably never use more 

than a handful of these diagrams, but even that handful — especially the core 

business graphics — have the power to radically improve the way you do 

business.

In the following sections, we show just a few of the most commonly used 

templates, just to give you a feel for the types of business graphics you can 

create with SmartDraw.

Flowcharts
A flowchart is a diagram that graphically shows the steps that must be fol-

lowed to complete a procedure or task. Flowcharts, also known as process 
charts, were the foundation of SmartDraw version 1.0 in 1995, and the flow-

chart tool remains one of its most powerful and distinctive features, even 

today. SmartDraw simply excels at making flowcharts.

If the very idea of a flowchart makes you cringe, relax. It’s true that flow-

charts are often used for complicated and technical applications such as 

managing an oil refinery or launching the space shuttle. But flowcharts aren’t 

just for mind-boggling applications like those. Every business has processes. 

And even if your company’s most complicated process is mailing a package 

or taking a phone call, a flowchart is often the best way to document and 

improve that process.

SmartDraw comes with more than 40 templates for creating various types of 

flowcharts. Figure 1-1 shows just one example.

Flowcharts are so powerful in SmartDraw that Chapter 11 is devoted to them.

Organization charts
Everyone has seen an organization chart — those diagrams that show the 

management structure of a company with a box for each employee and lines 

to indicate who reports to whom. Many of us have suffered the thankless 

and tedious task of drawing them. SmartDraw can’t remove the thankless 

part from the task, but it can definitely help with the tedious part. Figure 1-2 

shows an example of an organization chart — an org chart, as SmartDraw 

calls them.
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Figure 1-1: 
A flowchart.

 

The best part about creating organization charts in SmartDraw is that 

SmartDraw practically does all the work for you. SmartDraw automatically 

takes care of drawing the lines that connect the boxes to one another and 

indicate the working relationships. You can drag boxes around the page, 

and SmartDraw automatically adjusts the entire chart to match the new 

configuration.

 

One especially nice feature is that you can drop photos of employees into the 

chart and SmartDraw attaches them to their boxes. You can even zoom, crop, 

resize, and edit the photos right in the chart.

For more information about creating organization charts with SmartDraw, see 

Chapter 12.
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Figure 1-2: 
An organi-

zation chart.
 

Project (Gantt) charts
A project chart, also known as a Gantt chart, is a kind of horizontal bar chart 

used to track the schedule of a project. If you’re a professional project man-

ager and spend several hours every day crafting Gantt charts, you should 

probably invest in expensive software specifically designed for project 

management, such as Microsoft Project. But if you just need to create an 

occasional Gantt chart, there’s no need to invest in a separate program. 

SmartDraw is very adept at creating Gantt charts like the one shown in 

Figure 1-3.

 

Figure 1-3: 
An Gantt 

chart.
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The horizontal bars on a project chart represent tasks. The horizontal axis 

of the chart represents time. The length of the bars on the chart shows how 

much time each task will take, and it identifies when the task will start and 

when it will end. You can add special symbols to the chart to represent mile-

stones or dependencies, and of course SmartDraw has ready-made libraries 

of these symbols.

The beauty of a project chart is that it lets you see, at a single glance, the 

status of all the various tasks in a project that are happening simultaneously. 

Project charts are continuously updated to reflect the current status of each 

task, so you can see which parts may be falling behind, or even (in some 

alternate universe, perhaps) ahead of schedule.

For more information about using SmartDraw to create Gantt charts, see 

Chapter 14.

Mind maps
If a mind map sounds like something from Star Trek, don’t worry; you won’t 

have to put your head in a scanner or anything. (Although that could be a real 

timesaver. Maybe a future version of SmartDraw will include this as an option!) 

A mind map is just a visual way of organizing your ideas. See Figure 1-4.

 

Figure 1-4: 
A mind map.

 

A mind map is the visual equivalent of a text outline, the kind where you 

have main topics, followed by subtopics, followed by sub-sub-topics, and so 

on down the line. The benefits of sketching a mind map rather than writing 

a text outline is that the mind map engages the creative side of your brain 

and can often reveal new perspectives or solutions that you wouldn’t have 

noticed within the linear constraints of a text outline.
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As you would expect, SmartDraw has built some nice intelligence into its 

mind maps. For starters, you can easily convert a mind map to a text 

outline — a real timesaver for creating presentation bullet points or a table 

of contents! And you can also easily convert a mind map into a Gantt chart.

For more information about creating mind maps in SmartDraw, see Chapter 14.

Bar charts and graphs
When most people think of business charts, they of think of the basic bar 

chart or pie chart. Naturally, SmartDraw excels at creating these types of 

charts. Figure 1-5 shows an example of a bar chart and a pie chart created 

with SmartDraw.

 

Figure 1-5: 
Examples of 

bar charts 
and pie 
charts.

 

 

An Express Charts feature lets you simply type numbers into the bars, or pie 

slices, and the chart remakes itself to match your figures. You don’t have to 

create a spreadsheet or data table first.

SmartDraw can make the following variations on these basic data charts as 

well:

 ✓ Area chart

 ✓ Layered area chart

 ✓ Stacked bar chart

 ✓ Line chart

 ✓ Relative value chart
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One of the most interesting features of SmartDraw for creating bar and pie 

charts is its ability to substitute images or clip art for the bars or pie seg-

ments. This can lead to visually engaging charts, such as the one shown in 

Figure 1-6.

For more information about creating bar and pie charts, see Chapter 10.

 

Figure 1-6: 
An image 

chart.
 

Floor plans
A floor plan is one of those things that nearly everyone needs to make at one 

time or another — whether you’re rearranging office cubicles, redecorating 

a room, or moving to a new building and trying to decide if your old furni-

ture will fit. But the software traditionally used to create floor plans, such as 

AutoCAD, tends to be very expensive and difficult to learn.

Fortunately, SmartDraw has more than 50 templates specifically for creating 

floor plans. Figure 1-7 shows a floor plan created with one of them.

SmartDraw provides libraries with hundreds of ready-made objects for floor 

plans, including furniture, light fixtures, plants, windows, doors, and even 

technical stuff like plumbing and wiring. And SmartDraw’s floor plan tem-

plates have all the smarts you need to draw perfect rooms, walls, and build-

ings to place it all in.
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Figure 1-7: 
A floor plan.

 

Your floor plan need not stop at the walls of your building, either. SmartDraw 

can help you with landscape plans as well, so you can design anything from 

your home garden to your company’s office campus, right down to the last 

shrub and sprinkler.

If you want to find out more, you’re in luck. Chapter 13 is devoted to teaching 

you how to create floor plans with SmartDraw.
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Chapter 2

Creating a Business Graphic 
with SmartDraw

In This Chapter
▶ Firing up SmartDraw

▶ Creating a business graphic from scratch

▶ Getting used to the SmartDraw user interface

▶ Saving your work

▶ Getting help

This chapter introduces you to the basics of creating business drawings 

with SmartDraw. In this chapter, we show you how to create a simple 

organization chart. Note, however, that the basic techniques you discover in 

this chapter apply for any type of SmartDraw graphic.

Along the way, you find out how to use the various features of SmartDraw’s 

user interface, including the main toolbar and its various tabs, the 

SmartPanel, the SmartDraw button, and other odds and ends.

Starting SmartDraw
Like any other Windows program, you can start SmartDraw in several ways. 

Here are the most common:

 ✓ Double-click the SmartDraw icon on your desktop.

 ✓ Click the Windows Start button, then choose All Programs➪SmartDraw 

2009➪SmartDraw 2009.

 ✓ If you’ve used SmartDraw recently, click the Windows Start button, then 

look for SmartDraw on the frequently used program list that appears.
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 ✓ Double-click any SmartDraw drawing from Windows Explorer. 

(SmartDraw documents are named using the filename extension .sdr. 

Note that SmartDraw drawings are called both drawings and documents. 
We use the terms somewhat interchangeably throughout this book.)

 If you want SmartDraw to always appear at the top of the Start menu, choose 

Start➪All Programs➪SmartDraw 2009, then right-click SmartDraw 2009 and 

choose the Pin to Start Menu command.

Welcome to the Document Browser
Most programs begin by displaying their main screen and require you to take 

the additional step of opening an existing document or creating a new docu-

ment. Not SmartDraw; it begins by displaying a special Document Browser 

window (shown in Figure 2-1) that helps you get started quickly.

 

Figure 2-1: 
The 

Document 
Browser.

 

Saved Documents tab

Category List

SmartHelpNew Document tab

SmartTemplates
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Take a moment to familiarize yourself with the main parts of this window.

 ✓ New Document: This tab, displayed by default, lets you create a 

new document based on one of the many templates supplied with 

SmartDraw.

 ✓ Saved Documents: This tab lets you open an existing SmartDraw docu-

ment. For more information, see the section “Opening an Existing 

Drawing” later in this chapter.

 ✓ Category List: This panel displays a list of categories you can choose 

from. When you click one of these categories, a list of available tem-

plates appears in the SmartTemplates area of the Document Browser.

  The first item in the Category List isn’t really a category for creating a 

new document; instead, it’s just a shortcut for the Saved Documents tab.

  The second item in the Category List — My Favorites — is initially 

empty. As you work with SmartDraw and discover which templates you 

like to use the most, you can add those templates to the My Favorites 

category. Just right-click any template and choose Add to Favorites.

 ✓ SmartTemplates: This area displays thumbnail views of the various tem-

plates that are available for each category. To create a drawing based on 

one of these templates, click its thumbnail image.

  For most categories, the templates are organized into two or more 

groups. The first group is often a basic group that contains templates 

that are empty or nearly empty, designed for creating generic draw-

ings from scratch. The other groups contain more developed drawings 

that can often save you a lot of time when you create more complicated 

drawings.

 ✓ SmartHelp: This pane provides help information. You’ll see this pane 

frequently as you work with SmartDraw. The SmartHelp pane automati-

cally adjusts the information it displays based on the task at hand, so 

odds are that when you get stuck, the information you need to help you 

get unstuck is already displayed in this pane. (At least that’s the theory. 

Without actually connecting electrodes to your head, it’s difficult for 

SmartDraw to actually know what you’re thinking.)

Creating a Simple Drawing 
from Start to Finish

Enough of the overview; here are the actual steps for creating, saving, and 

printing a new drawing — in this case, an organization chart:
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 1. Start SmartDraw.

  You can use any of the techniques described in the earlier section, 

“Starting SmartDraw.”

 2. Select a category.

  Click one of the categories in the Category List to display thumbnails of 

the templates that belong to that category. For example, if you click the 

Org Charts category, a set of nine different templates for organization 

charts is displayed in the SmartTemplates area, as shown in Figure 2-2.

 

Figure 2-2: 
Templates 
displayed 

for the Org 
Charts 

category.
 

 3. Click the SmartDraw template you want to use.

  SmartDraw then creates a new drawing based on the template you 

select. For example, Figure 2-3 shows a drawing based on the Blank Org 

Chart template.

 4. Edit the drawing.

  Most of the rest of this book is devoted to showing you how to do that. 

You can find some brief pointers to get you started later in this chapter, 

in the section “Editing Your Drawing.” 
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Figure 2-3: 
A new 

organization 
chart draw-

ing based 
on the Blank 

Org Chart 
template.

 

 5. To print your masterpiece, click the Print button.

  The Print button is located near the top-left side of the window. For 

more information about printing, turn to Chapter 5.

 6. To save the drawing, click the Save button.

  The Save button is located near the top-left side of the window. For more 

information about saving drawings, see the section “Saving Your Work” 

later in this chapter.

Looking at the SmartDraw User Interface
When you’ve selected a template to create a new drawing, or when you’ve 

opened an existing drawing, SmartDraw displays its main drawing screen, 

which is cluttered with enough gadgets and controls that you might be 

tempted to trade SmartDraw for a stack of construction paper and a box of 

crayons.
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Don’t do it! With just a few minutes of orientation, the SmartDraw screen 

comes into focus, and you can quickly come to appreciate the power offered 

by its many user interface features.

Figure 2-4 shows the basic SmartDraw user interface screen with the major 

doohickeys labeled for your convenience.

 

Figure 2-4: 
SmartDraw’s 

cluttered 
screen.

 

Single-Click toolbar

SmartDraw button

Main toolbar Work area toolbar

SmartPanel Library Drawing area

The following list explains each of these labeled parts:

 ✓ Drawing area: Right smack in the middle of the SmartDraw window, and 

taking up most of its space, is the drawing itself.

 ✓ Main toolbar: Across the top of the screen, just below the SmartDraw 

title, is SmartDraw’s main user-interface gadget, officially called the 

main toolbar. If you’ve worked with recent versions of Microsoft Office, 

you’ll recognize right away that this toolbar is modeled after The Ribbon 

found in Office applications such as Word, PowerPoint, and Excel.
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  If you've never worked with a ribbon-style interface, the main toolbar 

may take some getting used to. But after you figure it out, it actually 

does become easier to use than old-style menus and toolbars.

  The exact appearance of the main toolbar varies a bit depending on the 

size of your monitor. On smaller monitors, SmartDraw may compress 

the main toolbar by using smaller buttons, arranging them differently, or 

showing fewer of them.

  For more information about working with the main toolbar, see the sec-

tion “Unraveling the Main Toolbar” later in this chapter.

  ✓ SmartDraw button: The SmartDraw button is the big icon that appears in 

the top-left portion of the SmartDraw window. You can click this button 

to reveal the SmartDraw menu, which has the following commands:

 • New: Creates a new drawing.

 • Open: Opens an existing drawing.

 • Save: Saves the current drawing.

 • Save As: Saves the current drawing using a new filename.

 • Print: Prints the current drawing.

 • Export: Converts the current drawing to a different file format.

 • Email: Sends the current drawing as an e-mail message.

 • Spell Check: Checks the spelling in the current drawing.

 • Options: Lets you set several SmartDraw options.

 • Utilities: Provides access to several utility functions.

 • Close: Closes the current document.

 • Exit: Exits the SmartDraw program.

 ✓ Single-Click toolbar: This toolbar is located right next to the SmartDraw 

button, above the main toolbar. It consists of the following buttons:

 • Undo: Reverses the most recent action.

 • Redo: Re-applies whatever action was most recently undone — in 

other words, the Redo button undoes the last undo.

 • New: Creates a new drawing.

 • Save: Saves the current drawing.

 • Print: Prints the current drawing.

 • Export as PDF: Creates a PDF of the current drawing.

 • Export to Word: Converts the current drawing to a Word document.

 • Export to Excel: Converts the current drawing to an Excel document.

 • Export to PowerPoint: Converts the current drawing to a PowerPoint 

document.
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 ✓ Work Area toolbar: This is a small toolbar that’s located just above the 

main drawing area. It contains two buttons:

 • Zoom: Adjusts the zoom factor to make your view of the drawing 

larger or smaller. For more information, see the section “Zooming 

in” later in this chapter.

 • Rulers: Shows or hides the rulers on the left and top edges of 

the drawing area. By default, the rulers are hidden, but you can 

summon them by clicking this button. Figure 2-5 shows what 

SmartDraw looks like with the rulers visible, which helps you visu-

ally gauge the size and position of objects in your drawing.

 ✓ SmartPanel: The SmartPanel appears to the left of the drawing area. 

It’s called the SmartPanel because the controls that appear in this panel 

adjust themselves depending on the template you’re using. For example, 

when you create an organization chart, the SmartPanel contains controls 

that are unique to organization charts, such as Add Employee Below and 

Add Assistant. But if you’re creating a floor plan, the SmartPanel con-

tains commands like Add Single Wall or Show Dimensions.

 ✓ Library: You use this tab to add new shapes to your drawing. For more 

information, see Chapter 3.

 

Figure 2-5: 
The drawing 

area with 
the rulers 

visible.
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Unraveling the Main Toolbar
The main toolbar is patterned after The Ribbon interface used in Microsoft’s 

Office products. As a result, if you’ve worked with Office 2007, you should 

have no trouble working with SmartDraw’s main toolbar.

The interface used by the main toolbar is a sort of hybrid of traditional 

menus and toolbars. Across the top is a series of tabs that resemble tradi-

tional menus. But when you click one of these tabs, a separate pull-down 

menu doesn’t appear. Instead, each tab brings up a different collection of 

commands. Whenever you change tabs, a different set of commands appears.

The SmartDraw main toolbar displays the following nine tabs:

 ✓ Home: Contains the most common commands for working with 

SmartDraw drawings, including commands for working with the clip-

board (copy, cut, and paste), selecting objects, creating shapes and 

lines, applying themes and styles, and formatting text.

 ✓ Design: Commands that affect the design and appearance of the shapes 

in your drawing, including the size and position of individual shapes, 

alignment and layout commands, and other shape properties.

 ✓ Insert: Commands for inserting things into your drawing. You can insert 

tables, pictures, charts, notes, maps, Web pages, and hyperlinks.

 ✓ Page: Commands for adjusting the page layout. You can use this tab to 

set the page background, the page orientation and margins, and ruler 

and grid options. Strangely enough, the Find and Replace commands 

are also located on this tab. (In most programs that use the ribbon 

interface — including Microsoft Office programs — these commands 

are on the Home tab. Go figure.)

 ✓ Table: Commands for working with tables. (For more information about 

this tab, refer to Chapter 7.)

 ✓ Chart: Commands for working with charts. (For more information, refer 

to Chapter 10.)

 ✓ Picture: Commands for working with pictures. (For more information, 

refer to Chapter 8.)

 ✓ PowerPoint: Commands for exporting drawings to Microsoft 

PowerPoint. (For more information, refer to Chapter 17.)

 ✓ Help: Commands for getting help with SmartDraw. For more informa-

tion, see the section “Getting Help” later in this chapter.
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Editing Your Drawing
A SmartDraw drawing is essentially a collection of shapes. When you create 

a drawing from a template, an initial set of shapes is added to the drawing. 

But to transform a template into a finished drawing, you’ll almost always edit 

those initial shapes and add shapes of your own.

Most of the rest of this book is devoted to showing you how to do that. And 

the next chapter in particular presents many of the techniques you’ll use 

most often to add and edit shapes. But to get you started, the following sec-

tions present a brief overview of the most common techniques for editing 

and adding shapes.

Editing shapes
To edit a shape, first click the shape to select it. When it’s selected, you can 

drag the shape to a new location, or you can drag one of the corner or edge 

handles to resize the shape.

You can select more than one shape by holding down the Ctrl key while click-

ing each shape. Or you can click and hold the mouse outside of any shape, 

then drag the mouse to trace a selection box. When you release the mouse, 

all shapes within the box are selected.

Editing text
To add or edit text in a shape, double-click the shape and start typing.

Most of the keyboard shortcuts that you’re already familiar with for format-

ting text — such as Ctrl+B for bold and Ctrl+I for italic — work as they do in 

other programs. You can also use the Font and Paragraph controls on the 

Home tab of the main toolbar to format text.

Adding shapes
There are several ways to add shapes to a drawing, including the following:

 ✓ Choose a command from the SmartPanel. It usually has commands 

for adding the most common types of shapes used for the template 

you selected. For example, if you use the organization chart templates 

to create a drawing, the SmartPanel contains commands such as Add 

Employee Below and Add Assistant.
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 ✓ Add additional types of shapes that are appropriate for the template 

you selected from the Library tab. This displays one or more libraries 

of shapes that are associated with the template. To add a shape from the 

library, simply drag the shape from the Library tab onto the drawing.

 ✓ Add a basic shape such as a rectangle or an oval with the Shape tool 

on the Home tab of the main toolbar. For example, to add a rectangle, 

click the Shape drop-down arrow, choose the Rectangle shape, and then 

drag the rectangle from the Home tab to the drawing. (You can also use 

the Line control on the Home tab to add lines to the drawing.)

Applying a theme
SmartDraw has many tools that let you customize the exact appearance of 

every shape individually. You find out how to use many of these tools in sub-

sequent chapters. Until then, you can use the Theme section of the Home tab 

to apply one of several predefined looks to all of the shapes in your drawing 

at once. Just click the theme you like and all of the shapes in the drawing will 

adopt the formatting specified by the theme.

Although only three themes appear on the Home tab, SmartDraw offers many 

more themes. You can view additional themes by using the scroll buttons on 

the right edge of the Theme area of the main toolbar or by clicking the pull-

down button at the bottom right of the Theme area.

Zooming in
The zoom factor determines how much of your drawing is visible in the draw-

ing window and, therefore, how large the objects in your drawing appear. 

You can zoom in close to work on the fine details of your drawing, or you 

can zoom out to see the entire drawing at once so you can work on the big 

picture.

You can use the following two ways to change the zoom factor:

 ✓ Click the magnifying glass button on the Work Area toolbar that 

appears just above the drawing. The mouse pointer changes to a mag-

nifying glass. You can then click any part of the drawing to zoom in for 

a closer view. Each time you click, the zoom factor increases until the 

maximum allowable zoom factor — 800% — is reached. To zoom out, 

right-click.
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 ✓ Click the zoom percentage button on the Work Area toolbar. A menu 

opens that lets you select the zoom factor. You can choose one of sev-

eral preset factors (50%, 75%, 100%, 150%, 200%, or 400%), you can fit 

the entire drawing to the window, or you can click Custom to set the 

zoom factor to any arbitrary percentage.

 The zoom doesn’t change the actual, printable size of your drawing, just its 

appearance on your screen.

Saving Your Work
After you’ve spent a few minutes creating the best business graphic since 

Michelangelo painted the Sistine Chapel, it’s time to save your work to a file. 

If you make the rookie mistake of turning off your computer before you’ve 

saved your drawing, poof! Your work vanishes as if David Copperfield were in 

town.

You have at least these three ways to save a document:

  ✓ Click the Save button on the Single-Click toolbar.

 ✓ Press Ctrl+S.

 ✓ Click the SmartDraw button and then choose Save.

If you haven’t yet saved the file to your hard drive, the magical Save As dialog 

box appears. Type the name that you want to use for the file in the Save As 

dialog box and click OK to save the file. After you save the file once, subse-

quent saves update the hard drive file with any changes that you made to the 

drawing since the last time you saved it.

After you save a file for the first time, the name in the drawing window’s title 

area changes from Untitled to the name of your file. This is simply proof that 

you’ve saved the file.

 Keep the following tips in mind when saving files:

 ✓ Put on your thinking cap when assigning a name to a new file. The file-

name is how you can recognize the file later, so pick a meaningful name 

that suggests the file’s contents.

 ✓ Don’t work on your file for hours at a time without saving it. Get into the 

habit of saving every few minutes, especially after making a significant 

change to a drawing, such as adding a covey of new shapes or making a 

gaggle of complicated formatting changes.

 ✓ Always save before you print.
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Opening an Existing Drawing
If you’ve already created and saved a SmartDraw document and you merely 

want to resume working on it, you can open the existing document by using 

one of the following methods:

 ✓ Start SmartDraw from the Windows Start menu. Then, when the 

Document Browser appears, either click the Saved Documents tab or 

select Saved Documents in the Category List. A list of your recently 

saved drawings appears. If the drawing you want to open isn’t shown, 

click the Browse button to summon an Open dialog box that lets you 

peruse your entire hard disk for the drawing you want to open.

  The fastest way to open a file from the Open dialog box is to double-click 

the file. You’re spared from having to click the file once and then click OK. 

Double-clicking also exercises the fast-twitch muscles in your index finger.

 ✓ If SmartDraw is already running, click the SmartDraw button (the icon 

at the top-left side of the SmartDraw window) and then click the Open 

button. The Saved Documents tab of the Document Browser appears.

  SmartDraw adds recently opened documents to the menu that appears 

when you click the SmartDraw button. Be sure to have a quick look 

before you click the Open button.

 ✓ An alternative if SmartDraw is already running: Press Ctrl+O.

 ✓ You can also use Windows Explorer (press Windows+E on your key-

board) to navigate to the drawing you want to open and then double-

click the document. Windows launches SmartDraw and automatically 

opens the document.

 If you seem to have lost a drawing, rummage around in different folders to see 

whether you can find it. Perhaps you saved a file in the wrong folder by acci-

dent. Also, check the spelling of the filename. Maybe your fingers weren’t on 

the home row when you typed the filename, so instead of OrganizationChart, 

you saved the file as PthsmoxsyopmVjsty. If all else fails, you can use 

Windows’s built-in Search feature. You’re looking for files with the .sdr file-

name extension.

Closing a Drawing
Having finished and saved your drawing, you have come to the time to close 

it. Closing a drawing is kind of like gathering your papers, putting them neatly 

in a file folder, and returning the folder to its proper file drawer. The drawing 

disappears from your computer screen. Don’t worry: It’s tucked safely away 

on your hard drive, where you can get to it later if you need to.
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To close a file, do one of the following:

 ✓ Click the Close button that appears at the top-right side of the SmartDraw 

window. Clicking the Close button is the easiest way to close a file.

 ✓ Click the SmartDraw button and then choose Close.

 ✓ Press Ctrl+W.

 You don’t have to close a file before exiting SmartDraw. If you exit SmartDraw 

without closing a file, SmartDraw graciously closes the file for you. The only 

reason that you might want to close a file is that you want to work on a differ-

ent file and you don’t want to keep both files open at the same time.

If you’ve made changes since the last time you saved the file, SmartDraw 

offers to save the changes for you. Click Yes to save the file before closing or 

click No to abandon any changes that you’ve made to the file.

If you close all the open SmartDraw drawings, you return to the Document 

Browser, where you can create a new drawing.

Exiting SmartDraw
Had enough excitement for one day? Use any of these techniques to shut 

SmartDraw down:

 ✓ Click the SmartDraw button and then click Exit SmartDraw.

 ✓ Click the X box at the top-right corner of the SmartDraw window.

 ✓ Press Alt+F4. (Alt+F4 is one of those magic Windows shortcut keys that 

works in any program.)

Bam! SmartDraw is history.

You should know a couple of things about exiting SmartDraw (or any pro-

gram, for that matter):

 ✓ SmartDraw doesn’t let you abandon ship without first considering 

whether you want to save your work. If you’ve made changes to any 

drawing files and haven’t saved them, SmartDraw offers to save the files 

for you. Lean over and plant a fat kiss right in the middle of your moni-

tor — SmartDraw just saved you your job.

 ✓ Never, never, never, ever, never turn off your computer while SmartDraw 

or any other program is running. Bad! Always exit SmartDraw and all 

other programs that are running before you turn off your computer.
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Getting Help
Wouldn’t it be great if SmartDraw came with an actual graphic artist who 

would sit patiently at your side? The artist would answer all of your ques-

tions with straightforward, simple answers, gently correcting you — without 

being condescending — when you make silly mistakes. Otherwise, he or she 

would mind his or her own business.

Short of that, the next best thing is to find out how to coax the software into 

giving you the answers you need. Fortunately, SmartDraw includes a nice, 

built-in help feature that can provide the answers you’re looking for. No 

matter how deeply you’re lost in the SmartDraw jungle, help is never more 

than a few mouse clicks or keystrokes away.

 ✓ The SmartHelp button, found above the main drawing area and to the 

right, displays a helpful SmartHelp panel that gives guidance on the task 

at hand.

 ✓ Press F1 at any time to reveal a separate Help window, as shown in 

Figure 2-6. This window provides the typical Windows-style help, com-

plete with a table of contents, an index, and a search feature.

 

Figure 2-6: 
Help!

 

 ✓ Most SmartDraw dialog boxes contain a Help button you can click to dis-

play help information specific to that dialog box.

 ✓ When you hover the mouse over an item on the main toolbar or other 

toolbar, a ToolTip appears, explaining what the item does.
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 ✓ Click the Help tab on the main toolbar to summon the Help controls. 

The following list describes the options available from this tab:

 • Tech Support: Opens the SmartDraw technical support Web page, 

where you can get answers to a variety of questions.

 • Updates: Connects you to SmartDraw’s automatic update page so 

you can get the latest updates to the SmartDraw software.

 • User Guide: Opens a Web page that lets you download printable 

documentation for SmartDraw in PDF format or browse it online.

 • About: Displays information about SmartDraw, including the ver-

sion number and the date you installed the software.

 • License: Displays the serial number and other information about 

your SmartDraw license.



Chapter 3

Drawing Shapes and Lines
In This Chapter
▶ Using SmartDraw’s drawing tools

▶ Introducing libraries

▶ Creating basic shapes and lines

▶ Selecting, duplicating, rotating, flipping, and otherwise manhandling shapes

▶ Using rulers and grids to create neatly arranged drawings

Shapes and lines are the building blocks of SmartDraw drawings. When 

you create a drawing from a template, the drawing contains a predefined 

collection of shapes and lines. But sooner or later you’ll find that you have 

to add your own shapes and lines to your drawings. And you’ll have to edit 

those objects — dragging them to new positions, changing their sizes, rotat-

ing them, and so on.

Many of these actions are intuitive in SmartDraw. Some aren’t. Either way, 

this chapter presents the most important techniques for creating and editing 

shapes, lines, and text objects in your SmartDraw drawings.

Note: This chapter does not show you how to apply fancy formatting to your 

shape and line objects. For that information, see Chapter 6.

Also, this chapter doesn’t show you how to add text to SmartDraw shapes. 

For that information, refer to Chapter 4.

Adding Shapes from the SmartPanel
The easiest way to add a shape to a drawing is to use one of the commands 

available on the drawing’s SmartPanel. Each template comes with its own 

SmartPanel that includes commands for adding the shapes that are most 

commonly used with the template’s drawing type.
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For example, Figure 3-1 shows the SmartPanel for a drawing created using a 

floor plan template. It includes commands for adding shapes typically found 

in floor plans, such as doors, dimensions, corners, and so on.

 

Figure 3-1: 
The Smart-
Panel for a 

floor plan 
drawing.

 

To add one of these shapes to the drawing, simply click the shape on the 

SmartPanel and then drag it onto the drawing.

If you don’t find the shape you’re looking for on the SmartPanel, you can find 

more shapes in other places, including the following:

 ✓ Scroll down the SmartPanel. The SmartPanel devotes just a small part 

of its space to listing library shapes — just six shapes are visible in 

Figure 3-1. You can use the scroll bar to reveal many additional choices. 

In fact, there are 25 different door and window shapes altogether.

 ✓ Choose a different symbol library on the SmartPanel. Each template 

comes with multiple shape collections that you can access on the 

SmartPanel. For example, at the top of the SmartPanel in Figure 3-1 is 

the Doors & Windows drop-down menu. This drop-down menu shows 
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which shape collection (symbol library) is displayed on the SmartPanel. 

Besides Doors & Windows, the drop-down menu lists several other 

libraries: Beds, Lavatories, and Appliances.

  Don’t be confused between symbol and shape. They’re essentially the 

same thing, although the term shape typically refers to a basic shape 

such as a rectangle or oval, while symbol usually refers to a more com-

plicated object such as a chair or an automobile. We use the terms inter-

changeably in this book.

 ✓ Access more symbol libraries from the More Symbols dialog box. You 

can also choose the More option from the drop-down menu at the top of 

the SmartPanel, which brings up the More Symbols dialog box shown in 

Figure 3-2. From here, you can select additional library shapes. The floor 

plan template, for example, offers 30 additional symbol libraries in the 

More Symbols dialog box. In all, hundreds of different floor plan shapes 

are available for your choosing.

 

Figure 3-2: 
The More 

Symbols 
dialog box 

lets you 
access 

additional 
symbol 

libraries.
 

  To access a shape in one of these libraries, you may need to first install 

the library (some come pre-installed; others download instantly over 

the Internet). To do that, simply double-click the library in the More 

Symbols dialog box. Or right-click the library and choose Install. For 

example, if you want to add appliances to a floor plan, you can double-

click the Appliances symbol library and install it.

  When you install a library, SmartDraw pauses for a few moments while it 

downloads the shapes that make up the library from SmartDraw’s serv-

ers. After you’ve installed the library, you can use it. (Of course, you’ll 

need to be connected to the Internet for this download to work.)
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  SmartDraw organizes its symbol libraries into folders. Thus, symbol 

libraries such as Appliances, Beds, and Bookcases & Cabinets are con-

tained in a folder named Furniture, which is itself contained in a folder 

named Floor Plans.

 ✓ Open the Library panel. To see more of the library shapes at once, and 

to access even more shapes, click the Library tab next to the SmartPanel 

tab. The Library panel opens, as shown in Figure 3-3. This panel shows 

the same shapes that are at the top of the SmartPanel tab, but it’s 

expanded so that more of the shapes are visible at once.

 If you need to access more than one symbol library at a time, you may want to 

create a floating library. To do that, right-click anywhere within the library and 

choose the Detach Library command. The library opens in a separate floating 

window, which you can then drag to any location that you wish. SmartDraw 

lets you to have as many as 16 floating library windows open at a time.

 

Figure 3-3: 
The Library 

panel.
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Drawing Basic Shapes
In addition to adding complex shapes from symbol libraries, you can also add 

basic shapes — rectangles and squares with straight or rounded corners, 

ovals, and circles. Here are the steps:

  1. On the main toolbar, click the Home tab if it isn’t already active, find 

the Tools group, and click the down arrow next to the Shape button.

  Clicking the down arrow reveals a menu with the following choices:

 • Rectangle

 • Rounded Rectangle

 • Oval

 • Square

 • Circle

 • Rounded Square

 2. Click the shape you want to insert.

 3. Click your drawing at the location you want the shape to appear.

To change the shape’s size, click and drag any of the shape’s corners or edge 

handles.

Drawing Lines
Lines play an important role in many types of business graphics. Often, vari-

ous types of lines are used to show the relationships among shapes in draw-

ings. For example, lines in a flowchart indicate the sequence of steps in a 

process.

The following sections describe the most common ways to create lines in 

SmartDraw.

Drawing straight lines
The easiest way to draw a straight line in SmartDraw is to follow these steps:
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  1. On the Home tab on the main toolbar, find the Tools group, click the 

down arrow next to the Line button, and then choose Straight Line.

 2. Click your drawing at the location you want the line to start.

 3. Click your drawing at the location you want the line to end.

That’s all there is to it.

Drawing curved lines
To draw a curved line, follow these steps:

  1. On the Home tab, find the Tools group and click the down arrow next 

to the Line button, and then choose Curved Line.

 2. Click your drawing at the location you want the line to start.

 3. Click your drawing at the location you want the line to end.

  The line appears with three selector handles: one on each end and one 

in the middle.

 4. Grab the selector handle in the middle and drag it to adjust the curva-

ture of the line.

  Figure 3-4 shows four different line curvatures drawn with the Curved 

Line tool.

 Lines that you draw with the Curved Line tool are simple arc segments — that 

is, they’re circular. To create more complex curves, use freehand lines as 

described in the next section.

 

Figure 3-4: 
Curved 

lines.
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Drawing freehand lines
The freehand line tool lets you create more complex curves than the Curved 

Line tool. To use it, follow these steps:

  1. On the Home tab, find the Tools group, click the down arrow next to 

the Line button, and then choose Freehand Line.

 2. Click and hold the mouse button in the drawing where you want the 

line to start.

 3. While still holding down the mouse button, drag the mouse wherever 

you want the line to go.

  The freehand line actually consists of one or more separate curved line 

segments with solid selector handles that mark the start and end of 

each segment and hollow selector handles that let you adjust the cur-

vature of each segment. Each time you make a major change in direc-

tion as you draw the line, SmartDraw begins a new line segment. For 

example, Figure 3-5 shows the selector handles created with a simple 

snake-like S shape.

 

Figure 3-5: 
Selector 

handles on 
a freehand 

line.
 

Solid selector handle Hollow selector handle

 4. Grab the selector handles in the middle and drag them to adjust the 

shape of the line.

  You can change the start point, end point, or curvature point of each 

segment independently. With this flexibility, you can almost always craft 

exactly the curvature you want for the line.

Here are a few points worthy of mention when thinking about freehand lines:
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 ✓ If you end the line at the same place that you started the line, SmartDraw 

converts the line to a filled shape.

 ✓ You can delete an entire segment of a freeform line by right-clicking the 

segment you want to delete and choosing Remove Line Segment.

 ✓ You can change the curve type of a segment by right-clicking the seg-

ment you want to change and choosing Change Segment Shape. The 

options are Parabola, Circular Arc, Quarter of an Ellipse, or Straight 

Line. You’ll want to experiment with these options to learn their effects.

Drawing connectors
Connectors are among the best features of SmartDraw. A connector is a line 

that’s attached to a shape on each end. SmartDraw automatically figures out 

how to route the connector from one shape to the other. If you move one of 

the shapes, SmartDraw adjusts the connector to maintain the connection. 

Figure 3-6 shows three shapes connected by two connector lines.

 

Figure 3-6: 
Three 

shapes with 
connector 

lines.
 

Before you can create connector lines, you may need to enable the Allow 

Lines to Link option (it’s enabled automatically for some drawing types). To 

do so, click the SmartDraw button (the large icon in the top-left side of the 

SmartDraw window), choose Options, select the Allow Lines to Link check 

box, and click OK.
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To create connector lines, start with a drawing that has at least two shapes 

you want to connect. Then, follow these steps:

  1. On the Home tab, find the Tools group, click the down arrow next to 

the Line button, and then choose Shape Connector.

  If you want your connector line to be curved rather than straight, 

choose Curved Connector rather than Shape Connector.

 2. Click the first shape you want the line to connect to.

  When you click it, click as close as possible to the exact location on the 

shape where you want the line to attach.

 3. Click the second shape you want the line to connect to.

  Again, click as close as possible to the spot where you want the line to 

connect.

 4. If you don’t like the way the line is routed, click the line to select it. 

Then, drag the selection handle in the middle of the line to reroute 

the connector.

Here are some thoughts to ponder concerning connector lines:

 ✓ When you click a shape to attach the connector line to it, the shape’s 

border appears with a bunch of dots called connector points. The con-

nector line always connects the shape at one of these points.

 ✓ You can change the connector point that a connector line attaches to by 

clicking the connector line where it attaches to the shape and then drag-

ging it to a different connection point.

 ✓ You can change the routing of a connector line by clicking the line to 

select it and then dragging the selection handle that appears at the line’s 

midpoint.

You can find more information about working with connector lines in 

Chapters 11 and 12, which explain in detail how to create flowcharts and 

organization charts.

Drawing Polygons
The Polygon Line tool lets you create shapes with an arbitrary number of 

sides. Figure 3-7 shows several examples of polygons that you can draw with 

SmartDraw.
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Figure 3-7: 
Polygons.

 

Here are the steps to draw a basic polygon:

  1. On the Home tab, find the Tools group, click the down arrow next to 

the Line button, and then choose Polygon Line.

 2. Click the location on your drawing where you want the first side of 

the polygon to start.

 3. Click the location on your drawing where you want the first side to end.

  SmartDraw draws a line from the point you clicked in Step 2 to the point 

you clicked in this step.

 4. Keep clicking to draw additional sides on your polygon.

  Each time you click, another side is added to the polygon.

  Don’t worry if you don’t click in exactly the right spot for each side. 

Adjusting the exact position of each side of the polygon is easy after you 

finish the basic polygon shape.

 5. To finish the polygon, click at the same point you started the polygon 

in Step 2.

  When you complete the polygon, SmartDraw fills it in with the current 

fill color. Then the shape is selected so that you can change the shape of 

the outline.
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 6. (Optional) If the polygon isn’t exactly the right shape, drag the adjust-

ment handles to adjust the shape until it’s exactly the way you want it.

  You’ll find a selection handle at the intersection of each side of the poly-

gon, so you can easily adjust the polygon’s shape.

Here are some additional tips for working with polygons:

 ✓ Another way to finish a polygon is to simply double-click after you draw 

the next-to-last side. When you double-click, SmartDraw automatically 

creates a side from the last point to the first point to close the polygon.

 ✓ The adjustment handles at the intersection of each side let you adjust 

the position and length of the sides. But the adjustment handles in the 

middle of each side let you add curvature to the side. The bottom-right 

polygon in Figure 3-7 shows a polygon with curved sides.

 ✓ To edit the shape of a polygon later, you must select the polygon, then 

choose the Edit Shape Outline command, which you can find on the 

Design tab in the Shape Properties section.

Adding Arrowheads
Just about any line in a SmartDraw drawing can have an arrowhead attached 

to either or both ends. To add a simple arrowhead to either or both ends of a 

line, follow these steps:

 1. Select the line.

  If you want to add arrowheads to more than one line, press Shift or Ctrl 

to select all of the lines you want to add arrowheads to.

  2. Click the Arrowheads drop-down arrow in the Tools group on the 

main toolbar’s Home tab.

  A menu with arrowhead choices opens.

 3. Select Right, Left, or Both.

  The arrowheads are added to the line.

If you don’t like the standard arrowheads, select Custom from the Arrowheads 

drop-down menu to display the Arrowheads dialog box shown in Figure 3-8. 

You can choose one of 35 different arrowhead styles for each end of the line. 

In addition, you can change the size and displacement of the arrowhead. (The 

displacement determines whether the arrowhead extends all the way to the 

end of the line or leaves a little empty space at the end of the line.)
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Figure 3-8: 
Creating 
custom 

arrowheads.
 

Selecting Shapes
If you happen to be the type that gets everything right on the first attempt, 

you can skip this section because all of the shapes you draw are perfect the 

first time, and therefore have no need of editing.

If, on the other hand, you’re like the rest of us, you need to know how to edit 

the shapes you add to your drawings. And the first step in editing any shape 

is knowing how to select it.

For the most part, selecting shapes in a SmartDraw document is the same as 

selecting objects in any other program. To select a single object, simply click 

the object. If a shape is filled with a color, you can click anywhere within 

the shape. If the shape is just an outline with no fill, you must click on the 

shape’s border to select it. (For more about filled and unfilled shapes, refer 

to Chapter 6.)

  You must have the Selection tool activated to select objects. This tool is usu-

ally active, but in case it isn’t, you can activate it by clicking the Select button 

on the Home tab on the main toolbar. (If the mouse cursor is a normal arrow 

pointer, the Selection tool is active.)

You can use any of the following methods to select more than one object:

 ✓ Hold down the Shift or Ctrl key and click each object you want to select.

 ✓ Click the arrow beneath the Select button on the Home tab on the main 

toolbar and then choose Select Multiple. Then click each object you 

want to select; you don’t have to hold down Shift or Ctrl.

 ✓ Click anywhere outside of an object, hold down the mouse button, and 

drag a rectangle around the objects you want to select. All objects inside 

your box are selected. Note that you must completely enclose an object 

to select it using this method.
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You can select all the objects in your drawing in two ways:

 ✓ Press Ctrl+A.

 ✓ On the Home tab on the main toolbar, click the arrow beneath the Select 

button and choose All Shapes or All Lines.

Duplicating Shapes
You can create a duplicate copy of any shape in a SmartDraw drawing by 

selecting the shape and then pressing Ctrl+D. (If you prefer to work from the 

main toolbar, click the Home tab, click the arrow beneath the Paste button, 

and then choose Duplicate.)

 When you duplicate an item, SmartDraw places the copy in a position that is 

offset somewhat from the original object. If you move the duplicate object 

immediately after creating it and then duplicate the object again, the offset of 

the new duplicate is adjusted based on how you moved the first duplicate. 

This handy trick makes it easy to create multiple copies of evenly spaced 

objects arranged in tidy rows.

For example, have a look at the nice array of 99 mugs of beer shown in 

Figure 3-9.

 

Figure 3-9: 
Ninety-nine 

mugs of 
beer on the 

wall.
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Follow these steps to create an array just like the one in Figure 3-9:

 1. Open the Beverages library. (You can find it in the Food group under 

Clip Art.)

  If you aren’t sure how to add shapes from a library, see the first section 

in this chapter.

 2. Drag a beer mug to the drawing and resize the mug so that 99 copies 

of it fit on the page.

  Make the beer mug about 0.5" tall. (For information about how to resize a 

shape, see the section, “Drawing Basic Shapes,” earlier in this chapter.)

 3. Click the beer mug to select it and then press Ctrl+D to make a 

duplicate.

  The duplicate appears below and to the right of the original.

 4. Drag the duplicate to a position immediately beneath the original.

 5. Press Ctrl+D eight times.

  You now have a column of ten neatly stacked beer mugs.

 6. Drag a rectangle around all of the beer mugs to select them.

 7. Press Ctrl+D again.

  This makes a duplicate column of beer mugs, to the right and slightly 

lower than the original column.

 8. Drag the entire column up so that it aligns with the top of the original 

column.

 9. Click Ctrl+D eight times.

  You now have ten columns of beer mugs arranged in a nice, even grid.

 10. Click the first mug in the top-left corner to select it, and then delete it.

  You now have 99 mugs of beer on the wall!

Rotating Shapes
Remember how all the bad guys’ hideouts were slanted in the old Batman 

TV show? SmartDraw lets you give objects in your drawing that same kind 

of slant.

There are two ways to rotate an object. The first is to rotate the object a spe-

cific amount by following these steps:
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 1. Choose the shape that you want to rotate.

 2. Click the Design tab on the main toolbar, find the Shape Layout group, 

and click the Rotate button.

  A menu of rotation choices that let you rotate the shape in 45 degree 

increments opens. (The options are 45°, 90°, 135°, 180°, 225°, 270°, 

and 315°.)

 3. Click the rotation option you want.

  The shape is rotated according to your selection.

 If you want to rotate the shape to a specific angle that isn’t an increment of 45 

degrees, choose the Custom rotation option. You can enter a specific angle for 

the rotation in the dialog box.

The faster way to rotate a shape is to grab and drag the shape’s rotate handle, 
which is a small dot that appears somewhere within the shape, as shown in 

Figure 3-10. You can rotate a shape to any angle simply by dragging the rotate 

handle either clockwise or counterclockwise.

 

Figure 3-10: 
The rotate 

handle lets 
you rotate 
an object 

to any arbi-
trary angle.

 

Rotate handles

The following steps show you how to use the rotate handle:

 1. Click the object that you want to rotate.

 2. Drag the rotate handle in the direction that you want to rotate the 

object.

  As you drag, an outline of the object rotates. When you get the object’s 

outline to the angle you want, release the mouse button, and the object 

is redrawn at the new angle.

 As you rotate the shape using the rotate handle, the rotation angle is con-

strained by the current grid setting. To freely rotate the object to any arbi-

trary angle, turn off the Snap to Grid option. For more information, see the 

section “Using the Ruler and the Grid” later in this chapter.
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Flipping Shapes
SmartDraw lets you flip a shape vertically or horizontally to create a mirror 

image of the object. To flip a shape, follow these steps:

 1. Select the shape or shapes you want to flip.

 2. Click the Design tab, find the Shape Layout group, click the Flip 

button, and then choose Flip Horizontally or Flip Vertically.

Overlapping Shapes
Whenever you have more than one shape on a page, the potential exists for 

objects to overlap one another. Like most drawing programs, SmartDraw 

handles this problem by stacking the shapes. The first shape that you draw 

is at the bottom of the stack, the second shape is on top of the first, the third 

is atop the second, and so on. If two shapes overlap, the shape that’s highest 

on the stack hides the shape beneath it.

So far, so good — but what if you don’t remember to draw the shapes in 

the correct order? What if you draw a shape that you want to tuck behind 

a shape that you’ve already drawn, or what if you want to bring an exist-

ing shape to the top of the pecking order? No problem. SmartDraw lets you 

change the stacking order by moving shapes toward the front or back so that 

they overlap just the way you want.

 Don’t confuse overlapping objects with SmartDraw layers, which let you 

create entire collections of shapes that overlap other collections. For more 

about working with layers, see Chapter 9.

The Design tab provides two controls that let you move a shape forward or 

backward in the stack order:

 ✓ Bring to Front: Brings the chosen shape or shapes to the top of the 

stack. Note that this button has a down arrow next to it.

 ✓ Send to Back: Sends the chosen shape or shapes to the back of the stack.

 Stacking problems are most obvious when objects have fill colors. If an object 

has no fill color, objects behind it show through. In this case, the layering 

doesn’t matter as much. But if one or both of the objects have a fill color, the 

object that is higher in the stacking order will overlap objects behind it.



55 Chapter 3: Drawing Shapes and Lines

For example, have a look at the three examples in Figure 3-11. In the first 

example, you can’t tell whether the square or the circle is higher in the stack-

ing order because neither has a fill color. But in the second example, you can 

tell that the circle is on top, and you can tell that the square is on top in the 

third example.

 

Figure 3-11: 
Stacked 
objects.

 

For more information about fill colors, see Chapter 6.

Note that sometimes you have to be clever with the Send to Back and Send to 

Front commands to get the exact effect you want.

Grouping Shapes
A group is a collection of shapes that SmartDraw treats as though it were 

a single shape. Using groups properly is one key to putting simple shapes 

together to make complex pictures without becoming so frustrated that you 

have to join a therapy group.

To create a group, follow these steps:

 1. Choose all shapes that you want to include in the group.

  Hold down the Ctrl or Shift key and click each of the shapes, or hold 

down the mouse button and drag a rectangle around all the shapes you 

want to select.

 2. Right-click one of the selected objects and then choose Group Objects 

from the menu that appears.

  You can also find the Group button on the Design tab on the main toolbar.

To take a group apart so that SmartDraw treats the shapes as individuals 

again, follow these steps:

 1. Right-click the group you want to break up.

 2. Choose Ungroup Objects.
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SmartDraw lets you create groups of groups. This capability is useful for 

complex pictures because it lets you work on one part of the picture, group 

it, and then work on the next part of the picture without worrying about 

accidentally disturbing the part that you’ve already grouped. After you have 

several such groups, select them and group them. You can create groups of 

groups of groups and so on, ad nauseam.

 Note that the Ungroup command ungroups only one level of this grouping 

hierarchy at a time. For example, suppose you draw two rectangles and group 

them, then draw two ovals and group them, then combine the two groups to 

create a single group made up of two rectangles and two ovals. If you then use 

the Ungroup command, the group reverts to one group of two rectangles and 

another group of two ovals. You must undo all of the groupings to completely 

revert to the individual, ungrouped shapes.

Precisely Setting a Shape’s 
Position and Size

Most of the drawing you do with SmartDraw is with the mouse. You use the 

mouse to drag shapes around on the page to place them exactly where you 

want them, and you use the mouse to change the size of individual shapes.

However, for absolute precision, right-click the shape whose size or position 

you want to set and choose the Position and Size command from the menu 

that appears. The Position and Size dialog box opens, as shown in Figure 3-12.

 

Figure 3-12: 
The Position 

and Size 
dialog box.

 

The way this dialog box works is a little confusing, so hang with us here as 

we explain.

To change the exact position of a shape, change the value in the Left or Top 

text box. These text boxes control the exact position of the top-left corner of 

the shape.
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To change the size of the shape, change the values in the Width and Height 

text boxes. These two text boxes control the exact size of the shape.

The confusion comes about when you look at the text boxes labeled Bottom 

and Right. These two text boxes control one of two things, depending on 

which of the two options you select in the Changing the Right and Bottom 

Positions Changes section of the dialog box.

 ✓ If The Object’s Size is the selected option, changing the right or bottom 

setting leaves the top-left corner of the shape exactly where it is and 

adjusts the shape’s size to match the right or bottom position you set.

 ✓ If The Object’s Position is the selected option, changing the right or 

bottom setting leaves the size of the object unchanged; instead, the 

position of the object is adjusted so that the bottom-right corner of the 

object is at the position you specify.

Confused? Not to worry. In most cases you can simply ignore the Right and 

Bottom text boxes. Use the Left and Top boxes to set the shape’s position 

and the Width and Height boxes to set the shape’s size.

Here are a few other pointers about adjusting the size and position of your 

shapes:

 ✓ If you want to precisely adjust a shape’s size but not its position, 

there’s no need to call up the Position and Size dialog box. Just select 

the shape, click the Design tab, and use the Width and Height fields to 

set the size you want.

 ✓ If you want several objects to be the same size, select all of the objects, 

click the Make Same button on the Design tab, and choose Make Same 

Height, Make Same Width, or Both from the menu that appears. (The last 

shape you select is the one that SmartDraw uses to determine the size 

for the other selected shapes.)

 ✓ If you want to adjust the position of shapes, use the alignment tools 

described in the next section.

Line ’em Up
Nothing looks more amateur than shapes that look like they were supposed 

to be lined up neatly in a row, but are just a little bit off. Fortunately, the 

Design tab on the main toolbar includes an Align button that brings up a 

menu with the following commands:

 ✓ Lefts

 ✓ Centers
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 ✓ Rights

 ✓ Tops

 ✓ Middles

 ✓ Bottoms

The first three commands align items horizontally; the next three align items 

vertically.

To use any of these commands, first select the shapes you want to align. 

Then, click the Align button on the Design tab and choose the alignment 

option you want.

 The last shape you select is the one that all the others adjust themselves to.

Space ’em Out
One more way to adjust the position of shapes is to distribute them evenly. 

For example, suppose you’ve drawn five rectangles, but you haven’t been too 

careful about the spacing between them. To distribute them all evenly, select 

the five rectangles, click Space Evenly on the Design tab, and choose Space 

Evenly Horizontally, Space Evenly Vertically, or Both from the drop-down 

menu that appears.

When you distribute shapes horizontally, SmartDraw leaves the leftmost and 

rightmost shapes where they are. Then, it adjusts the position of any shapes 

that fall between the leftmost and rightmost shapes so that the spacing 

among them is even.

When you distribute shapes vertically, the topmost and bottommost shapes 

stay put, while any shapes between them are adjusted so that the vertical 

space between them is the same.

Using the Ruler and the Grid
SmartDraw includes two closely related tools to help you arrange your 

shapes into a well-ordered drawing: the rulers and the grid. The following 

sections explain how to use these helpful features.
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Using the rulers and guides
In Chapter 2, you find out how to turn the rulers on and off by clicking the 

Ruler button on the Work Area toolbar, which is just above the drawing area. 

The rulers provide an easy way to gauge the size and position of shapes on 

your drawing.

Besides simply showing and hiding the ruler, there are a couple of useful 

tricks you should know:

 ✓ By default, the rulers align themselves with the top-left corner of your 

drawing. In other words, the zero on the horizontal ruler is placed at the 

left edge of your drawing, and the zero on the vertical ruler is placed at 

the top. You can change the zero position by double-clicking anywhere 

in either of the rulers. For example, if you want the zero on the horizon-

tal ruler to be right in the middle of an 81/2 x 11 inch page, double-click 

at 4.25" on the horizontal ruler.

 ✓ If you click one of the rulers and hold down the mouse button, a line 

called a guide appears to help you line up objects in your drawing with 

the ruler. If you click the ruler at the top of the drawing area, a vertical 

guide line appears; if you click the ruler to the left of the drawing area, a 

horizontal guide line appears. Then, if you move the mouse while hold-

ing down the button, the guide line follows your mouse movement.

 Here’s a cool trick: Click in the small empty box at the top-left corner of the 

drawing area, where the two rulers meet. Then, hold down the mouse button 

and drag the mouse into the drawing area. When you do, two guide lines 

appear, creating cross-hair guide lines that intersect at the mouse position. 

Figure 3-13 shows these cross-hair guides in action. Here, the cross-hair guide 

line confirms that a rectangle is positioned at the 1" mark on both rulers.

Showing the grid
The ruler is helpful for aligning objects, but you may want to turn on the grid 

for more precise control. The grid is an imaginary framework of dots that 

provides alignment points for the objects in your drawing. You can show or 

hide the grid: Click the Page tab on the main toolbar, find the Rulers and Grid 

group, and select the Show Grid check box. Figure 3-14 shows what the draw-

ing area looks like with the grid displayed.

 The grid dots aren’t actually a part of your drawing, so they don’t appear 

when you print your drawing or export it into another program. They exist 

simply to make the task of lining things up a bit easier.
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Figure 3-13: 
Using guide 

lines.
 

 

Figure 3-14: 
The grid.
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The grid always exists “behind the scenes” whether you are viewing it or not. 

The Show Grid command simply makes it visible to you.

Snapping to the grid
If you want to force objects in your drawing to line up with the grid, you can. 

Click the Page tab, find the Rulers & Grid group, and select the Use Snaps 

check box. When this check box is selected (and it is automatically in some 

drawing types), any object you draw or any object you move automatically 

snaps itself to the nearest grid point.

By default, shapes snap into place so that the top-left corner of the shape 

aligns with the nearest grid point. If you prefer, you can change this behav-

ior so that the snap-point is the center of the shape rather than the top-left 

corner. To do so, click the Snaps button on the Page tab (in the Rulers and 

Grid group), and choose Snap Center of Shape.

 The grid doesn’t have to be visible for the snaps to be on. In other words, if 

you select the Use Snaps check box but leave the Show Grid check box dese-

lected, objects still snap to the grid even though the grid isn’t visible. (In fact, 

this is SmartDraw’s default configuration for grids.)

Changing grid and ruler settings
If you want, you can change the size and scale of the rulers and the grid. The 

easiest way to do that is to click the Scale button. (You can find it on the Page 

tab in the Rulers & Grid section.) Click the Scale button to reveal a menu of 

the following scale options:

 ✓ Standard: This option displays a standard, full-sized, 1" scale ruler, 

scaled so that 1" on the screen equals 1" in the drawing. In other words, 

the ruler is scaled one-to-one.

 ✓ Floor Plan (Standard): This option scales the ruler down so that 1" on 

the screen equals 4 feet in the drawing. This is the standard scale used 

to draw floor plans.

 ✓ Metric: This changes the ruler to a metric ruler, showing 1 centimeter. 

The scale is 1:1, so that 1 centimeter on the screen equals 1 centimeter 

in the drawing.

 ✓ Floor Plan (Metric): This scales the ruler so that 1 centimeter on the 

screen equals 0.5 meter in the drawing.
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If none of these predefined scales work for you, choose Custom from the 

Scale menu to display the Set Rulers and Grids dialog box, shown in Figure 

3-15. (Another way to display this dialog box is to right-click the ruler and 

then choose Define Rulers and Grids from the menu that appears.)

 

Figure 3-15: 
The Set 

Rulers and 
Grids dialog 

box.
 

You can specify the following settings from the Set Rulers and Grids dialog box:

 ✓ Scale: The controls in the Scale section let you set the scale. You can 

adjust the scale so that any number of inches or centimeters on the 

screen equals any number of inches, feet, millimeters, centimeters, or 

meters in the drawing.

 ✓ Set the Position of 0 on the Rulers (the origin): The controls in this sec-

tion let you set the zero-position for the horizontal and vertical rulers.

 ✓ Divisions: This setting lets you set the number of tick marks that appear 

in each inch or centimeter of the ruler.

 ✓ Hide and Show: This section contains a check box that you can use to 

hide the ruler.

 ✓ Snaps: This section contains option buttons that set whether to snap 

the top-left corner or the center of shapes to the grid.



Chapter 4

Working with Text
In This Chapter
▶ Inserting text into your drawings

▶ Adjusting the font and other text format settings

▶ Creating bullets

▶ Eliminating spelling errors from your drawings

Years ago, artists and draftsmen used a device known as a Leroy 

Lettering Set to mechanically add text to drawings. The Leroy set 

consisted of three components: a set of stencils that contained the shapes 

of the letters to be formed, a special stylus that the user operated to trace 

the shape of the letters from the stencil, and an ink pen that transferred the 

traced shape to the paper. (If you read comic books when you were a kid — 

especially those published by EC Comics — you’ve seen plenty of examples 

of Leroy lettering.)

Fortunately, adding text to drawings in SmartDraw is much easier. You don’t 

have to pull out the Leroy set and trace letters with the stencils. Instead, you 

just click the Text tool on the Home tab, click the drawing at the location 

where you want to add text, and start typing.

Well, of course there’s a little more to it than that. Otherwise, we wouldn’t 

have devoted this entire chapter to the subject.

Note that besides the basic text-editing features presented in this chapter, 

SmartDraw also lets you create text organized as tables. For more informa-

tion about using tables, see Chapter 7.

Adding Text to a Drawing
There are several ways to add text to a drawing, as described in the following 

sections.
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Adding text to a shape or symbol
Shapes can have their own text. To add text to a shape, double-click the line 

or shape. The mouse pointer changes to a text cursor. Then, you simply type 

your text. When you’re finished, just click anywhere outside of the shape.

 Many symbols inserted from libraries can also have their own text. To find 

out, try double-clicking the symbol. If a text cursor appears, you’re in busi-

ness. If not, that particular symbol isn’t designed to accommodate text.

Adding text to a line
Lines can also have text. To add text to a line, double-click the line and start 

typing.

SmartDraw provides the following alternatives for aligning text with lines, as 

shown in Figure 4-1:

 ✓ Horizontally: By default, text attached to a line is displayed horizon-

tally, as shown in the first example.

 ✓ Follow the course of the line: The second example in Figure 4-1 shows 

the text following the line. To do so, select the line (not the text itself), 

and then, on the Home tab, find the Paragraph group, click the Direction 

button, and choose Along the Direction of the Line.

  The text won’t follow the direction of the line if the line is curved.

 

Figure 4-1: 
Creating 

text on lines.
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 ✓ Oriented with the line direction: The third and fourth examples in 

Figure 4-1 show the effect of the text alignment options when text is 

oriented with the line direction. For more information about setting the 

alignment, see the section “Aligning Text” later in this chapter.

Creating a text object
You can add text to any arbitrary location on your drawing by following 

these steps:

 1. On the main toolbar, click the Home tab if it isn’t already active, find 

the Tools group, and click the Text tool.

 2. Click in the empty background of the drawing where you want to 

add text.

  Be careful not to click on or inside a shape, or your text will become 

attached to it.

  The mouse pointer changes to a text cursor.

 3. Type your text.

 4. When you finish, click anywhere outside of the text.

If you want to move the text to a new location, select it and drag it anywhere 

you want. Also, you can edit the text by double-clicking it.

 Text added using the Text tool is actually contained in a rectangle shape with 

an invisible border and no fill color. SmartDraw sometimes refers to these 

rectangles as text objects or background text. Consider these two important dif-

ferences between text objects and ordinary rectangle shapes:

 ✓ If Use Snaps is turned on, text objects align with the grid at the baseline 

of the text, not at the upper-left corner or center of the rectangle.

 ✓ If you delete all of the text in a text object, the text object is deleted, so 

you don’t have empty invisible rectangles cluttering your page.

Editing Text
To edit text that you’ve already added to your drawing, double-click the text. 

The mouse pointer changes to an insertion point, and you can then edit the 

text using the techniques found in most text-editing programs. For example, 

you can use the Backspace or Delete key to obliterate text, and you can insert 

text by clicking and typing where you want the new text to appear. You can 

also select text by dragging the mouse, or you can select individual words by 

double-clicking the words.



66 Part I: Getting Started with SmartDraw 

SmartDraw also includes a Find and Replace command like most other text-

editing programs do. You can find these commands on the Page tab, in the 

Find & Replace group. You can also summon the Find and Replace dialog 

boxes by pressing Ctrl+F for Find and Ctrl+H for Replace.

Because these text-editing techniques are widely used in many different 

Windows programs, we won’t bore you with details of how to use them in 

this book.

Setting Text Fonts
The Font group of the Home tab, shown in Figure 4-2, includes controls that 

let you specify the typeface, size, color, and other properties of your text.

 

Figure 4-2: 
The Font 

group on the 
Home tab.

 

Many font formatting options also have handy keyboard shortcuts. The fol-

lowing table lists the controls in the Font group along with their equivalent 

keyboard shortcuts.

Button Keyboard Shortcut Formatting Command

(none) Font

(none) Size

Ctrl+B Bold

Ctrl+I Italic
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Button Keyboard Shortcut Formatting Command

Ctrl+U Underline

(none) Superscript

(none) Subscript

Shift+F3 Color

(none) Insert symbol

Most of the keyboard shortcuts for formatting text that work in other pro-

grams work in SmartDraw as well.

Note also that you can change the text color by clicking the Color button in 

the Font group. Clicking this button reveals a large menu that contains many 

options for setting colors, including transparency options, gradient fills, and 

texture fills. These options are described in detail in Chapter 6.

If the Font group on the Home tab doesn’t provide enough options for format-

ting your text, you can call up the Font dialog box for additional options. (See 

Figure 4-3.) To summon this dialog box, just select the arrow at the bottom-

right corner of the Font group.

 

Figure 4-3: 
The Font 

dialog box.
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Inserting a Special Symbol
The Text Symbol button, found in the Font group on the Home tab, lets you 

insert a special symbol into your text. To insert a symbol, click the Text 

Symbol button. The Insert Symbol dialog box shown in Figure 4-4 appears. 

You can then insert any of the symbols shown in the dialog box by double-

clicking the symbol.

 

Figure 4-4: 
The Insert 

Symbol dia-
log box.

 

You can choose which font to select symbols from by selecting the font 

from the Font drop-down list. Initially, this list includes just two options: 

Normal Text and Symbol. However, you can add more fonts to the list by 

clicking the Add Font button. (You can use any font that is installed on your 

computer here.)

Biting the Bullet List
  You can create bullet lists by clicking the Bullets button in the Paragraph 

group on the Home tab. The Bullets menu opens, which offers eight different 

styles of bullets.

To apply bullets to one or more paragraphs within a single shape, follow 

these steps:

 1. Double-click the shape to edit the text.

 2. Select the paragraph or paragraphs you want to apply the bullets to.

 3. Click the Bullets button and then click the bullet style you want to 

apply.
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To apply a bullet style to all of the paragraphs in a shape, just select the 

shape itself — there is no need to double-click to edit the text. Then click the 

Bullets button to apply the bullet style you want to use.

Aligning Text
The Text Alignment button in the Paragraph group on the Home tab lets you 

align text both horizontally and vertically. The following table shows how 

each of these buttons aligns text.

Button Horizontal Alignment Vertical Alignment

Left Top

Center Top

Right Top

Left Middle

Center Middle

Right Middle

Left Bottom

Center Bottom

Right Bottom

 These alignment options are especially useful for aligning text attached to line 

objects. In particular, the vertical alignment (Top, Middle, or Bottom) option 

determines whether the text appears above the line, below the line, or cen-

tered over the line.
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Spacing Your Lines
  The Line Spacing button in the Paragraph group on the Home tab lets you set 

the line spacing for text. This setting has no effect on text that fits on a single 

line, but if the text is large enough to require two or more lines, this setting 

affects the amount of vertical space between the lines.

To set the line spacing, click the Line Spacing button, then choose one of 

the three provided options: 1 for single-spacing, 1.5 to add an extra half-line 

space between each line, or 2 for double-spacing.

Checking Your Spelling
If you were ever voted Worst Speller in school, you’ll appreciate the spell 

checker that comes with SmartDraw. The spell checker in SmartDraw is so 

smart that it knows that you’ve made a spelling mistake almost before you 

make it. The spell checker watches over your shoulder as you type and helps 

you correct your spelling errors as you work.

When the spell checker observes that you’ve made a spelling mistake, it 

underlines the error with a wavy red line. You then have several options:

 ✓ Make the correction. You can retype the word using the correct spelling.

 ✓ Let SmartDraw help. You can right-click the word to call up a menu that 

lists suggested spellings for the word. In most cases, SmartDraw can 

figure out what you meant to type and then suggest the correct spelling. 

To replace the misspelled word with the correct spelling, just click the 

correctly spelled word on the menu.

 ✓ Ignore the misspelling. Sometimes, you want to misspell a word on pur-

pose (for example, if you run a restaurant named The Koffee Kup). More 

likely, the word is correctly spelled, but SmartDraw just doesn’t know 

about the word. In that case, right-click the word and choose Ignore All. 

The misspelling is ignored throughout the drawing — but only for the 

current drawing. If you want to ignore it for all your drawings, you must 

choose Add.

 ✓ Add the word to the dictionary. If you’ve discovered a word that isn’t 

already in SmartDraw’s extensive dictionary, and you’re absolutely posi-

tive that you spelled the word correctly, right-click the word and click 

Add. The word is added to the dictionary so that it won’t be flagged as a 

spelling error in the future.
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 ✓ Have SmartDraw autocorrect the word. If you find that you make the 

same spelling errors over and over again, right-click your misspelling 

and choose AutoCorrect. Then, SmartDraw automatically corrects the 

spelling error for you whenever you type the misspelled word.

 The spell checker can’t tell you when you’ve used the wrong word but spelled 

it correctly. For example, if you type dime navels instead of dime novels, the 

spell checker won’t help you because navels is a legitimate word. Cheap litera-

ture might be a bad thing, but cheap citrus certainly is not.

If you want more precise control over how the spell checker works, right-

click any misspelled word and choose Spelling from the menu that appears. 

The Check Spelling dialog box opens, as shown in Figure 4-5. From this dialog 

box, you can manually check the spelling of all the words in your drawing. 

In addition, you can click the Options button to set custom spell-checking 

options, and you can use the Dictionaries button to add or remove words 

from the spell-checking dictionary.

 

Figure 4-5: 
The Check 

Spelling 
dialog box.
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Chapter 5

Printing Your Drawings
In This Chapter
▶ Using the print command

▶ Setting print options

▶ Previewing your printouts

▶ Getting your drawings professionally printed

The Print command. The Printmeister. Big document comin’ up. Printin’ 

some pages. The Printorama. The Mentor of de Printor. Captain Toner of 

the Good Ship Laseroo.

Don’t worry — when you print a SmartDraw drawing, no one’s waiting 

to ambush you with annoying one-liners like that guy who used to be on 

Saturday Night Live. Just a handful of boring dialog boxes with boring check 

boxes. Point-point, click-click, print-print.

Printing a Drawing
To print a SmartDraw drawing, you can choose one of the following methods:

  ✓ Click the Print button on the Single-Click toolbar at the top-left side of 

the SmartDraw window.

 ✓ Click the SmartDraw button and choose Print➪Print.

Either way, the Print dialog box opens, as shown in Figure 5-1.

For most drawings, you can safely ignore most of the settings in this dialog 

box. Just make sure the correct printer is selected and then click OK. Your 

drawing is printed on the selected printer.
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Figure 5-1: 
The Print 

dialog box.
 

 Printing can be es-el-oh-double-ewe, so don’t panic if your document doesn’t 

start printing right away. Some SmartDraw drawings are very demanding on 

the printer, so sometimes the printer has to work for a while before it can pro-

duce a finished page. Be patient. The Print dialog box has every intention of 

granting your request.

Changing Printers
If you’re lucky enough to have two or more printers at your disposal, you can 

use the Name field to pick which printer you want to use. You must first suc-

cessfully install each printer in Windows — a topic beyond the reach of this 

humble book but that you find plenty of information about in the appropriate 

version of Andy Rathbone’s Windows For Dummies (Wiley Publishing).

Printing Part of a Drawing
If your entire drawing fits on a single page, the settings in the Print Range 

section are of no consequence. But for larger drawings, you can use the Print 

Range settings to specify which pages you want to print. The choices are
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 ✓ All: Prints the entire drawing.

 ✓ Pages: Lets you select specific pages for printing. You can print a range 

of pages by typing the beginning and ending page numbers, separated by 

a hyphen, as in 5-8 to print pages 5, 6, 7, and 8. Or you can list individual 

pages, separated by commas, as in 4,8,11 to print pages 4, 8, and 11.

 ✓ Selection: Prints just the pages that contain the selected objects. First, 

select the parts of the drawing you want to print. Then call up the Print 

command, select the Selection radio button, and click OK. 

Printing More than One Copy
The Number of Copies field in the Print dialog box lets you print more than 

one copy of your document. You can click one of the arrows next to this field 

to increase or decrease the number of copies, or you can type directly in the 

field to set the number of copies.

If the drawing requires more than one page, a Collate check box appears 

beneath the Number of Copies field. If you select this box, SmartDraw prints 

each copy of your document one at a time. In other words, if your draw-

ing consists of ten pages and you select three copies and select the Collate 

check box, SmartDraw first prints all ten pages of the first copy of the docu-

ment, then all ten pages of the second copy, and then all ten pages of the 

third copy. If you don’t select the Collate check box, SmartDraw prints three 

copies of the first page, followed by three copies of the second page, followed 

by three copies of the third page, and so on.

 The Collate option saves you from the chore of manually sorting your copies. 

If your document takes forever to print because it’s loaded down with heavy-

duty graphics, however, you can probably save time in the long run by dese-

lecting the Collate check box. Why? Because many printers are fast when 

printing a second or third copy of a page. The printer may spend ten minutes 

figuring out how to print a particularly complicated page, but after it figures it 

out, the printer can print additional copies in just a few seconds. If you print 

collated copies, the printer must labor over each page separately for each 

copy of the document that it prints.

Using the Print Preview Command
The Print Preview command lets you see how your pages will appear before 

committing them to paper. To use this command, click the SmartDraw button 

in the upper-left corner of the window and then choose Print➪Print Preview. 

A preview of the printed page appears as shown in Figure 5-2.
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Figure 5-2: 
Previewing 

your printed 
output.

 

When you’re satisfied that the printout will be to your expectations, click 

the Print button to bring up the Print dialog box. Then, you can click Print to 

print your drawing. If you discover a mistake in your preview, you can close 

the preview by clicking the Undo button on the Single-Click toolbar.

Setting Print Options
The Options section of the Print dialog box lets you set several options that 

affect how the drawing is printed. Here are your options:

 ✓ Print on One Page: This box forces the entire drawing to be printed 

on a single page. If the drawing is too large to fit on a single page, 

SmartDraw scales the entire drawing down to make it fit.

 ✓ Scale up to Fit Page: This option is sort of the opposite of the Print on 

One page option. If the drawing is smaller than a single page, this option 

increases the size of the drawing so that it fills the printed page.
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 ✓ Print to Scale: This option lets you adjust the size of the printed draw-

ing. Selecting this option brings up the Set Printing Scale dialog box 

shown in Figure 5-3. You can use this dialog box to set the scale at which 

to print your drawing.

 

Figure 5-3: 
The Set 
Printing 

Scale 
dialog box.

 

 ✓ Print the Grid: If you select this option, the drawing grid is printed 

along with your drawing. You’ll usually want to leave this option turned 

off, but there may be times when you want the grid printed along with 

your drawing.

 ✓ Print Page Footers: This option prints a footer at the bottom of every 

printed page. The footer contains the name of the drawing, the page 

number, and the date and time. If you want to change the footer position 

or font, click the Define Footer button (which magically appears when 

you select the Print Page Footers option) to bring up the Define Footer 

dialog box shown in Figure 5-4.

 

Figure 5-4: 
The Define 

Footer 
dialog box.

 

Setting the Page Layout
The Page tab on the main toolbar contains a Page Setup section that includes 

several tools you can use to set the basic layout of the pages that make up 

your drawings. These tools are described in the following sections.
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Setting the orientation
  The Orientation button lets you choose one of two page orientations:

 ✓ Portrait: Orients the paper in an upright position, where the height is 

greater than the width. This is the default orientation for SmartDraw 

drawings.

 ✓ Landscape: Orients the paper sideways, so that the width is greater than 

the height.

Setting margins
  To set the size of the page margins, use the Margins button. It lets you 

choose from the following options:

 ✓ Normal: 1/2" margins.

 ✓ Narrow: 1/4" margins.

 ✓ Wide: 1" margins.

 ✓ Printer Minimum: Sizes the margins to the smallest that your printer 

can manage.

 ✓ Custom: Brings up the Page Setup dialog box, shown in Figure 5-5. 

Among other things, this dialog box lets you set the page margins to any 

value you wish.

 The Page Setup dialog box is remarkably similar to the Print dialog box, but it 

includes a few additional settings. Specifically, the Page Setup dialog box lets 

you choose the paper size and set the margins.

Printing multi-page drawings
The Page Setup dialog box (shown in Figure 5-5) also includes options that 

are useful when printing drawings that are too large to fit on one page. 

By default, SmartDraw squeezes your entire drawing onto a single page. 

However, if you deselect the Print on One Page option in the Page Setup 

dialog box, SmartDraw will print as many pages as are actually required by 

the drawing. When you deselect Print on One Page, SmartDraw adds dashed 

lines in the main drawing area to show where the actual page boundaries fall.
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Figure 5-5: 
The Page 

Setup 
dialog box.

 

The Page Setup dialog box also includes an option that adds a 1/16” overlap 

area between pages when you print drawings that won’t fit on a single page. 

This feature is useful when you intend to paste or tape the printed pages 

together.

Using a Printing Partner
If you want your SmartDraw graphic to be professionally printed, click the 

Use Printing Partner button at the bottom of the Print dialog box. Your 

default Web browser opens and displays the Mimeo.com Web site, as shown 

in Figure 5-6.

From this Web site, you can order copies of your drawing professionally 

printed and delivered via Federal Express the next day.
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Figure 5-6: 
Using 

Mimeo.com 
to profes-

sionally 
print your 
drawings.

 



Part II
Embellishing 

Your Graphics



In this part . . .

The chapters in this part are devoted to helping you 

create fantastic-looking drawings. We start with tips 

for applying color and design themes to your drawings. 

Then, we launch into other refinements, such as adding 

tables and images to your slides and working with layers.



Chapter 6

Using Themes, Styles, and Effects
In This Chapter
▶ Using themes

▶ Formatting shapes with fills, gradients, textures, and hatches

▶ Playing with lines

▶ Adding special effects

One of the most bothersome — but important — parts of creating any 

type of business graphic is making sure that the graphic not only 

conveys the information you want, but that it looks good while doing so. 

With most graphics programs, you’re on your own when it comes to adding 

the essential aesthetic quality to your drawings. Not so with SmartDraw: 

SmartDraw includes many tools that are designed to help you create good-

looking drawings.

This is not to say that you can’t create unattractive drawings with 

SmartDraw. You certainly can. However, SmartDraw does everything it can 

to steer you away from graphic doom. One of the most important features in 

this regard is its predefined themes, which can transform the entire look of 

your drawing with just a single mouse click.

This chapter starts by showing you how to work with themes. Then, it shows 

you how to change the look of individual elements of your drawing by chang-

ing colors and applying special effects to your shapes and lines.

Specifically, you find out how to set three aspects of a shape’s appearance:

 ✓ Fill, which controls the appearance of the interior of closed shapes 

like rectangles, circles, and polygons. The possibilities for fill settings 

include solid colors, gradient fills, textures, and hatching patterns.

 ✓ Line, which controls the appearance of lines — both separate line 

objects and the lines that define the boundaries of shapes. Line settings 

include the line thickness and dashing pattern, plus color, gradient fills, 

textures, and hatching patterns.

 ✓ Effects, which applies special graphic effects to shapes such as shadows, 

reflections, glow effects, bevel and gloss, and perspective.
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Note that all of the tools discussed in this chapter are located on the main 

toolbar’s Home tab. Specifically, the tools covered here are in the Theme and 

Shape Style groups.

Formatting the Easy Way 
with Design Themes

To make up for the sad fact that most of us flunked art in school, SmartDraw 

hired teams of artistically minded designers to come up with predefined 

color combinations and other design elements. It then bundled these com-

binations into themes, which you can apply to your drawings with just a few 

mouse clicks.

Color Plate 3 shows the effect that applying a theme can have on a 

SmartDraw drawing. The only difference between the two organization charts 

presented is a theme.

Applying a theme
To apply a theme, simply click the theme you want to apply in the Theme 

group on the Home tab. If the theme you want to use isn’t visible, use the 

scroll buttons to the right of the theme previews to scroll forward or back-

wards through the list of available themes.

You can click the down arrow at the bottom-right side of the Theme group to 

display the entire theme gallery, as shown in Figure 6-1. The Categories menu 

at the bottom of the gallery lets you choose which of three different theme 

galleries to display: Business, SmartDraw 2008, or Floorplan.

Here are some important things to keep in mind when you use themes:

 ✓ Themes control the fill, line, and effect settings used for all objects in 

the drawing, including shapes, lines, text, and the drawing background. 

Thus, when you apply a theme, the fill, line, and effect settings for every 

object in the drawing are changed to those specified by the theme.

 ✓ After you apply a theme, you’re still free to manually change the fill, line, 

and effect settings for any object in the drawing. However, if you change 

these settings for an object, those settings revert to the theme setting 

if you later apply a theme to the drawing. In other words, changes you 
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make to an object’s fill, line, and effects settings aren’t permanent — 

that is, unless you override the theme settings as described in the next 

section.

 

Figure 6-1: 
The Theme 

gallery.
 

Belay that theme setting!
In most cases, applying a theme is the best way to ensure that your drawings 

have an attractive and consistent appearance. However, you can override 

the color and fill effects applied by themes for specific objects. For example, 

you can easily change the color for one or more shapes in your drawing by 

following the steps outlined in the section “Filling Your Shapes” later in this 

chapter.

Unfortunately, if you then change your mind about the basic color scheme 

for the entire drawing and decide to apply a different theme, the shapes you 

applied the custom color to are reset to the color dictated by the theme. In 

other words, your customization of those shapes is lost.

To avoid this fate, you can use the Freeze Properties command for a given 

shape to specify that its properties shouldn’t be changed, even when a new 

theme is applied. Here are the steps:
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 1. Select the shape or shapes whose properties you want to freeze.

 2. Right-click one of the shapes and choose the Freeze Properties 

command.

  The Freeze Properties dialog box, shown in Figure 6-2, appears.

 

Figure 6-2: 
The Freeze 
Properties 
dialog box.

 

 3. Select the check boxes corresponding to the properties you want to 

freeze.

  You can freeze the following properties:

 • Fill Color

 • Fill Texture

 • Shadows and Glow

 • Effects

 • Text Properties

 • Line or Border Color

 • Line or Border Thickness

 • Line or Border Pattern

 • Arrowheads

  For example, to ensure that the color isn’t changed even when you apply 

a new theme, select the Fill Color option.

 4. Click OK.

  You’re done. You can now apply a new theme to the drawing without 

changing the color of the shape or shapes you selected.

 

Freezing the properties of a shape also prevents you from manually adjusting 

the shape’s properties. For example, if you freeze the Fill Color properties for 

a shape, you can’t change the fill color manually. You must unfreeze the 

shape’s properties before you can make any other changes. (To unfreeze a 

property, just right-click the object and choose Freeze Properties again, then 

deselect the properties you want to unfreeze.)
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Filling Your Shapes
The Fill command, located in the Shape Style group on the Home tab, lets 

you control how objects are filled. Essentially, this command lets you dump 

colors and patterns inside of your shapes. There are several types of colors 

and patterns that you can dump in. The simplest is a solid color. But you can 

also create a gradient fill, apply a texture, or use a hatch pattern. Figure 6-3 

shows examples of these types of fills.

Less is more
Although it’s great to have all of the design 
capabilities that come with SmartDraw avail-
able at your fingertips, there’s also an inher-
ent danger: The temptation to go overboard. 
Much like the novice presenter who discovers 
the potentials of PowerPoint and uses every 
transition and animation effect imaginable, it’s 
possible to overdo a graphic. Consider an 
example of a marketing diagram. The following 
figure is a simple, straightforward diagram cre-
ated directly from one of SmartDraw’s built-in 
templates.

The colors are coordinated, the text is clearly 
legible, and the graphic’s message is clear.

If you decided to apply almost every formatting 
option, you’d end up with a graphic similar to 
the one in the following figure.

The size and shape of all elements in this new 
version of the drawing are the same. The font is 
different, with fill textures and effects applied. 
These changes transformed a graphic that was 
originally crystal clear to one that is now next to 
impossible to figure out.

So what’s the lesson here? Do use the special 
effects and do be creative with the tools you 
use to communicate your thoughts. But don’t 
over-use them. Remember that often, less is 
more.
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Figure 6-3: 
Four types 

of fills.
 

When you click the Fill button, the menu shown in Figure 6-4 appears. The 

following sections explain how to use the many commands that appear on 

this menu.

Color Plate 4 shows off these effects.

 

Figure 6-4: 
The Fill 
menu.
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Pouring color into a shape
The easiest type of fill is a simple solid color. You can set a solid color by 

clicking the Fill button (in the Shape Style section of the Home tab) and then 

choosing one of the colors that appears on the resulting menu. The Fill menu 

includes three groups of colors:

 ✓ Recent Colors: These are colors that you’ve recently used.

 ✓ Theme Colors: These are colors that are part of the theme currently 

applied to the drawing.

 ✓ Standard Colors: These colors include red, blue, yellow, and green, 

among others.

If you want to use a color that isn’t visible on the menu, click More Fill Colors 

in the lower portion of the Fill menu. The Color dialog box appears, as shown 

in Figure 6-5, which resembles a tie-dyed shirt.

 

Figure 6-5: 
Choosing 

a color.
 

Here, you can construct any of the 16-million colors theoretically possible 

with SmartDraw. We recommend against attempting to use all 16 million of 

them in the same drawing.

You can create a custom color in three ways:

 ✓ Drag the controls in the main color area until you find a color you 

like. You can then drag the pointer on the thin vertical bar at the right 

side of the dialog box up or down to increase or decrease the intensity 

of the color that you’ve chosen. This is the easiest and most intuitive 

way to create custom colors.

 ✓ Manually set the Hue, Saturation, and Luminosity values. In most 

cases, you’ll use these settings only if someone tells you that you must 

use a particular color in your drawing, and that someone also provides 

you with the Hue, Saturation, and Luminosity values for the colors. 

Otherwise, you need a PhD in color to use these settings.



90 Part II: Embelleshing Your Graphics 

 ✓ Enter the Red, Green, and Blue values. (The Red, Green, and Blue 

values are also known as RGB values.) Again, you’ll probably use this 

option only if someone tells you that you must use a certain color and 

provides you with the RGB values to use.

 

Feel free to play all you want with the Color dialog box, but be warned: It’s 

very easy to create really ugly colors that clash badly with the other colors in 

your drawing. We suggest you stick with the standard colors and the theme 

colors instead. (If you really mess up the colors, you can fix the entire drawing 

quickly by re-applying a theme.)

Being transparent
Immediately beneath the Standard Colors section of the Fill menu is the 

Transparency section, which lets you set the transparency of a shape’s 

fill. By default, fills are 0% transparent, which means that the shape’s fill 

completely hides anything that happens to be behind the shape. The other 

transparency settings let you set increasing levels of transparency, which 

allows whatever lies behind the shape to show through the object. You can 

select one of ten transparency percentages, ranging from 0% (completely 

opaque) to 90% (almost completely transparent).

Figure 6-6 shows a simple drawing that has a rectangle filled with a stone tex-

ture. On top of the rectangle are three shapes created from one of the landscap-

ing symbol libraries. The shape on the left has no transparency: It allows none 

of the background to show through. The shape on the right has the maximum 

transparency (90%), which allows the background to show; the shape in the 

middle has 40% transparency, which allows the background to partially show.

 

Figure 6-6: 
A drawing 

that uses 
transpar-

ency.
 

No transparency 90% transparency40% transparency

Applying a gradient
A gradient fill is a fill effect that smoothly blends two different colors. Gradient 

effects can be subtle or bold, depending on how similar the blended colors are. 

For example, if you blend a bright shade of yellow into a not-so-bright shade 
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of yellow, the effect is subtle. But if you blend a bright shade of yellow into a 

bright shade of red, the effect is bold.

To apply a gradient fill, click the Fill button and choose Gradient. This reveals 

a gallery of gradient options, as shown in Figure 6-7. Then you can select the 

gradient you want to use.

 

Figure 6-7: 
Creating a 

gradient fill.
 

If none of the gradient fills in the gallery suit your fancy, you can create a 

custom gradient fill by clicking More Gradients. The Gradient Fill dialog box 

appears, as shown in Figure 6-8. You can then customize the gradient fill to 

your liking:

 

Figure 6-8: 
Customizing 

a gradient 
fill.

 

 ✓ Set the two colors you want to use for the fill by clicking the One and 

Two buttons. When you click either of these buttons, a menu similar to 

the Fill menu, showing just the color options (no gradients, textures, or 

hatches), appears. You can then choose the color you want to use.

 ✓ Pick a customized style. If you prefer, you can choose one of the pre-

defined color schemes.
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 ✓ Choose a gradient for the Color Schemes box. You can choose one of 

twelve different gradient styles to control the direction of the gradient 

and the manner in which the colors are blended.

Using textures
A texture is a photo-quality bitmap image designed so that it can be repeated 

throughout a shape without any noticeable tiling. Textures let you create 

objects that look like they’re made of wood, stone, parchment, and so on. 

Figure 6-9 gives a sampling of the textures you can create with SmartDraw.

 

Figure 6-9: 
A variety of 

textures.
 

To apply a texture, click the Fill button and choose Texture. The Texture gal-

lery is revealed, as shown in Figure 6-10. Here you can choose one of several 

textures to apply one of the more commonly used textures.

 

Figure 6-10: 
The Texture 

gallery.
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For more texture choices, click the More Textures option at the bottom of the 

gallery. The Select a Texture dialog box opens, as shown in Figure 6-11. Here 

you can choose one of the many textures provided with SmartDraw. Spend a 

few moments to peruse the various texture categories that are available.

If none of the textures that come with SmartDraw suit your fancy, you can 

use any photograph you want. To import a photograph to use as a texture, 

click the Add Texture button. The Insert Picture dialog box opens, which lets 

you select any picture file located on your computer. When you find a picture 

you want to use as a texture, select it and click Open.

 

To be suitable for use as a texture, a photograph should have a uniform 

appearance so that when the picture is tiled, the edges will blend smoothly.

 

Figure 6-11: 
The Select 

a Texture 
dialog box.

 

Batten down the hatches!
A hatch is a pattern of lines or dots that’s used to fill an object. If you choose 

Hatch from the Fill menu, you can select a pattern from the Hatch gallery 

shown in Figure 6-12. This gallery lists 48 different patterns and lets you spec-

ify your choice of foreground and background colors.

Here are a few interesting points to ponder as you lay awake tonight consid-

ering the marvel of hatches:

 ✓ You can apply a hatch to an object that has either a fill color or a texture. 

In that case, the hatch is displayed over the top of the color or texture.

 ✓ The lines or dots that make up a hatch pattern are displayed using the 

object’s line color setting.

 ✓ To remove a hatch, choose Fill➪Hatch➪No Hatch.
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Figure 6-12: 
The Hatch 

gallery.
 

Formatting Lines
As you work with SmartDraw, you encounter two basic types of lines. The 

first are actual line objects, which are usually connectors between shapes in 

a drawing. The second are lines that indicate the outline of shapes such as 

rectangles, triangles, and circles. You can apply formatting to both types of 

lines by using the Lines button, found in the Shape Style group on the Home 

tab, as shown in Figure 6-13.

The Line menu is very similar to the Fill menu. In fact, all the options available 

on the Fill menu, including colors, gradients, textures, and hatches, can be 

applied to lines. In the following sections, we explain how you can use the two 

additional commands that appear on the Line menu: Thickness and Dashes.

 

Figure 6-13: 
The Line 

menu.
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Setting the line thickness
To set the thickness of a line, choose Thickness from the Line menu. You 

can select one of four standard line thicknesses, or click Custom to open the 

Set Line or Border Thickness dialog box, as shown in Figure 6-14. From this 

dialog box, you can choose one of several predefined line formats, or you can 

set the line thickness to any arbitrary value you want.

 

Figure 6-14: 
The Set Line 

or Border 
Thickness 

dialog box.
 

SmartDraw lines have two important formatting elements: Fill and Edge. The 

Fill setting determines the exact thickness of the central portion of the line. 

The line’s fill (not to be confused with a shape fill) is filled with the color, 

gradient, texture, or hatch specified on the Line menu. Edge is an additional 

formatting element that’s added outside of the line’s fill.

The use of line edges can create interesting lines. For example, consider the 

two lines shown in Figure 6-15. Both of the lines in this figure are actually vari-

ants of the same line; specifically, they are curved lines with an arrowhead. 

The bottom curved line has a shade of gray, a line thickness of 0.13”, and a 

thin edge. The result makes the line look more like a filled shape than a line.

 

Figure 6-15: 
Adding 

thickness 
and an edge 
to a line can 

make the 
line look 

more like a 
filled shape.
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Creating dashed or doubled lines
To create dashed or doubled lines, choose Dashes from the Line menu. A gal-

lery of several dash styles is displayed. Note that the last dash style on this 

menu doesn’t actually created dashed lines; instead, it creates double lines.

 

You must first draw the line before you can make it a dashed line.

Figure 6-16 shows a simple line with an arrowhead with each of the possible 

dash styles applied.

 

Figure 6-16: 
Dashed and 

doubled 
lines.

 

Using Shape Effects
Shape effects are special effects you can apply to shapes. These effects go 

beyond simply filling the shape with color, texture, or patterns — some of the 

effects create features that spill outside of the boundaries of the shape, such 

as shadows or reflections, while other effects such as bevels or glosses alter 

the appearance of the interior of your shapes. Figure 6-17 shows examples of 

the kinds of shape effects you can create with SmartDraw.

You can find the Effects button on the Home tab in the Shape Style group. 

When you click the Effects button, a menu with the following options appears:

 ✓ Shadow

 ✓ Reflection

 ✓ Glow

 ✓ Gloss

 ✓ Bevel

 ✓ Perspective
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Figure 6-17: 
Effects 

you can 
create using 

the Effects 
menu.

 

Each of these effects has a submenu that lets you apply one of several varia-

tions of the effect to the selected shape or shapes. In addition, each submenu 

includes a choice that lets you remove the effect.

 

You can combine some of these effects on a single object, with some limita-

tions. Here’s how the combinations work:

 ✓ A shape can have a shadow, a reflection, or a glow — but you can apply 

only one of these three effects to a single object.

 ✓ A shape can have a bevel or a gloss, but not both.

 ✓ You can combine a shadow, reflection, or glow with either a bevel or a 

gloss.

In other words, a shape can have up to two effects — a shadow, reflection, or 

glow, and a bevel or gloss.

Color Plate 4 shows these effects.

The following sections cover each of the Effects commands in turn, with the 

exception of the Perspective command. You use this command to create a 

perspective effect when printing or exporting SmartDraw graphics to other 

formats. 

Applying a shadow
A shadow creates the illusion that a shape is actually a three-dimensional 

object that has cast a shadow on an imaginary background. Use shadows 

when you want your shapes to stand out a bit from an otherwise blank 

background.
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To apply a shadow effect to an object, select the object, go to the Shape Style 

group on the Home tab, click the Effects button, and choose the Shadow com-

mand. A gallery opens, listing several popular shadow styles. These shadows 

are organized into three basic shadow types:

 ✓ Drop shadows: Shadows that appear behind the object, offset a bit in 

one direction. Drop shadows create the appearance that the object is 

resting slightly above the page.

 ✓ Cast shadows: Shadows that appear in front of the object, creating the 

impression that the object is standing upright on an invisible floor, and 

the shadow is cast on this floor.

 ✓ Inside shadows: Shadows that appear inside the object.

Figure 6-18 shows an example of each kind of shadow.

 

Figure 6-18: 
Three kinds 
of shadows.

 

If you aren’t happy with any of the choices that appear in the gallery, you can 

use the Shadow dialog boxes to create custom shadows, by controlling the 

shadow’s direction and its size. Follow these steps to create a custom drop 

shadow:

 1. On the Home tab on the main toolbar, find the Shape Style group, click 

the Effects button, choose Shadow, and choose More Drop Shadows.

  The Drop Shadow dialog box opens, as shown in Figure 6-19.

 

 To create custom cast or inside shadows, click the Effects button in the 

Shape Style group on the Home tab, choose Shadow, and choose either 

More Cast Shadows or More Inside Shadows.

 2. Choose the direction of the shadow by selecting one of the nine 

choices in the Light Direction box.
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 3. Vary the size of the shadow by dragging the Size slider.

 4. Click OK to apply the shadow.

 

If you apply a shadow, you can’t also apply a reflection or glow to the same 

object.

 

Figure 6-19: 
The Drop 
Shadow 

dialog box.
 

Creating reflections
A reflection in SmartDraw is similar to a cast shadow, but instead of simply 

displaying a fuzzy gray outline of the shape, the reflection actually displays a 

mirror-image replica of the shape. For example, if you examine the reflection 

of the box shown back in Figure 6-17, you can see the word Reflection written 

in mirror image in the reflection.

To create a reflection, click the Effects button and choose Reflection, and 

then select the reflection style you want from the gallery that appears. If you 

want to create a custom reflection, choose More Reflections to call up the 

dialog box shown in Figure 6-20. Move the sliders to change both the size of 

the reflected image and its direction.

 

Figure 6-20: 
The 

Reflection 
dialog box.
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If a shape has a reflection, it can’t also have a shadow or a glow.

Making shapes glow
A glow creates — you guessed it — the impression that your shape is glow-

ing. A shape can have two types of glow: inside and outside. And the glow can 

be of any color and size you wish.

To add glow to an object, select the object, click the Effects button, and 

choose Glow. Then, choose either the inside or outside glow (or both) that 

you want to use from the gallery that appears.

As with reflections and shadows, you can create a custom outside or inside 

glow through a dialog box. Click the Effects button, choose Glow, choose 

More Glows or Effects, choose Glow, and choose More Inside Glows. Figure 

6-21 shows the Glow dialog box for an outside glow. Move the slider to con-

trol the size of the glow, and click the Color button to select the color to use 

for the glow. The dialog box used to create inside glows is similar.

 

Figure 6-21: 
The Glow 

dialog box.
 

 

An object with a glow can’t have a shadow or a reflection.

Cutting a bevel
The bevel effect creates the impression that your shape is actually a three-

dimensional object with beveled edges. As Figure 6-22 shows, there are three 

basic variations of the bevel effect: Flat, Smooth, and Bump. You can also 

vary the angle of the light source to add additional variety; each of the three 

rows in the figure uses a different light source angle.
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Figure 6-22: 
Bevels.

 

To add a beveled effect to an object, select the object, click the Effects button, 

choose Bevel, and then choose one of the bevel effects shown in the gallery.

You can create a custom bevel effect by clicking the Effects button, choos-

ing Bevel, and choosing More Bevels to bring up the Bevel dialog box shown 

in Figure 6-23. In this dialog box, you can choose which of the three bevel 

effects you want to use, and you can choose the angle of the light source.

 

An object can use the Bevel effect or the Gloss effect, but not both.

 

Figure 6-23: 
The Bevel 

dialog box.
 

Glossing up your shapes
The gloss effect makes your shapes look like you’ve spray painted them with 

high-gloss paint or coated them with chrome. Figure 6-24 shows that there 

are two basic types of gloss effect: hard and soft. For the soft effect, you can 

specify one of four different lighting angles.
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Figure 6-24: 
The gloss 

effect.
 

To use the gloss effect, select an object, click the Effects button, choose 

Gloss, and then choose one of the gloss effects shown in the gallery. If you 

don’t find a gloss you like, choose More Glosses. In the Gloss dialog box (see 

Figure 6-25), you can choose whether to use the Hard or Soft gloss effect. And 

if you choose the Soft effect, you can also choose the lighting angle.

Notice that you can also choose the reflection color. The effect created 

when you choose an alternate color is subtle — almost as if the reflection 

were created by a slightly colored lamp.

 

An object can use the Bevel effect or the Gloss effect, but not both.

 

Figure 6-25: 
The Gloss 

dialog box.
 



Chapter 7

Working with Tables
In This Chapter
▶ Looking at SmartDraw tables

▶ Creating tables

▶ Editing tables

▶ Creating forms with SmartDraw tables

We couldn’t figure out what to call this chapter: Setting the Table? 

Turning the Tables? Sliding Under the Table? Dancing on the Table? 

Tabling the Motion? The Periodic Table? Table for Two? So we gave up and 

decided to call it just “Working with Tables.”

This chapter describes the ins and outs of creating tables in SmartDraw. 

SmartDraw’s table feature is remarkably versatile, so figuring out how it 

works really pays off.

If you’re going to sit at the table, you have to remember two rules of table 

manners: No talking with your mouth open and no eating with your mouth full.

Understanding Tables
In some ways, a table is like a miniature spreadsheet that lives within your 

drawing. Like a spreadsheet, a table consists of rows and columns. At the 

intersection of each row and column is a cell in which you can enter text. 

The entire table is treated as a single shape, but each cell behaves as if it is 

a separate shape, with separate text entry and formatting abilities. Figure 7-1 

shows a SmartDraw graphic created from one of the built-in templates that 

contains four tables.
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Figure 7-1:
A 

SmartDraw 
drawing 

with four 
tables.

 

You can create tables using separate shapes, but tables have these advantages:

 ✓ Text wrapping: Each cell can contain one or more paragraphs of text, 

and text automatically wraps within its cell. Whenever text wraps to a 

new line, SmartDraw automatically increases the height of the row, if 

necessary, to accommodate the new line of text.

  If you do create your table using shapes, when the height of one shape 

increases to accommodate text, the height of other shapes in the same 

row are not automatically adjusted. In contrast, SmartDraw adjusts the 

size of each shape within a row uniformly.

 ✓ Format each cell: Each cell in a table can have its own fill and line set-

tings. You can create fancy table layouts with different colors or border 

styles for certain rows, columns, or individual cells.

 ✓ Combine cells: Although many tables are simple grids of rows and col-

umns, SmartDraw lets you combine cells to create irregularly shaped 

tables. For example, you can create a table that has one cell in the first 

row, but four cells in the second and subsequent rows. Or you can 

create a table in which one cell spans several rows. For more infor-

mation about creating this type of table, see the section “Joining and 

Splitting Cells” later in this chapter.

To work with tables, you use the Table tab in the SmartDraw main toolbar 

(see Figure 7-2). Most of the controls available in this tab are described in 

the remaining sections of this chapter. For your convenience, and because a 

chapter on tables should include at least one table, Table 7-1 shows the table 

controls found on the Table tab that you use when working with tables. If 

that doesn’t turn the tables, we don’t know what will.
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Figure 7-2: 
The Table 

tab.
 

Table 7-1 The Table Tab
Control Name What It Does

Table Creates a new table.

Rows Sets the number of rows for 
the selected table or for new 
tables created via the Insert 
Table command.

Columns Sets the number of columns 
for the selected table or for 
new tables created via the 
Insert Table command.

Delete Deletes rows or columns.

Insert Left Inserts a new column to the 
left of the selected column.

Insert 
Right

Inserts a new column to the 
right of the selected column.

Insert 
Above

Inserts a new row above the 
selected row.

Insert 
Below

Inserts a new row below the 
selected row.

Join Cells Joins the selected cells to 
create a single cell. Note that 
the cells must be adjacent.

Split Cells Splits the selected cell in 
half.

Distribute Evenly spaces the selected 
rows or columns.
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Table 7-1 (continued)
Control Name What It Does

Format 
Table

Displays a dialog box that 
lets you apply a predefined 
format to the table.

Fill Applies a fill to the selected 
cell or cells.

Grid Applies line styles to the 
border of the selected cell 
or cells.

Effects Applies fill effects.

AutoFill Fills selected cells with pre-
defined data.

Convert 
to Table

Converts an existing shape to 
a table.

Convert 
to Text

Converts a table to simple 
text.

Text 
Editing

Locks the selected cell or 
cells so that you can’t edit 
its text.

Creating a Table
The easiest way to add a table to your drawing is to click the Insert Table 

button, the first button on the left of the Table tab. Here are the steps:

 1. Click the Table tab on the main toolbar.

  The table controls that are shown in Figure 7-2 appear.

  2. In the Insert Table group, click the down-arrow beneath the Table 

button.

  The Table Gallery, shown in Figure 7-3, appears.

 3. If one of the predefined sizes shown in the Gallery matches your 

needs, click it and be done. Otherwise, continue with Step 4.
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Figure 7-3: 
The Table 

Gallery.
 

 4. Click the Define button.

  The Add New Table dialog box opens, as shown in Figure 7-4.

 5. Choose one of the predefined table formats from the Select a Table 

Format list.

  The first format in this list — Simple Grid — creates a basic table. The 

other table formats create interesting variations. For example, the 

Simple Columns format creates a table with a line between the columns 

but not between the rows. Other formats use various combinations of 

lines and shading.

 6. If your table includes heading text, select the Do Not Include Any of 

the Text check box to omit the text from your table.

  If you leave this box deselected, the text shown in the table preview 

within the Add New Table dialog box is included in the new table.

 7. Specify the size of your table with the Number of Rows and Number of 

Columns text boxes.

 

Figure 7-4: 
The Add 

New Table 
dialog box.
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 8. Click OK.

  The table is inserted into your drawing.

  Another way to create a table is to convert an existing shape to a table. First, 

select the shape. Then click the Table tab on the main toolbar, go to the Data 

group, and choose the Convert to Table command. The Convert Shape to 

Table dialog box opens, which is nearly identical to the Add New Table dialog 

box. You can then select the number of rows and columns for the table, 

choose a formatting style, and click OK to create the table.

Adding Text to a Table
After you’ve created a table, you’ll want to start adding text to its cells. To 

add text to a table cell, just click the cell and start typing. If the cell doesn’t 

accept text after you click it, try double-clicking; some tables (especially 

those that you created by converting an existing shape to a table) require 

that you double-click to enter text.

 You can change the number of clicks required to enter text into a table: Select 

the table, click the Home tab on the main toolbar if it isn’t already active, go to 

the Shape Properties group, and click the Text Entry button. The Text Editing 

Properties dialog box opens, which, among other things, lets you set whether 

a shape requires one or two clicks to initiate text editing.

Here’s how to navigate your table:

 ✓ Move from cell to cell. Press Tab.

 ✓ Move to the previous cell. Press Shift+Tab.

 ✓ Select one or more cells. Place your cursor in the desired cell and then 

drag the mouse to highlight it. Keep dragging until you have highlighted 

an entire range of cells. (In some tables you may have to double-click in 

the cell to get the insertion cursor before you can drag it.)

 ✓ Select an entire row. Move the mouse pointer just inside the left edge of 

the leftmost cell in the row. When the mouse pointer changes to a thick 

arrow, click to select the row.

 ✓ Select an entire column. Move the mouse pointer just under the top 

edge of the uppermost cell in the column and click when the pointer 

turns into a thick arrow.

 You can lock the contents of table cells to prevent users from changing their 

contents. For more information, see the section “Locking Table Cells to Create 

Forms” later in this chapter.
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Adding Rows and Columns
To add a new row or column to a table, use one of the Insert commands on 

the Table tab.

To add new rows to a table, follow one of these procedures:

 ✓ Insert a new row within the body of a table. Select the row (or any cell 

in the row) where you want to insert the new row and click either Insert 

Above or Insert Below. The new row is inserted above or below the 

selected row.

 ✓ Insert multiple rows. Select the number of rows you want to insert and 

then choose Insert Above or Insert Below.

To add new columns to a table, follow one of these procedures:

 ✓ Insert a new column within the body of the table. Select the column 

(or any cell in the column) where you want to insert the new column 

and choose either Insert Left or Insert Right. The new column inserts to 

the left or right of the selected column.

 ✓ Insert several columns. Select the number of columns you want to 

insert and choose either Insert Left or Insert Right.

Deleting Rows and Columns
If you want to delete the contents of one or more cells, select the cells and 

press the Delete key. The contents of the cells are deleted, but the cells 

remain in place.

  To completely remove one or more rows or columns from the table, select 

the rows or columns you want to delete and click the Delete button on the 

Table tab. A menu opens with the following choices:

 ✓ Remove Row

 ✓ Remove Column

 ✓ Delete Contents of Row

 ✓ Delete Contents of Column

Choose Remove Row or Remove Column.
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Adjusting Cell Size
You can adjust the height of rows or the width of columns in your tables 

in several ways. The easiest way is to simply let SmartDraw decide. As you 

enter text into your table’s cells, SmartDraw automatically adjusts the cell 

sizes to try to accommodate your text.

If SmartDraw’s efforts are not satisfactory, you can manually adjust the 

cell sizes. To do that, hover the mouse over one edge of the cell. When the 

pointer changes to a double line, click and drag the mouse to stretch the cell 

to the height or width you wish. If your table requires a double-click to enter 

text, you need to double-click in a cell before you can get the double-line to 

adjust the size.

  You can also direct SmartDraw to make all of the rows or columns — or just 

selected rows or columns — the same size. To do that, first select the rows 

or columns you want to adjust. To adjust all rows or columns, select the 

entire table. Then, click the Distribute button on the Table tab and choose 

either Space Rows Evenly or Space Columns evenly.

Joining and Splitting Cells
SmartDraw lets you join cells together to create cells that span more than 

one row or column. This lets you create almost any imaginable arrangement 

of cells. For example, Figure 7-5 shows a table that uses joined cells to create 

a form.

 

Figure 7-5: 
A table with 
joined cells.
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To join cells together, follow these steps:

 1. Highlight the cells you want to join.

  The cells must be adjacent to one another, and they must form a rectan-

gular block of cells.

  2. Click the Join Cells button.

  The cells merge into one gigantic cell that spans several rows or 

columns.

  You can also use the Split Cells command to split a cell into two cells. First, 

select the cell or cells you want to split. Then click the Split Cells button to 

split each selected cell into two cells.

Formatting a Table
If you want, you can manually format a table by using the Fill, Grid, and 

Effects buttons in the Table Style group of the Table tab. These buttons work 

almost exactly as they do for regular shapes, as described in Chapter 6, so we 

don’t go over them again here.

  An easier way to quickly format a table is to click the Format Table button 

(found in the Table Style group of the Table tab), which brings up the Format 

Table dialog box shown in Figure 7-6 (which is similar to the Add New Table 

dialog box). It lets you quickly apply a predefined set of formatting options 

with just a click of the mouse.

 

Figure 7-6: 
The Format 

Table dialog 
box.
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Using the AutoFill Feature
The AutoFill button, found in the Data group of the Table tab, lets you quickly 

fill table cells with commonly used sequences such as sequential numbers, 

the days of the week, the names of months, and so on. To use this feature, 

follow these steps:

 1. Select the rows or columns in which you want the sequence inserted.

  For example, Figure 7-7 shows a simple table with the first column of 14 

rows selected.

 

Figure 7-7: 
A table 

with cells 
selected.

 

  2. Click the AutoFill button.

  The AutoFill Table dialog box, shown in Figure 7-8, appears.

 

Figure 7-8: 
The AutoFill 
Table dialog 

box.
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 3. Choose the sequence type you want.

  The available options are Numbers, Days of the Week, Date Range, 

Months, Years, and Constant.

 4. Enter the parameters for the sequence type you selected.

  Note that the parameters change depending on which type of sequence 

you select. The following table lists the parameters that you can enter 

for each sequence type:

Type Parameters

Numbers Starting Value, Ending Value, Increment, 

Number of Values, Suffix, Prefix

Days of the Week Start With, Number of Values, Abbreviate

Date Range Starting Value, Ending Value, Increment, 

Number of Value, Suffix, Prefix

Months Start With, Number of Values, Abbreviate

Years Starting Value, Ending Value, Increment, 

Number of Values, Suffix, Prefix

Constant Constant Value, Number of Values

 5. Click OK.

  The values are inserted into your table.

  For example, Figure 7-9 shows the table that was shown in Figure 7-7 

after the selected cells have been filled with the days of the week.

 

Figure 7-9: 
A table after 
the AutoFill 

command 
has been 

used to add 
the days of 

the week.
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Here are a few additional thoughts concerning the AutoFill feature:

 ✓ The Prefix and Suffix fields let you add text before or after the sequence 

values.

 ✓ Date ranges must be in the form mm/dd. For example, 1/15 is January 15 

and 10/31 is Halloween.

 ✓ Unfortunately, the Years option isn’t clever enough to deal with two-

digit years. For example, if you want the sequence to cover 1999 to 2009 

but want the sequence to read 99, 00, 01, and so on up to 09, you’ll have 

to enter the numbers yourself.

 ✓ The Insert options at the bottom of the dialog box let you choose 

whether you want to insert the values in a row or in a column. If you 

select a row or column before you call up the dialog box, these options 

are already set for you. But if you select just a single cell, you must 

choose one of these options.

Locking Table Cells to Create Forms
SmartDraw tables are often used to create fill-in-the-blank forms. In fact, 

many of the templates that come with SmartDraw are elaborate forms that 

are created from tables. (Refer to Figure 7-5.)

By default, SmartDraw lets you edit the text in any cell in a table. But when 

you create a fill-in form, you may want to protect the text in certain cells so 

that no one else can edit the text in those cells. For example, you may want to 

protect text in cells that contain headings that should never be changed.

To protect a cell so that its text can’t be changed, select the cell, and then 

click the Table tab if it isn’t already active, go to the Data group, and deselect 

the Text Editing check box.

If you find that you do need to edit the text in a protected cell — for example, 

to change a heading — just select the cell, and then click the Text Editing 

check box again to deselect it.
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Inserting Images in Your Drawings
In This Chapter
▶ Understanding picture file types

▶ Moving pictures from your camera or hard disk into a SmartDraw drawing

▶ Cropping, zooming, and panning your pictures

▶ Correcting exposure problems

The whole purpose of SmartDraw is to create business graphics that 

convey the meaning of a thousand words in simple, straightforward, 

clear, and meaningful pictures. Sometimes, the best way to achieve that end 

is to insert photographs — pictures of your products, your clients, your staff, 

your workplace, your city, or anything else that helps support your central 

ideas — into your business graphics.

SmartDraw has many tools for working with pictures in your drawings. You 

can pull a picture in directly from a camera or scanner, you can grab a pic-

ture file that’s already saved to your computer’s hard disk, or you can use 

pictures you find on the Internet (with permission, of course!). And after you 

put a picture in your drawing, you can edit it in many useful ways: You can 

crop it, pan it, zoom it, brighten or dim it, give it more or less contrast, and 

otherwise manipulate it to your heart’s content.

 One of the more interesting things you can do with pictures in SmartDraw is 

use them as the bars in a bar chart or the pie slices in a pie chart. For informa-

tion on how to use pictures in this way, refer to Chapter 10.

Exploring the Many Types of Pictures
The world is awash with many different formats in which you can store pic-

tures on your computer. Fortunately, SmartDraw works with almost all these 

formats. The following sections describe the two basic types of pictures 

that you can work with in SmartDraw: bitmap pictures and vector drawings. 

Bitmap pictures are primarily used for photographs, while vector drawings 

are used for clip art.
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 If you have a choice in the matter, we recommend using JPEG format images 

for photographs that you want to include in SmartDraw drawings because the 

JPEG format has built-in compression that saves disk space.

Bitmap pictures
A bitmap picture is a collection of small dots that comprise an image. Bitmap 

pictures are most often used for photographs and for icons and buttons used 

on Web pages. You can create your own bitmap pictures with a scanner, a 

digital camera, or a picture-drawing program such as Adobe Photoshop or 

Corel Photo-Paint. You can even create crude bitmap pictures with Microsoft 

Paint, which is the free painting program that comes with Windows.

The dots that comprise a bitmap picture are called pixels. The number of 

pixels in a given picture depends on two factors: the picture’s resolution and 

its size. Resolution refers to the number of pixels per inch, often called dots 
per inch, abbreviated dpi. Most computer monitors display anywhere from 

72 to 100 pixels per inch. At 100 dpi, a 1-inch-square picture requires 10,000 

pixels (100 x 100).

Photographs that you print on an inkjet or laser printer should have a much 

higher resolution, typically at least 300 dpi, and often much more. At 300 

pixels per inch, a 4-x-6-inch photograph requires more than two million pixels.

 Pictures with higher resolution require more total pixels for the image than 

pictures with lower resolution. For example, a 4-x-6-inch photograph at 300 dpi 

requires 2.1 million pixels, but the same picture at 600 dpi requires more than 

8.6 million pixels.

The term megapixel, which is used to measure the capacity of digital cam-

eras, refers to the maximum number of pixels the camera can record for a 

given image, in millions. Thus, you need an 8.6 megapixel camera to create a 

4-x-6-inch picture at 600 dpi because that picture requires 8.6 million pixels 

to store.

One other thing to note about resolution is that for a given picture, increas-

ing or decreasing the printed size of the picture doesn’t change the number 

of pixels used in the picture. Instead, it changes the pixel density of the 

image. For example, if you shrink that 8.6-megapixel, 4-x-6-inch image to 2 x 

3 inches, the picture still has 8.6 million pixels. But the number of pixels per 

inch doubles from 600 to 1,200. Likewise, if you enlarge the picture to 8 x 12 

inches, the number of pixels per inch is cut in half to 300.
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The amount of color information stored for the picture — also referred to as 

the picture’s color depth — affects how many bytes of computer memory the 

picture requires. The color depth determines how many different colors the 

picture can contain. Most pictures have one of two color depths: 256 colors, 

which requires one byte per pixel, or 16.7 million colors, which requires four 

bytes per pixel. Simple charts, diagrams, cartoons, and other types of clip art 

look fine at 256 colors. Photographs usually use 16.7 million colors.

 Pictures with 16.7 million colors are also known as TrueColor pictures or 24-bit 
color pictures.

A 4-x-6-inch picture at 600 dpi, using 8.6 million pixels, requires about 8.6MB 

to store 256 colors. With TrueColor, the size of the picture jumps to a whop-

ping 32MB.

Fortunately, most bitmap picture formats use special data compression 
techniques to reduce their sizes without noticeably distorting the image. 

Depending on the actual contents of the picture, a 32MB picture may be 

reduced to under 1MB or even less.

Bitmap picture files usually have filename extensions such as .jpg, .gif, 

.bmp, or .png. Table 8-1 lists all of the bitmap file formats that SmartDraw 

supports.

Table 8-1 SmartDraw’s Bitmap Picture File Formats
Format What It Is

BMP Garden variety Windows bitmap file, used by Windows Paint and 
many other programs

GIF Graphics Interchange Format, a format commonly used for small 
Internet pictures

JPG (or 
JPEG)

A common format for photographs that includes built-in compression

PCX A variant type of bitmap file, also used by Windows Paint

PNG Portable Network Graphics, an image format designed for Internet 
graphics

TIFF Tagged Image File Format, another bitmap program most often used 
for high-quality photographs
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Vector formats
Besides bitmap pictures, the other category of picture files that you can 

use with SmartDraw are vector drawings. A vector drawing is a picture file 

that contains a detailed definition of each shape that makes up the image. 

SmartDraw itself is a vector drawing program. Other vector drawing pro-

grams include Adobe Illustrator and AutoCAD.

SmartDraw supports several of the most popular vector drawing formats, as 

described in Table 8-2.

SmartDraw lets you edit vector pictures you insert into your drawings. For 

starters, you can resize them. You can also ungroup a vector picture to break 

it into individual SmartDraw shapes, which you can then edit as you see fit 

using any of SmartDraw’s shape-editing capabilities. For example, you can 

apply line styles or fills. (For more information about these editing tech-

niques, refer to Chapter 3.)

Vector pictures are also subject to SmartDraw’s other picture-editing fea-

tures, such as the ability to crop, pan, zoom, trim to a picture, and change 

brightness or contrast only with bitmap formats.

Table 8-2 SmartDraw’s Vector File Formats
Format What It Is

AI Adobe Illustrator, one of the most popular vector drawing programs

CDR CorelDraw, a drawing program

CGM Computer Graphics Metafile

DRW The format used by Micrografx Designer and Micrografx Draw, 
two popular drawing programs that have now been absorbed into 
Corel’s product line

DWG Another type of file that AutoCAD drawings use

DXF A drawing interchange format that AutoCAD uses

EMF An Enhanced Windows Metafile picture

EPS Encapsulated Postscript, a format that some high-end drawing 
programs use

HPGL Hewlett-Packard Graphics Language, the format that Hewlett-
Packard plotters use

PDF Portable Document Format, which Adobe Acrobat uses

WMF Windows Metafile, a format that many programs recognize
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Using the Picture Tab 
with Bitmap Images

Most of SmartDraw’s features for working with bitmap pictures are consoli-

dated onto the Picture tab on the main toolbar, as shown in Figure 8-1. Note: 

Many of the controls on the Picture tab are enabled only when you’ve inserted 

an actual picture into your drawing, and when the picture is selected.

Table 8-3 lists the various controls you can find on the Picture tab.

Table 8-3 The Picture Tab
Control Name What It Does

From Camera Retrieves pictures from a digital camera, either 
directly or from the camera’s media card. 
Pictures retrieved with this command are added 
to the symbol library.

Picture Folder Retrieves pictures from a folder on your hard disk 
and adds them to a symbol library.

Open Picture Retrieves a single picture from your computer’s 
disk and inserts the picture into your drawing. 
(This command is the same as the Insert Picture 
command found on the Insert menu.)

Capture Web 
Image

Lets you retrieve images from Web pages.

Pan & Zoom Zooms in and out and pans the picture within its 
frame.

Crop Crops the picture.

Trim to Shape Trims an image to the shape that contains it.

Brightness Adjusts the image’s brightness.

Contrast Adjusts the image’s contrast.
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Figure 8-1: 
A 

SmartDraw 
drawing 

with a pic-
ture and the 
Picture tab 

visible.
 

Getting Pictures into a Symbol Library
After you understand what kinds of picture formats SmartDraw can work 

with and get an overview of the Picture toolbar, you can get down to the task 

of ornamenting your drawings with pictures. There are two basic ways to do 

that. The first is to create a symbol library that contains your pictures. Then, 

you can insert any of the pictures from the symbol library into any drawing 

you want. The second is to simply insert the picture directly from a folder on 

your hard drive into the drawing. The first method is useful if you think you’ll 

use the picture over and over again in multiple drawings; the second is more 

appropriate when you only intend to use the picture in one drawing.

The following sections describe two ways to create symbol libraries that con-

tain your pictures. For information about how to insert a picture once you 

have created a symbol library or how to insert a picture without creating a 

symbol library, see the section “Getting Pictures into Your Drawings” later in 

this chapter.
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Getting images from a camera
When your pictures are still in your camera or other source — such as a flash 

drive or CD or DVD — you need to get them into SmartDraw. What you need 

is the From Camera button. Despite its name, you use it to grab images from 

any peripheral device that contains pictures.

Here are the steps for copying pictures from a camera (or other source) into 

a SmartDraw symbol library:

 1. Buy a digital camera.

  If you already own one, you can skip this step.

 2. Take some pictures.

  If you’ve already taken the pictures, you can skip this step, too.

  That’s enough for stepping skips — er, we mean skipping steps. From 

here on out, you have to follow the steps.

 3. Remove the memory card from the camera and insert it into the 

appropriate slot on your computer.

  If your computer doesn’t have a slot that will hold the memory cards 

used by your camera, try connecting the camera directly to the com-

puter using the USB cable that came with the camera.

  As an alternative, you can buy an inexpensive card reader for about $15 

at any consumer electronics store (if there are still any in business in 

your town) or at an office supply store that carries computer supplies. 

These inexpensive card readers connect to your computer via a USB 

port and can accommodate most different kinds of camera memory 

cards.

 4. If a Windows dialog box appears asking what you want to do with the 

pictures, close it.

  5. In SmartDraw, click the Picture tab and then click the From Camera 

button.

  The Select Photo Source dialog box appears as shown in Figure 8-2.

 6. Click the photo you want to use.

  If your photos don’t appear in the dialog box, use the drop-down list to 

choose a different location. One of the locations in the drop-down list 

contains the photos on your camera’s memory card.

  If you want to erase the pictures from your camera after the pictures are 

copied into SmartDraw, select the Erase after Transfer check box. If you 

leave this check box deselected, the pictures are left on the memory card.
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Figure 8-2: 
The Select 

Photo 
Source dia-

log box.
 

 7. Click Next.

  The Set Photo Destination dialog box, shown in Figure 8-3, appears.

 

Figure 8-3: 
The Set 

Photo 
Destination 
dialog box.

 

 8. Type a name for the folder that will hold your picture(s).

  SmartDraw creates a folder using the name you provide in your My 

Pictures folder.

  If you want to store the photo(s) in a different location, click the Change 

Location button and browse to the location where you’d prefer to store 

the picture(s).

 9. Click Import Photos.
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  The photo(s) is copied to your hard disk and saved in the folder you 

specified in Step 8. In addition, a symbol library using the folder name is 

created and added to the Library tab, as shown in Figure 8-4.

 

Figure 8-4: 
Pictures 

imported 
from a 

camera are 
added to 
a symbol 

library.
 

 10. Remove the camera card and put it back in your camera.

  This may be the most important step in the procedure! Those little bug-

gers are easy to lose.

 11. You’re done!

  That was easy; wasn’t it?

Creating a symbol library 
from a folder of pictures
Maybe you already have pictures on your computer. You can use them in 

your SmartDraw charts. The Picture Folder button on the Picture tab lets you 

create a symbol library from a folder of pictures on your hard disk. Here are 

the steps:
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 1. Put some pictures in a folder somewhere on your computer.

  Most likely, this folder should live within your My Pictures folder.

  If the pictures already exist somewhere in a folder on your hard drive, 

you can skip this step.

  2. In SmartDraw, click the Picture tab and then click the Picture Folder 

button.

  The Browse for Folder dialog box appears, as shown in Figure 8-5.

 

Figure 8-5: 
The Browse 

for Folder 
dialog box.

 

 3. Navigate your way through the folder tree until you find the folder 

that contains your pictures.

  When you find the right folder, click it to select it.

 4. Click OK.

  The pictures are copied into a symbol library.

 5. You’re done!

Getting Pictures into Your Drawings
After you have your pictures copied into a symbol library, you can get down 

to the business of inserting them into your SmartDraw charts. Or if you have 

a stray photo somewhere on your hard drive or find one on the Internet that 

you don’t want to add to a symbol library, you can use that, too. The follow-

ing sections show you how.
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Inserting a picture from a library
When you have your images in your library, you can insert a picture from the 

library into your drawing the same as you would insert any other symbol:

 ✓ Simply drag a picture from the library to your drawing.

 ✓ Select a picture in the library and then click in the drawing to insert the 

picture.

 ✓ To insert the same picture into your drawing multiple times, click the 

picture, then hold down the Shift key and click the drawing several 

times. Each time you click, a copy of the picture is inserted.

Inserting a single image
If you just want to insert a single, solitary picture into a drawing, follow these 

steps:

  1. Click the Picture tab on the main toolbar, find the Get Images group, 

and click the Open Picture button.

  The Insert Picture dialog box appears, as shown in Figure 8-6.

 

Figure 8-6: 
The Insert 

Picture 
dialog box.

 

  The Open Picture command on the Picture tab is a duplicate of the 

Picture command that appears on the Insert tab.
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 2. Select the picture you want to insert.

  If the picture doesn’t appear in the dialog box, use the Look In drop-

down list to navigate your way to the folder that contains the picture 

you’re looking for.

 3. Click Open.

  The picture is inserted into your drawing, as shown in Figure 8-7.

 

Figure 8-7:
 A picture 

that has 
been 

inserted 
into a 

SmartDraw 
drawing.

 

After you’ve inserted a picture into a drawing, you can manipulate it like any 

other shape: You can drag it around, resize it, add borders, and apply effects. 

For example, Figure 8-8 shows five examples of how you can format a photo 

using the Effects button on the Design tab. For more information about apply-

ing effects, refer to Chapter 6.

Inserting an image into a shape
Normally, when you insert an image, the image takes the shape of a rectangle. 

You can then change the size and proportions of the rectangle by dragging its 

edge or corner handles. But when you do so, the shape remains a rectangle.
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Figure 8-8: 
You can 

apply shape 
effects to a 

picture.
 

What if you want to paste an image onto some shape other than a rectangle? 

It turns out that this is easy enough to do. Figure 8-9 shows several different 

shapes containing a picture.

 

Figure 8-9: 
It’s easy 

to insert a 
picture into 

a shape.
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Here are the steps:

 1. Draw a shape you want to slap a picture into.

  You can use any of SmartDraw’s drawing tools to do so. For more infor-

mation about drawing shapes, see Chapter 3.

 2. Click the shape to select it.

 3. Click the Open Picture button on the Picture tab.

  The Insert Picture dialog box appears. (Refer to Figure 8-6.)

 4. Find the picture you want to insert and select it.

 5. Click Open.

  The picture is inserted into the shape.

 When you insert a picture into a shape, you probably won’t be all that happy 

with the way the picture is framed within the bounds of the shape. But you 

can fix it up easily enough by zooming and panning the image within the 

shape. For more information, refer to the section “Panning, Zooming, and 

Cropping Your Pictures” later in this chapter.

Using a picture from a Web site
The Capture Web Image command makes it easy to import graphics from 

Web sites into your SmartDraw drawings.

 Be advised that many of the images you find on the Internet are protected by 

copyright law. Make sure you have permission to use any images you capture 

from the Web before you use them for commercial purposes.

Here’s how you capture an image from a Web page:

  1. Click the Capture Web Image button on the Picture tab.

  The special SmartDraw Web browser appears, as shown in Figure 8-10.

 2. Browse to the Web page that contains the image you want to capture.

  The special Web browser has just a few simple controls for navigating 

the Web: Forward, Back, Stop, Refresh, Search, and Start Page buttons 

work the same as they do in any Web browser; the Favorites button 

displays your Internet favorites, and the Address box lets you enter any 

Web address.

 3. Click the Capture Webpage button.

  The browser closes, and the entire Web page you were viewing is 

inserted into your drawing as a picture, as shown in Figure 8-11.
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Figure 8-10: 
The 

SmartDraw 
Web 

browser.
 

 

Figure 8-11: 
A Web page 

that has 
been cap-
tured and 

inserted into 
a drawing.
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The Capture Web Image command inserts an entire Web page into your 

drawing. After you’ve inserted the Web page, you can use SmartDraw’s crop, 

zoom, and pan features to crop the picture down to just the part of the page 

you want to use in your drawing. For more information, see the section 

“Panning, Zooming, and Cropping Your Pictures” later in this chapter.

 Another way to copy images from a Web site into SmartDraw is to simply 

right-click the picture and choose Copy to place a copy of the picture on your 

clipboard. Then, switch over to SmartDraw and press Ctrl+V to paste the pic-

ture into the drawing.

Panning, Zooming, and 
Cropping Your Pictures

In most pictures, the actual subject of the picture is too small, relative to the 

unimportant background information in the picture. And sometimes the sub-

ject isn’t properly centered within the picture.

Fortunately, SmartDraw lets you correct both of these problems by using the 

Pan & Zoom tool. You can usually improve the appearance of any picture 

using this tool — sometimes dramatically.

For example, Figure 8-12 shows two versions of a Halloween photograph. 

The top version is the raw, unedited photo. The photo is badly balanced and 

includes elements that detract from the scene, including the time and date 

stamp added by the camera. The main subject of the photo — the skeleton 

playing the antique organ — is crowded out by the other elements.

The bottom version is the same photo focusing on just the skeleton organist 

by zooming and panning. Quite an improvement, wouldn’t you say? (And yes, 

the organist did scare a lot of kids away that year.)

To pan and zoom an image, follow these steps:

 1. Select the image.

  2. Click the Picture tab on the main toolbar, find the Picture Size group, 

and click the Pan and Zoom button.

  Or just double-click the image.

  Either way, the Pan and Zoom toolbar appears next to the picture, as 

shown in Figure 8-13.
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Figure 8-12: 
Panning and 
zooming can 
dramatically 

improve a 
picture.

 

 

Figure 8-13: 
Using the 

Pan and 
Zoom 

toolbar.
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 3. Pan and zoom using the following controls:

 • Pan around the picture within its frame with the four arrows. Note 

that this control doesn’t do anything initially; you must zoom in at 

least a little before you can pan the image around within its frame.

 • Zoom in and out of the image with the slider control. After you zoom 

an image a bit, you can use the arrow controls to move the image 

left, right, up, or down.

 • Click the magnifying glass buttons above and below the slider control 
to zoom in or out.

 • Click the crop-mark button at the bottom-left side of the toolbar and 
select a rectangular region of the picture. This accomplishes both a 

zoom and a pan at the same time: The image is both zoomed and 

panned so that the area you select fills the space.

  The folder button at the bottom-right side of the Pan and Zoom toolbar 

has nothing to do with panning or zooming. Instead, it lets you replace 

the picture that’s contained within the shape with a different picture. 

When you click this button, the Insert Picture dialog box is displayed so 

that you can choose a new picture for the shape.

Following are a few additional points to ponder when using the Pan and 

Zoom toolbar:

 ✓ Another way to zoom and pan a picture when the Pan and Zoom toolbar is 

visible is to simply click within the Pan and Zoom toolbar. Then, you can 

click and drag the picture to pan it, and you can spin the wheel on your 

mouse (assuming your mouse has a wheel) to zoom the picture in or out.

  ✓ The Picture toolbar includes a separate button named Crop (shown in the 

margin) which lets you crop a picture to one of several predefined sizes, 

including 4 x 6 inches, 5 x 7 inches, and 8 x 10 inches. Although this button 

is useful at times, the Crop button on the Pan and Zoom toolbar is much 

more flexible in that it lets you crop your image to any size you want.

 ✓ Note that you can zoom or pan only bitmap file formats such as JPG or 

BMP. You can’t zoom or pan vector file formats.

 ✓ When you zoom and pan a picture, the parts of the picture that aren’t 

currently visible are still present within the picture — they’re just 

hidden. If you want to actually remove the non-visible portions from the 

picture, you must trim the picture as described in the next section.
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Trimming a Picture
When you zoom and pan a picture, the parts of the picture that don’t fall 

within the shape are still present in the picture — those parts just aren’t vis-

ible. As a result, you can always use the Pan and Zoom toolbar again to view 

the parts of the picture that were clipped.

But suppose you want to permanently remove the parts of a picture that 

have been clipped off by zooming or panning? You can do that easily by 

using the Trim to Shape command. Here are the steps:

 1. Select the picture you want to trim.

  2. Click the Trim to Shape button.

  You get a Do You Really Want to Do This? confirmation dialog box, as 

shown in Figure 8-14.

 

Figure 8-14: 
Are you 

sure you 
want to 
do this?

 

 3. Click Continue.

  The picture is permanently trimmed.

 By permanently trimmed, we mean that the picture inside the drawing is 

trimmed so that the invisible parts are removed. But this clipping occurs only 

within the copy of the picture that exists within your SmartDraw file. The 

actual JPG or other type of picture file from which the picture was inserted 

isn’t changed.

Keep in mind that you can trim only bitmap files such as JPG or BMP files. 

Vector images can’t be trimmed.
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Changing the Exposure
Many pictures are either too dark or washed out. You can often correct these 

problems by using the Brightness and Contrast controls found on the Picture 

toolbar:

  ✓ Brightness: Lets you increase or decrease the picture’s brightness by as 

much as 50 percent.

  ✓ Contrast: Lets you increase or decrease the picture’s contrast, again by 

as much as 50 percent.

Keep in mind that you can adjust the brightness and contrast for only bitmap 

file formats such as JPG or BMP. You can’t adjust these settings for vector 

formats.
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Working with Layers
In This Chapter
▶ Looking at layers

▶ Making layers invisible

▶ Locking and unlocking layers

▶ Changing layer order

This chapter covers a feature of SmartDraw called layers. Layers are a way 

to separate different categories of shapes within a single drawing so that 

you can work on them separately. They’re most often used in floor plans, 

to represent the different elements that make up the floor plan, such as the 

walls, furniture, electrical, plumbing, and other types of details. Strictly speak-

ing, all SmartDraw drawings have at least one layer. However, only certain 

types of drawings — most notably floor plans — are improved by having more 

than one layer. (For more information about floor plans, see Chapter 13.)

Understanding Layers
In most SmartDraw drawings, all shapes, text, lines, and other objects you 

add to the drawing are placed directly on the page. If two objects happen to 

overlap, you can dictate which of the objects appears on top.

With all objects on one layer, you have only basic control over how objects 

overlap one another. SmartDraw has a much more powerful feature for work-

ing with overlapping objects: layers. You can think of a layer as a transparent 

paper that can hold shapes, text, lines, and other SmartDraw objects.

Every SmartDraw drawing begins life with just one layer, called the Default 

layer. In a drawing that has just the Default layer, all objects in the drawing 

belong to the Default layer.
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However, you can add more layers to a drawing — up to 32 layers altogether, 

in fact. For example, an office floor plan might have several layers, including 

these:

 ✓ A layer for the walls.

 ✓ A layer for the furniture.

 ✓ A layer for computers and other office equipment, such as copiers and 

paper shredders. (If the floor plan happens to be for the White House, 

you may need a separate layer just for the paper shredders.)

 ✓ A layer for text boxes to indicate who sits where.

Color Plate 5 shows how you can use layers in a garden landscape.

Every layer in a SmartDraw drawing has four important properties:

 ✓ Name: Every layer has a name. The name of the first layer in every 

drawing is Default. Whenever you create a new layer, you must provide 

a name for the layer. This name should reflect the content that you’ll 

place on the layer. For example, Walls, Furniture, Equipment, and Staff 

are good choices for the layer names in an office floor plan.

 ✓ Order: When a drawing has more than one layer, the layers have a stack-

ing order, just as the objects in each layer have a stacking order. The 

layer order determines what happens when objects in one layer overlap 

objects in a different layer. The objects in higher layers hide the objects 

in lower layers.

 ✓ Visible: One of the most important features of layers is that you can 

selectively reveal or hide all of the objects on each layer. By default, 

every layer is visible. That means that with an office floor plan, you can 

see the walls and other permanent elements of the floor plan, the furni-

ture, the computers and other office equipment, and the text boxes that 

identify who sits where. But suppose you want to show just the walls 

and the furniture but leave out the computers and the text boxes. You 

can hide those elements easily — simply hide the layers that contain the 

elements you want to omit.

 ✓ Clickable: Another important feature of layers is that you can lock down 

a layer so that you can’t select or modify its objects. For example, you 

can make the Walls layer in a floor plan unclickable. Then, you can freely 

edit objects in other layers of the drawing, but you won’t be able to 

move the walls unless you make the Walls layer clickable again.

 At any given moment, one — and only one — of the layers in the drawing is 

the active layer. Shapes in the active layer are always visible and always click-

able, regardless of the Visible and Clickable settings for the layer. A layer’s 

Visible and Clickable settings, in other words, are meaningful only when some 

other layer is the active layer.



137 Chapter 9: Working with Layers

Creating a New Layer
Adding a new layer to a drawing is easy. Here are the steps:

 1. Click the Page tab on the main toolbar, find the Page Setup group, 

click Layers, then click New Layer.

  The Add a New Layer dialog box appears, as shown in Figure 9-1.

 

Figure 9-1: 
The Add a 

New Layer 
dialog box.

 

 2. Type a name for the layer in the text box.

  Use a descriptive name that indicates the content that you’ll place on 

the layer.

 3. If you want to change the Visible and Clickable settings, change 

them now.

  By default, all new layers are visible but not clickable. For most new 

layers, you should leave these settings alone.

 4. Click OK.

  The new layer is added to the drawing.

The new layer is made the active layer, so that any objects you add to the 

drawing are added to the layer you just created. For information about how 

to change the active layer, see the next section.

Changing the Active Layer
As we’ve already mentioned, only one layer at a time can be active in a 

SmartDraw drawing. The layers in a SmartDraw drawing are represented by 

tabs at the bottom of the drawing area, as shown in Figure 9-2. The Walls 

layer is currently the active layer in this drawing; to change to the Default 

layer, simply click the Default tab.
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  Visible setting Clickable setting

 The objects in the active layer are always visible and always clickable, regard-

less of the settings of the Visible and Clickable properties. Those properties 

come into play only when the layer is not the active layer.

 The eye and padlock icons on the layer tabs indicate the setting of the layer’s 

Visible and Clickable properties. You can change either of these settings by 

clicking the down-arrow that appears at the bottom right side of the tab and 

then choosing Visible or Clickable from the menu that appears.

Managing Layers
You can manage the layers that you’ve created in a drawing by using the 

Define Layers dialog box, shown in Figure 9-3. There are two ways to summon 

this dialog box.

  ✓ In the Page tab on the main toolbar, go to the Page Setup group, click 

the Layers button, and then choose Define Layers.

 ✓ Double-click the tab for any layer. (You can find the tabs beneath the 

drawing area.)

Figure 9-2: 
Layers are 

represented 
by tabs at 

the bottom 
of the 

drawing 
area.
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Figure 9-3: 
The Define 

Layers 
dialog box.

 

There are several useful and interesting things you can do with the Define 

Layers dialog box:

 ✓ You can change the Visible and Clickable properties for each layer by 

selecting or deselecting the appropriate text boxes.

 ✓ You can see the number of objects on each layer.

 ✓ You can change the order of a layer relative to other layers in the draw-

ing. To change the order for a layer, first select that layer. Then, click 

the Move Layer Up or Move Layer Down button.

 ✓ You can delete a layer by selecting the layer and then clicking the 

Remove Layer button.

 ✓ You can edit a layer by selecting the layer and then clicking the Edit 

Layer button. The Edit Layer dialog box opens, which is nearly identi-

cal to the Add a New Layer dialog box that was shown in Figure 9-1. 

From this dialog box, you can change the layer’s name or its Visible or 

Clickable status.

Moving an Object to a Different Layer
Suppose you’re looking at the Furniture layer of an office floor plan and dis-

cover that it contains a photocopier, which should be on the Equipment layer.

No problem; you can easily move the copier to the correct layer by following 

these steps:

 1. Click the object that is on the wrong layer.
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  This selects the object.

  If you can see the object but can’t click it, click the tab for the layer that 

contains the object to select that layer. You should then be able to click 

the object to select it.

  2. On the Page tab on the main toolbar, go to the Page Setup group, click 

the Layers button, and then choose Move Object to Layer.

  A menu listing all the layers in your drawing appears.

 3. Click the layer you want to move the object to.

  The object is sent to its new layer.

Changing Order within a Layer
The familiar Send to Back and Bring to Front commands on the Design tab 

work differently than you might expect in a drawing that has more than one 

layer. Specifically:

 ✓ The Send to Back command always sends the selected object to the 

back of the bottom layer. If the object doesn’t already reside in the 

bottom layer, the object is moved to the bottom layer, then sent to the 

very back of that layer.

 ✓ The Bring to Front command, however, displays a dialog box such as the 

one shown in Figure 9-4 when the object isn’t already on the top layer. 

This dialog box gives you the option of bringing the item to the front of 

all objects, or just to the front of its current layer. If you choose to bring 

the object in front of all other objects, the object is moved to the top 

layer, then brought to the front of that layer.

 

Figure 9-4: 
Bringing an 

object to the 
top.

 

 If you want to constrain the Bring to Front and Send to Back commands to the 

object’s current layer, avoid using these commands on the Design tab. 

Instead, use the Bring Object to Front and Send Object to Back commands 

found on the Layers button on the Page tab. These commands move objects 

to the front or back of their current layer.
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Creating Business 

Graphics



In this part . . .

The chapters in this part show you how to use several 

of the most common types of templates that come 

with SmartDraw. You find out how to create charts such 

as bar charts and pie charts, as well as flowcharts, organi-

zation charts, floor plans, mind maps, and regular maps.
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Creating Charts
In This Chapter
▶ Creating bar charts, area charts, 3D charts, and more

▶ Working with chart templates

▶ Making changes to charts

▶ Fine-tuning your chart’s format

▶ Spicing up your charts with pictures

One of the best ways to prove a point is with numbers, and one of the 

best ways to present numbers is in a chart. With SmartDraw, creating a 

chart is easy. In fact, SmartDraw is probably the easiest tool ever created for 

making professional-looking charts.

One of the best features of charts in SmartDraw is that you don’t necessar-

ily have to create a separate data table to provide the numbers used in the 

chart. Other programs, including Microsoft Excel, view a chart as a way to 

present numbers in a special type of spreadsheet called a data table. Thus, 

in Excel, the data table is the main thing, and the chart is just a way to repre-

sent the numbers in the data table in a graphical form.

Not so in SmartDraw. Instead, in SmartDraw, the chart is the main thing. 

You don’t even have to create a data table in SmartDraw to create a chart. 

Instead, you can just click one of the elements of the chart (such as a bar in a 

bar chart) and type the value that the element represents.

In this chapter, you find out how to use this feature as well as many other fea-

tures for creating charts.

 Throughout this chapter, we use the terms chart and graph interchangeably. 

For the purposes of this chapter, these two terms mean the same thing.
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Choosing a Chart Type
Before you can create a chart in SmartDraw, you need to know the various 

types of charts that SmartDraw can create. SmartDraw includes templates for 

creating eight basic chart types, as described in the following sections.

Bar
Suppose you’re interested in spotting trends in the production, export, and 

consumption of cigarettes over a 15-year period, and you’ve found this data 

to use as the basis for your analysis:

1990 1995 2000 2005

Production 709.7 746.5 594.6 489.0

Export 164.3 231.1 148.3 113.3

Total Consumption 525.0 487.0 430.0 376.0

Depending on what you want to emphasize or highlight in your comparison, 

you’d most likely use a bar chart to represent this data graphically. Figure 

10-1 shows a bar chart using this data. The CD has another example of a bar 

chart: Author/Chapter10/10-1.

 

Figure 10-1: 
A bar chart.
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The main strength of a bar chart is its ability to show how different values 

rank against each other. This is possible because the heights of the bars 

(or their lengths, if the bars run horizontally) give you an instant picture 

of which values are the highest, which are the lowest, which are about the 

same; whether the values are increasing or decreasing; and so on. The human 

eye is very good at spotting these relationships.

As the chart in Figure 10-1 shows, a bar chart can include more than one 

set of values. In this example, three different sets of values related to the 

tobacco industry are compared for four different years: 1990, 1995, 2000, and 

2005. The three different sets of values represent the number of cigarettes 

produced, the number of cigarettes exported, and the number of cigarettes 

consumed.

In charting terms, this chart shows three distinct series of data: produc-

tion, export, and consumption. Each series also shows four categories: 1990, 

1995, 2000, and 2005. Each row in the spreadsheet used to create the chart 

is a series, and each column is a category. (Note, however, that it’s an easy 

matter to flip the chart so that the rows become categories and the columns 

become series.)

Stacked bar
A stacked bar chart is a special type of bar chart in which the different series 

in the chart are stacked on top of each other to create a single bar for each 

category. Figure 10-2 shows an example of a stacked bar chart. There’s 

another example of a stacked bar chart on the CD: Author/Chapter10/10-2.

 

Figure 10-2: 
A stacked 
bar chart.
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Stacked bar charts are often the best choice when you want to show how 

several different components of a single, composite amount vary over sev-

eral categories. In Figure 10-2, the categories represent the years 1990, 2003, 

2010, 2020, and 2030, and the single composite value represents the total 

international population. The individual components of this composite repre-

sent populations of various regions, such as Central and South America, the 

Middle East, North America, and so on.

 It’s possible to create a stacked bar chart from any data that contains more 

than one series. However, you should avoid doing so when the series doesn’t 

reflect the same type of data. In Figure 10-2, it makes sense to stack the series 

because they all represent population, and the sum of the values for each 

series gives a meaningful result: total population for all regions.

In contrast, it would be inappropriate to stack the series in the cigarette data 

used for the chart in Figure 10-1. That’s because the sum of the production, 

export, and total consumption values for each year doesn’t reflect any mean-

ingful measurement. Stacking the bars in this case would suggest that there’s 

a relationship between the series that doesn’t actually exist.

Line
A line chart is most often used to show how data changes over time. For 

example, if you have data that shows your company’s total sales for each 

month of the past three years, you can plot the sales data using a line chart. 

In most cases, the horizontal axis (also called the x-axis) represents time, 

and the vertical axis (or y-axis) represents the values that you’re plotting 

against time.

Figure 10-3 shows an example of a line chart. This chart plots the number of 

fatal accidents for different types of vehicles from 1994 to 2006. Notice that 

the chart has been embellished a bit by the addition of pictures representing 

the different types of vehicles. This kind of embellishment isn’t at all super-

fluous — without it, you’d have a difficult time quickly determining which 

vehicle type is represented by each line in the chart. (For more information, 

see the section “Creating Image Charts” later in this chapter.)

The CD includes another example of a line chart: Author/Chapter10/10-3.

Area
An area chart is similar to a line chart, except that the area between the lines 

is filled with color. Figure 10-4 shows a simple area chart that shows sales by 

region for the years 2005 through 2008. The CD includes another example of 

an area chart: Author/Chapter10/10-4.
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Figure 10-3: 
A line chart.

 

 

Figure 10-4: 
An area 

chart.
 

In an area chart, the series are stacked much as they are in a stacked bar 

chart. Thus, you should use area charts for situations in which the values 

represented by the different series are of like type, and the values in the 

series give a meaningful value when added up (in this case, total sales for all 

regions).

Layered area
A layered area chart is similar to an area chart, except that the series aren’t 

stacked. Instead, each series is plotted exactly as it would be in a line chart, 

and a fill color is used to fill the space beneath the line. Transparency is used 

so that each area is transparent, which lets you see all of the areas in the 
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chart. Figure 10-5 shows an example of a layered area chart. In this case, the 

exact same data that was shown in Figure 10-4 is presented as a layered area 

chart rather than as a regular (stacked) area chart. There’s another example 

of a layered area chart on the CD: Author/Chapter10/10-5.

 

Figure 10-5: 
A layered 

area chart.
 

Pie
A pie chart is the most common way to show the relative proportion among 

items in a whole. In a pie chart, each value is represented as a slice or wedge 

cut from a circular pie. The entire pie represents the sum of all the individual 

values, and the size of each slice makes it easy to compare the relative size of 

each value.

Figure 10-6 shows a pie chart showing five budget categories for the operat-

ing budget of an engineering firm. To emphasize how much of the budget 

actually goes to engineering, the engineering slice of the pie is separated 

from the rest of the pie. The CD includes another example of a pie chart: 

Author/Chapter10/10-6.

 

Figure 10-6: 
A pie chart.
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 A pie chart is most effective when it has six or fewer slices. If your data has 

more than six slices, you have two choices. First, you can combine several of 

the smaller slices into one slice labeled Other. Second, you can use a relative 

value chart instead, as described in the next section.

Relative value
A relative value chart is similar to a pie chart in that it’s designed to show the 

relative proportion of several items. However, instead of showing each item 

as a wedge in a circle, each item is shown as a piece of a larger rectangle that 

represents the overall total. Figure 10-7 shows the same data that was shown 

in Figure 10-6, but this time it’s plotted as a relative value chart instead of 

a pie chart. Another example of a relative value chart is on the CD: Author/

Chapter10/10-7.

 

Figure 10-7: 
A relative 

value chart.
 

3D
The 3D chart provides an interesting three-dimensional variation on bar 

and stacked bar charts. For example, Figure 10-8 shows a 3D version of the 

bar chart in Figure 10-1. The 3D effect renders the bars as three-dimensional 

objects — you can choose cylinders, cones, or cubes. In addition, the hori-

zontal and vertical axes are represented as a floor and a wall to provide a 

three-dimensional space in which the cylinders are placed. The CD includes 

another example of a 3D chart: Author/Chapter10/10-8.
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Figure 10-8: 
A 3D chart.

 

Creating a New Chart
Enough for the overview: Now it’s time to create a chart. You have four dis-

tinct ways to create a chart:

 ✓ Use one of the chart templates. This is the preferred way because 

when you use a chart template, you have the advantage of the Chart 

SmartPanel with convenient commands for the most common chart 

actions.

 ✓ Insert a chart object into an existing drawing. Any SmartDraw drawing 

can contain a chart, whether or not the drawing was originally created 

with one of the chart templates. For more information, see the section 

“Inserting a chart into an existing drawing” later in this chapter.

 ✓ Paste the data from a spreadsheet program such as Microsoft Excel via 

the clipboard. For more information on this technique, see the section 

“Pasting data from the clipboard” later in this chapter.

 ✓ Import data from an external file. This technique lets you export data 

from a spreadsheet or other program into a text file, then import the file 

into SmartDraw to create a chart.

Using a chart template
SmartDraw has a number of templates for creating charts. These templates 

are found on the New Document tab of the Document Browser in the Charts 

category, as shown in Figure 10-9. (Click the New button to bring up the 

Document Browser.)
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Figure 10-9: 
Creating 

a drawing 
from a chart 

template.
 

The templates are divided into four subcategories:

 ✓ Basic Chart: Contains a single template named Blank Chart. When 

you create a drawing from this template, no chart is actually created. 

However, you have the Chart SmartPanel available, which simplifies the 

task of creating your chart. We recommend using this template only if 

none of the other templates contains a chart that’s similar to the one 

you want to create.

 ✓ Chart Types: Contains templates of the eight major chart types.

 ✓ Picture Charts: Contains 17 sample charts that incorporate images into 

the chart. For more information about working with images, see the sec-

tion “Creating Image Charts” later in this chapter.

 ✓ Examples: Contains seven additional chart templates, many of which 

we show in the first section of this chapter. These charts contain place-

holder data you can modify as needed for your own charts.

When you choose a template, the Chart SmartPanel is displayed, as shown in 

Figure 10-10.
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Figure 10-10: 
The Chart 

SmartPanel 
is displayed 

when you 
create a 
drawing 

using one 
of the chart 
templates.

 

The Chart SmartPanel contains the following groups of commands to help 

you as you work with charts:

 ✓ Import Data: Lets you create a new chart using data copied from the clip-

board or from scratch. For more information about the Paste Data from 

Clipboard command, see the section “Pasting data from the clipboard” 

later in this chapter. For more information about the Start a New Chart 

command, see the section “Inserting a chart into an existing drawing.”

 ✓ Bar/Line/Slice Style: Contains commands that let you format the bars, 

lines, or slices in your chart.

 ✓ Add to Chart: Provides commands that let you add or remove series or 

categories.

Inserting a chart into an existing drawing
You can insert a chart into any drawing, even if you didn’t create the drawing 

from one of the chart templates.
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You can use these three ways to insert a chart into an existing drawing:

 ✓ Click the Insert tab on the main toolbar and click the Chart button.

 ✓ Click the Chart tab on the main toolbar, find the Insert Chart group, and 

click the New button.

 ✓ If you created the drawing from a chart template, find the Import Data 

section of the SmartPanel and click Start a New Chart.

No matter which way you choose, you can select a chart type from a drop-

down menu.

Pasting data from the clipboard
One of the more interesting ways to create a new chart is to paste data from 

the clipboard. First, you must copy the data you want to use for the chart 

to the clipboard. You’ll typically copy the data from an Excel spreadsheet. 

Here are the steps:

 1. In Excel, highlight the cells that contain the data you want to use for 

your chart and press Ctrl+C to copy the cells to the clipboard.

  For example, Figure 10-11 shows a range of cells that contains the same 

data used to create the charts that we show in Figure 10-1.

 

Figure 10-11: 
Copying 

data from 
Excel.

 

 2. Open SmartDraw and create a new drawing.

  We suggest the Blank Chart template.
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 3. Click the Insert tab on the main toolbar, click Chart, and then select 

Bar Chart.

  Alternatively, you can use the New command from the Chart menu. 

Either way, the chart is created, as shown in Figure 10-12.

 

Figure 10-12: 
Inserting a 

chart using 
data copied 
from Excel.

 

 If you created the drawing using one of the chart templates, you can skip Step 

3. Just press Ctrl+V to paste the contents of the clipboard into the drawing. 

Because you selected a chart template, SmartDraw knows that when you paste 

spreadsheet data, you want it converted to a chart. SmartDraw even remem-

bers the last type of chart you worked with and creates the same type for the 

pasted chart. (You can change the chart type if you want. See the section 

“Changing the chart type” later in this chapter to see how.)

Importing data from Excel
If the data you want to use for your chart exists in an Excel spreadsheet, you 

can import the data directly into your chart by following these steps:
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 1. Create a new drawing using the chart type of your choice.

 2. Click the Import from Excel File button in the SmartPanel.

  An Import Chart dialog box appears, which resembles a standard Open 

dialog box.

 3. Locate the spreadsheet file you want to import, select it, and click 

Open.

  The SmartDraw Excel File Import dialog box appears as shown in 

Figure 10-13.

 

Figure 10-13: 
Importing 
data from 

Excel.
 

 4. Highlight the cells that contain the data you want to use for your chart.

 5. Select the First Row Is Labels check box to indicate whether the first 

row contains labels, or select the First Column Is Labels check box if 

the first column contain labels rather than text.

 6. Click Import.

  The data is imported into your chart.

Using the Chart Tab
The Chart tab contains about a million commands you can use for working 

with charts. To give you an overview, Table 10-1 lists the purpose of each 

command on the Chart tab.
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Table 10-1 The Chart Tab
Control Name What It Does

New Creates a new chart.

From File Creates a new chart using data 
from a file.

From Clipboard Creates a new chart using data 
from the clipboard.

Add Series Adds a new series to the chart.

Add Category Adds a new category to the chart.

Show Data 
Table

Inserts a table that contains the 
data used to create the chart.

Swap Series & 
Categories

Exchanges the series and the 
categories.

Pie Data Selects the category used to 
create a pie chart. Note that if 
you use this command, the chart 
is converted to a pie chart.

Chart Type Lets you change the chart type.

Quick Layouts Lets you choose from a gallery of 
common layouts specific to each 
chart type.

Rotate Chart Rotates the chart orientation.

Axes Controls whether the vertical or 
horizontal axis is shown.

Grid Lets you format the background 
grid.

Legend Controls the position and 
contents of the legend.
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Control Name What It Does

Max Sets the maximum value for the 
vertical axis.

Min Sets the minimum value for the 
vertical axis.

Data Controls the position of the data 
labels.

Horizontal Axis Controls the labels and tick marks 
on the horizontal axis.

Vertical Axis Controls the labels and tick marks 
on the vertical axis.

Editing Your Chart
After you’ve created a chart in SmartDraw, the first thing you’ll want to do is 

make some modifications to the basic layout of the chart. You may need to 

change the chart type or its orientation, add or remove series or categories, 

and edit the chart values. The following sections show you how.

Changing the chart type
  Chart types in SmartDraw are completely interchangeable. Having created a 

chart of one type, you can instantly change it to any other type by clicking 

the Chart Type button, found in the Layout group on the Chart tab. When you 

click this button, a drop-down menu appears listing the eight basic 

SmartDraw chart types. Clicking any of these types reveals a gallery of chart 

layouts you can choose from. For example, Figure 10-14 shows the gallery 

options for stacked bar charts.

 You can also access the gallery for the current chart type by clicking the 

Quick Layouts button. This lets you change the quick layout without having to 

also select the chart type.

 Be careful about indiscriminately changing the chart type. Data that makes 

sense as one chart type may not work at all for a different chart type. 

SmartDraw is happy to plot your data using any chart type you select, but the 

results may not make sense. (If you mess up the chart by changing it to a non-

sensical type, you can back yourself out of the corner by pressing Ctrl+Z.)
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Figure 10-14: 
The gallery 
of bar chart 

layouts.
 

Rotating your chart
Sometimes, a chart might make more sense if you rotate it 90 degrees to 

change the orientation of the axes and bars or lines. For example, Figure 10-15 

shows the chart that was first shown in Figure 10-1, rotated 90 degrees to the 

right. The Year category is on the vertical axis and the units series is on the 

horizontal axis, with the bars running horizontally instead of vertically.

 

Figure 10-15: 
Rotating 
a chart.

 

  To rotate a chart, first select the chart. Then click the Rotate Chart button in 

the Layout group on the Chart tab and choose the rotation you want to 

apply.
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Switching series and categories
  In some cases, you can improve the presentation of a chart by swapping the 

series with the categories. SmartDraw lets you do this by clicking the Swap 

Series & Categories button in the Chart Data group on the Chart tab. When 

you click this button, the series and the categories trade places.

The best way to understand how this works is to look at an example. Figure 

10-16 shows the chart that was first shown in Figure 10-1 after the series and 

categories have been switched. All of the Production bars are now grouped 

together, as are all of the Export bars and all of the Consumption bars.

 

Figure 10-16: 
Switching 
series and 

categories.
 

Adding and removing series and categories
In most cases, the chart you get may not have exactly the arrangement of 

series and categories that you need to depict your data. For example, the 

standard bar chart has four categories and three series. But what if your data 

requires five categories and eight series?

Fortunately, you can add or remove categories or series by using these 

techniques:
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  ✓ To add a new series, click the Add Series button in the Chart Data group 

on the Chart tab. Each time you click this button, a new series is added. 

The series will have a generic name like Series 4. To assign a more mean-

ingful name to the series, click the series name in the chart legend and 

type a new name.

  ✓ To add a new category, click the Add Category button in the Chart Data 

group on the Chart tab. A new category is added with each click of this 

button. The category will have a generic name like Category 4, but you 

can click the category name to select it, then type a new name for the 

category.

 ✓ To remove a series, click any of the bars, lines, or slices in the chart to 

select all of the bars for the series. You can then remove the series by 

pressing the Delete key on your keyboard.

 ✓ To delete a category, click the mouse on the border of the rectangular 

box that surrounds the category name to select all of the items for the cat-

egory. (The border may be invisible, but it glows when the mouse hovers 

over it.) You can then delete the category by pressing the Delete key.

Editing chart values
The simplicity of editing chart values is one of the great strengths of 

SmartDraw’s charts. You can use these three basic ways to edit the values 

that are plotted in your chart:

 ✓ You can drag the bar, line, or slice to adjust its height or size.

 • For a bar or line chart, move the mouse over the top of the bar 

or line until the mouse pointer becomes a double-headed arrow. 

Then, click and drag the bar or line up or down to adjust its shape.

 • For a pie chart, click a slice to select it, and then drag one of the 

handles on either edge of the slice to adjust the size of the slice.

 ✓ If data labels are visible, you can click any data label and type a new 

value. Press Enter to complete the entry, and the bar, line, or slice is 

adjusted to reflect the value you entered.

  If data labels aren’t visible, show them by clicking the Data button in the 

Labels group on the Chart tab.

 ✓ To edit values in a table, click the Show Data Table button in the 

Chart Data group on the Chart tab. The data sheet appears, as shown 

in Figure 10-17. You can then edit any of the values in the data table; 

changes are reflected in the chart immediately. To hide the data table 

when you’re done, click the Show Data Table button again.
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Figure 10-17: 
Working 
with the 

data table.
 

Formatting Your Chart
A SmartDraw chart is made up of many constituent shapes, all of which you 

can individually format with the same formatting techniques as any other 

type of SmartDraw object.

For example, you can apply custom formatting to the bars for each series in 

a bar chart by first clicking a bar to select the series, then using any of the 

formatting options available on the Home tab to format the bar. Figure 10-18 

shows a bar chart formatted with gradient fills, bevel effects, and reflections. 

(For more information on the different effects you can add to your chart, see 

Chapter 6.)

You can also apply this type of formatting using the Fill with Colors button 

on the SmartPanel. When you click this button, a gallery of predefined fills 

appears on the SmartPanel.
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Figure 10-18: 
Formatting 

the indi-
vidual bars 
in a chart.

 

You can also format many of the additional elements that make up a chart. In 

particular:

 ✓ Titles: A chart title describes the chart’s contents. It normally appears 

at the top of the chart. You can format it using any of the text-formatting 

options that appear on the Home tab.

  ✓ Axes: You can show or hide the horizontal or vertical axis by using the 

Axes drop-down menu in the Layout group on the Chart tab. You can 

also control whether labels and tick marks should appear on the axes by 

using the Horizontal Axis and Vertical Axis buttons in the Labels group 

on the Chart tab.

  ✓ Legends: A legend identifies the data series that appear in the chart. 

When you click the Legend button in the Layout group on the Chart tab, 

a menu with several choices for the placement of the legend appears. 

You can show or hide the legend, control its position, and specify 

whether the legend should include swatches of the color fill used for 

each series, the series name, or both.

  SmartDraw can automatically create a legend, but you’re on your own if 

you need a myth or fable.

  ✓ Data labels: You can control whether labels appear at each of the data 

points in your chart by clicking the Data button in the Labels group on 

the Chart tab. The options are

 • Hide data labels

 • Outside data labels

 • Outside at an angle
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 • Outside with an angled leader

 • Custom

  If you choose Custom, the Chart Label dialog box shown in Figure 10-19 

is shown. This dialog box lets you specify the placement and the con-

tents of the data labels.

  For many charts, data labels add unnecessary clutter without adding 

much useful information. Use labels only if you think that you must back 

up your chart with exact numbers.

 

Figure 10-19: 
The Chart 

Label 
dialog box.

 

  ✓ Grid lines: Grid lines are light lines drawn behind a chart to make it 

easier to judge the position of each dot, bar, or line plotted by the chart. 

You can turn grid lines on or off via the Grid button, found in the Layout 

group on the Chart tab. Clicking this button reveals a menu that lets you 

add major or minor grid lines to the background of your chart. The grid 

lines can be horizontal, vertical, or both. Figure 10-20 shows a chart with 

major horizontal grid lines.

 

Figure 10-20: 
A chart with 

grid lines.
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Creating Image Charts
One of the most refreshing features of SmartDraw is its ability to incorporate 

images into charts. You can use images in a few different charts.

 ✓ For bar charts, you can use images as the bars for each series. The 

images can be stacked, scaled, or stretched — which option looks best 

for a given chart depends on the nature of the images. For example, you 

might stack dollar bills to indicate financial values, but you might want 

to scale a missile for a chart of various countries’ missile defense capa-

bilities. Figure 10-21 shows a bar chart that uses scaled beer glasses to 

indicate beverage sales. Color Plate 6 shows this same chart in color, as 

well as the CD: Author/Chapter10/10-21.

 

Figure 10-21: 
A bar chart 

that uses 
images.

 

 ✓ For line charts, you can use images to represent the data points. If 

you want, each series can use a different image. For an example, refer to 

Figure 10-3.

 ✓ For a pie chart, you can use an image to represent the pie. Obviously, 

this works best with images that are circular in nature. For example, 

Figure 10-22 shows a pie chart that uses a coin as its image. Color 

Plate 7 shows another chart that uses an image to display its data; 

the CD also has another pie chart that incorporates an image: Author/

Chapter10/10-22.

To use an image in a chart, follow these steps:

 1. Select the chart element that you want to apply an image to.

  For a bar chart, click any of the bars in the series to select the entire 

series. For a line chart, click the series in the legend. For a pie chart, 

click a slice.
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Figure 10-22: 
A pie chart 

that uses 
an image.

 

 2. Click the Fill with Images button on the SmartPanel.

  The Gallery shown in Figure 10-23 appears on the SmartPanel.

 3. Click the image you want to use.

  If the image you want isn’t in the gallery, click the Libraries button. 

Navigate through SmartDraw’s symbol libraries to locate the image you 

want to use. (For more information about using symbol libraries, refer to 

Chapter 8.)

  Alternatively, you can click the Import Image button to use an image file 

from your computer’s disk.

 

Figure 10-23: 
The Fill 

with Images 
gallery.
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 4. Click the Image Fill Type button and then choose the image fill type 

you want to use.

  The options are

 • Stacked Images: Stacks multiple copies of the image to represent 

the size of the value.

 • Images Represented by Size: Scales the image according to the data 

value.

 • Stretch Image: Stretches the image vertically according to the data 

value.

 • Span Across Image: Carves the image across multiple slices or bars. 

(This is the usual setting for a pie chart.)

 5. Repeat Steps 1 through 4 for each additional chart element you want 

to format.

 Although the image chart feature is cool, we suggest you use it with caution. 

Make absolutely certain that the use of your images actually enhances the 

impact of your chart rather than detracts from it. Depending on your audi-

ence, simple colors may have a more powerful impact than cute pictures. 

However, if your data lends itself to an image representation and the end 

result is compelling, go for it!

Animating a chart
SmartDraw makes it easy to add animation to 
a chart so that the various pieces of the chart 
appear one at a time. These animations are 

used when you export a SmartDraw chart to 
Microsoft PowerPoint. For more information, 
see Chapter 17.



Chapter 11

Fashioning Flowcharts
In This Chapter
▶ Looking at flowcharts

▶ Creating a basic flowchart 

▶ Understanding all the shapes used in flowcharts

▶ Splitting paths

▶ Creating cross-functional flowcharts with swim lanes

The official definition of a flowchart goes something like this: a graphic 
representation, using special symbols connected with lines, that depicts the 

sequence of steps and decisions that must be made to accomplish some process 
or task.

Hmphf.

Our preferred definition is this: a bunch of boxes and other shapes that rep-

resent the steps needed to complete some job, connected with arrows that 

show the sequence of the steps.

There. That’s not so complicated; is it?

What’s even easier than coming up with a simple definition of a flowchart 

is how easy it is to create a flowchart in SmartDraw. In this chapter, you 

find out the easy way to create simple flowcharts, as well as how to use 

SmartDraw’s advanced flowcharting features that can help you create more 

complicated flowcharts.

Getting to Know Flowcharts
A flowchart is a diagram that graphically shows the steps needed to complete 

a process. The process can be something simple, like making a pot of coffee or 

answering a telephone, or something complex, like controlling a wastewater 

treatment plant or hiring a new employee. Figure 11-1 shows a flowchart for 

hiring a new employee. The CD includes an example of a flowchart: Author/

Chapter11/11-1.
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Figure 11-1: 
A flowchart 

for hiring 
a new 

employee.

 

Process
box

Start
symbol

End
symbol

Decision
box

Simple or complex, the basic principles behind flowcharting are the same: A 

series of shapes that represent the steps of the process are connected to one 

another via lines with arrowheads that indicate the order of the steps.

To read a flowchart, you start with the oval-shaped start symbol, typically in 

the upper-left corner of the flowchart. This symbol is usually labeled simply 

Start, but sometimes it has a label that indicates the condition or criteria that 

triggers the need to follow the process defined by the flowchart. For example, 

the start symbol in the flowchart shown in Figure 11-1 is labeled Identify 

Staffing Need because the hiring process is triggered by the need to hire staff.

After you’ve located the start point of the flowchart, you simply follow the 

arrows. Thus, the Hiring Process flowchart in Figure 11-1 begins with three 

steps that should be performed in sequence:

 1. Define and write up job description

 2. Send personnel request form to HR

 3. Determine classification
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Each of these steps is represented by a rectangle, called a process box in formal 

flowchart terminology. The arrows indicate that the steps should be completed in 

sequence. In other words, you don’t determine the classification until you’ve sent 

the personnel request form to HR, and you shouldn’t send the personnel request 

form to HR until you’ve defined the job and written up the job description.

The next shape in the sequence is a diamond shape labeled Regular Hire?. 

This shape is called a decision box, and it represents a fork in the road. In most 

cases, a decision box contains a question that you can answer Yes or No to 

and two arrows that emerge from the decision box to indicate which way the 

process continues, based on the answer to the question. For example, in Figure 

11-1, the flowchart continues to the Post Job Internally step if the answer is Yes.

How much detail?
An important aspect of creating flowcharts is 
deciding how much detail you should include 
in the steps. For example, the Send Personnel 
Request Form to HR step in Figure 11-1 implies 
that you’ve located a copy of the form and filled 
it out. If you want to be more explicit, you can 
list these three steps separately, with three 
separate process boxes. Then, the first part of 
the flowchart would look like the figure.

The level of detail you use in your flowcharts is 
determined by the intended audience and how 

familiar that audience is with the procedure or 
with similar procedures.

Although it’s tempting to always include more 
detail rather than less, be advised that including 
too much detail in a flowchart can make the flow-
chart more difficult to follow. And second, if you 
make your flowchart too detailed, you must be 
absolutely certain that you include every step.
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If the answer is No, the flowchart comes to another oval, labeled Temp Hiring 

Process. The oval symbols represent not only the start of the flowchart, but 

also the end. In this case, the symbol indicates that a temporary hiring process 

will be used rather than the regular hiring process defined by this flowchart.

 One of the basic rules of flowchart design is that every path represented 

by the arrows of the flowchart must eventually lead to an end symbol. A 

flowchart may have more than one ending symbol. For example, the Hiring 

Process flowchart has two ending symbols: one labeled Temp Hiring Process 

and the other labeled Hire Candidate.

Using additional flowcharting shapes
The vast majority of flowcharts use just the four basic symbols described in 

the previous section: ovals to mark the start and end of the flowchart; rectan-

gles to indicate processing steps; diamonds to indicate decisions; and arrows 

to indicate the sequence in which steps are followed.

There are, however, many more symbols you can use in a flowchart. Table 11-1 

lists the most common ones. (Believe it or not, there are even more that aren’t 

shown here.) When you create a flowchart from one of SmartDraw’s built-in 

flowcharting templates, all of these symbols are available in the SmartPanel.

Many of the symbols shown in Table 11-1 betray their origins: They were 

developed in the 1960s for use in creating computer programming flow-

charts. It’s extremely unlikely today that any of the processes you create 

flowcharts for will involve punched cards or paper tape. We included these 

obsolete symbols in this table not just for the sake of nostalgia, but because 

these symbols appear in the SmartPanel.

Table 11-1 Flowcharting Symbols
Symbol Name Explanation

Process A task to be completed or a 
single step in a process.

Start/End Marks the start or end of the 
process.
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Symbol Name Explanation

Alternate 
process

Another shape often used for 
processes.

Decision A decision to be made which 
results in a branch in the 
procedure’s flow. Generally, 
the decision should be a 
Yes/No question, with one 
arrow going in and two 
arrows (labeled Yes and No) 
going out.

Data (Input/
Output)

A process step that obtains 
input from outside of the 
procedure or creates output 
that’s used outside of the 
procedure.

Document A process step that creates a 
printed document.

Multi-document A process step that creates 
multiple printed documents. 
This most likely means that 
the step creates multiple 
copies of a single document; 
if the step really does create 
two or more distinct docu-
ments, it’s considered better 
to list each document as a 
separate step using the 
document shape.

Stored data A process step that stores 
data, where the means by 
which the data is stored (on 
disk files or on tape) isn’t 
indicated.

(continued)
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Table 11-1 (continued)
Symbol Name Explanation

Subroutine A process step that is docu-
mented somewhere by its very 
own flowchart. This symbol is 
often used to simplify complex 
flowcharts by moving a large 
chunk of the flowchart to a 
separate flowchart, which 
can then be represented on 
the main flowchart as a single 
subroutine step.

Database Database, which can be any 
type of database, including 
Microsoft Access, SQL Server, 
or even something simple, such 
as a Word Mail Merge docu-
ment or an Excel spreadsheet.

Disk storage Disk storage, which can be 
a simple file on disk or a 
database.

Magnetic tape Tape storage.

Microfilm Microfilm storage.

Input Any generic type of input, 
such as entering data on a 
keyboard.

Punched card Old-style IBM punch cards.
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Symbol Name Explanation

Transmittal tape Data that is written to tape 
devices, which can then 
be sent to another location 
where it will presumably be 
used as input to some other 
process.

Paper tape Old-style paper tape. If you 
have a device that can read or 
write paper tape, we suggest 
you take it to the Antiques 
Roadshow on PBS.

Preparation A process step that involves 
preparation, such as setting 
up your equipment.

Manual 
operation

A process step that isn’t auto-
mated. This symbol is used 
only in computer program-
ming flowcharts. In a manual 
process flowchart (such as 
the hiring flowchart shown in 
Figure 11-1), all of the steps 
are manual, so this symbol 
isn’t needed.

Loop limit Used in computer program-
ming flowcharts to indicate 
when a loop should stop.

Display Data displayed to the user.

Delay A step that indicates a time 
delay.

(continued)
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Table 11-1 (continued)
Symbol Name Explanation

Note A comment that isn’t part of 
the procedure, but merely 
elaborates on one of its steps.

Connector Used in complex flowcharts to 
connect one point of the chart 
with another without having 
to draw a line. The connectors 
are used in pairs, and they 
contain a letter or number 
indicating which connectors 
belong together.

Or A type of decision that results 
in more than two branches. 
Thus, one arrow flows into 
this symbol and three or more 
arrows flow out. Each arrow 
that flows out of this symbol 
should be clearly labeled to 
indicate the criteria for follow-
ing the arrow.

Summing 
junction

This symbol is used when two 
or more paths converge. You 
can see an example of it in 
Figure 11-1, where three differ-
ent paths converge to return to 
the Gather Resumes step.

Off page down Used in a complicated flow-
chart to connect a path to 
another page.

Off page up Used in a complicated flow-
chart to connect a path to 
another page.
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Symbol Name Explanation

Off page left Used in a complicated flow-
chart to connect a path to 
another page.

Off page right Used in a complicated flow-
chart to connect a path to 
another page.

Off page storage SmartDraw calls this symbol 
Off Page Storage, but it’s 
really called Off Line Storage. 
It’s used to represent storage 
that is moved outside of the 
system after it’s created — for 
example, documents that are 
moved to a filing cabinet.

Internal storage Represents storage that is 
internal to the system. Used 
mostly in computer program-
ming flowcharts to indicate 
data that’s stored in internal 
program memory.

Cross-functional flowcharts
A cross-functional flowchart is a chart that divides its processes into horizon-

tal or vertical bands called swim lanes, which serve to categorize the steps of 

your process in some way. For example, Figure 11-2 shows a flowchart that 

documents financial account procedures organized into three swim lanes 

that indicate which procedures are done daily, which are done at the end of a 

financial period, and which are done when financial documents are required. 

The CD includes another example of a cross-functional flowchart: Author/

Chapter11/11-2.

Another common use for swim lanes is to show who is responsible for dif-

ferent steps in a flowchart. For example, a flowchart that documents how to 

fulfill orders might have three lanes:

 ✓ The sales department, which handles the steps involved in creating the 

order.
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 ✓ The orders department, which handles the steps involved in processing 

the order.

 ✓ The shipping department, which handles the steps involved in shipping 

the order.

Besides indicating who is responsible for each step in the flowchart, swim 

lanes have the added benefit of documenting how the departments commu-

nicate with each other. In short, whenever a line crosses one of the lanes, a 

point of communication is indicated.

You find out how to create flowcharts that use swim lanes later in this chap-

ter, in the section “Creating Swim Lanes.”

 

Figure 11-2: 
A cross-

functional 
flowchart.

 

Creating a Flowchart
SmartDraw comes with several useful templates for creating flowcharts. 

These templates are found on the New Document tab of the Document 

Browser in the Flowcharts category, as shown in Figure 11-3. (Click the New 

button in the Single-Click toolbar to open the Document Browser.)

The templates listed in the Flowcharts category are divided into four 

subcategories:
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 ✓ Basic Flowcharts: Contains a single template named Blank Flowchart. 

This flowchart begins with a single Start/End symbol to get you started. 

Use this template if none of the other templates match the flowchart you 

want to create.

 ✓ Cross Functional Flowcharts — Smart Templates: Contains three tem-

plates for creating flowcharts with swim lanes. The three samples are:

 • Blank Deployment Flowchart — 1, which creates four generic hori-

zontal swim lanes and includes a single Start symbol.

 • Blank Deployment Flowchart — 2, which creates four generic verti-

cal swim lanes and includes a single Start symbol.

 • Blank Opportunity Cost Flowchart, which creates two vertical swim 

lanes labeled Value Added and Cost Added Only. This type of flow-

chart lets you divide your process into steps that add value to the 

end result and steps that add cost.

 ✓ Specialized Flowcharts — SmartTemplates: Contains ten samples that 

contain specialized types of flowcharts, such as data flow diagrams, 

event-driven process chains, and influence diagrams.

 ✓ Examples: Contains 24 examples of finished flowcharts. You can use 

these as starting points for your own flowcharts, or you can use them 

simply to study the techniques used to create different types of flow-

charts and develop ideas for creating your own.

 

Figure 11-3: 
Creating 
a draw-

ing from a 
flowchart 
template.

 



178 Part III: Creating Business Graphics 

When you create a drawing using one of these flowcharting templates, the 

Flowchart SmartPanel is displayed, as shown in Figure 11-4.

 

Figure 11-4: 
The 

Flowchart 
SmartPanel 
is displayed 

when you 
create 

a draw-
ing using 

one of the 
flowchart 

templates.
 

The Flowchart SmartPanel contains the following groups of commands to 

help you as you work with flowcharts:

 ✓ Build: This section of the SmartPanel contains the Flowchart symbols 

library, which includes all of the symbols listed in Table 11-1, plus four 

command buttons labeled Add Left, Add Right, Add Above, and Add 

Below that make it easy to add symbols to your chart. We explain how 

to use these commands in the section “Adding Shapes.”

 ✓ Split Path: This section contains buttons that add two symbols to your 

flowchart, effectively splitting the process path into two forks. For more 

information, see the section “Splitting a Path.”

 ✓ Text: Contains the text tool, which lets you add text at any location on 

the flowchart.

 ✓ Lines: Lets you add lines. The drop-down menu lets you choose the line 

shape (straight or curved), and the Line button lets you add the line.

 ✓ SmartHelp: Provides access to SmartHelp information about creating 

flowcharts.
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Adding Shapes
If you create a flowchart from one of the templates that begins with just a 

Start shape, one of the first things you need to do is start adding shapes to 

the flowchart. You can add shapes to a flowchart using any of the standard 

techniques for adding shapes in SmartDraw. (See Chapter 3.)

You can more easily add shapes to a flowchart in two other ways: through 

the flowcharting SmartPanel or with keyboard shortcuts.

Using the flowcharting SmartPanel
The flowcharting SmartPanel makes your life much easier by providing com-

mands specifically designed for adding shapes to a flowchart. And, as an 

added benefit, when you use these commands to create the shapes in your 

flowchart, SmartDraw automatically includes connector lines and arranges 

and formats the shapes for you.

To add a shape to a flowchart, follow these steps:

 1. Select the shape you want to add from the symbol library.

  The basic flowcharting shapes are available in the SmartPanel, but you 

can click the Library tab if you want to browse for additional shapes.

 2. Select the shape in your flowchart that you want the new shape to be 

connected to.

  When your flowchart contains just one shape (the Start shape), this is 

easy: Just select the one and only shape in the flowchart. If the flowchart 

contains more than one shape already, select the shape that you want 

the new shape to follow in the procedural sequencing of the flowchart.

 3. Click one of the four Add buttons in the top section of the SmartPanel.

  The four Add buttons all do the same thing; the only difference is the 

direction in which the flowchart is extended with the new shape.

  The new shape is connected to the previous shape with an arrow.

 4. To add text to the shape, just start typing.

  Whatever text you type appears within the shape.

 5. Continue clicking any of the four Add buttons to continue inserting 

shapes.

  Each new shape is connected to the previously added shape.

  Each time you click, another copy of the selected shape is added. Each new 

shape is connected to the previously added shape. If you want to change the 

shape, just select one of the other shapes before you click the Add button.
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Figure 11-5 illustrates these steps in action.

 

Figure 11-5: 
Adding 
shapes 

using the 
Add but-

tons on the 
SmartPanel.

 

Note that if you select a shape that already has a shape connected to it, 

adding a new shape in the same direction inserts the new shape between the 

existing shapes. The drawing is automatically rearranged to accommodate 

the new shape. Figure 11-6 shows an example.

 

Figure 11-6: 
Inserting 
a shape 

between 
two existing 

shapes.
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Using keyboard shortcuts
SmartDraw provides several keyboard shortcuts you can use for inserting 

shapes into a flowchart. Select a flowchart shape, then press one of the 

keyboard shortcuts.

 This Keyboard Shortcut Is The Same as This Command

 Ctrl+→ Add Right

 Ctrl+← Add Left

 Ctrl+↑ Add Above

 Ctrl+↓ Add Below

You can use these keyboard shortcuts to quickly create multiple boxes in a 

flowchart. For example, to create the flowchart in Figure 11-7, do this:

 1. Start with the Blank Flowchart template.

 2. Press Ctrl+↓ six times.

 3. Press Ctrl+→.

 4. Press Ctrl+↑ six times.

 5. Press Ctrl+→.

 6. Press Ctrl+↓ six times.

 

Figure 11-7: 
A simple 

flowchart 
created by 
holding the 

Ctrl key and 
pressing 

the cursor 
navigation 

arrows.
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Using Decision Symbols 
and Connecting Lines

Most flowcharts involve one or more decision points, at which time you must 

make a decision that determines which step comes next. In addition, most 

real-world flowcharts include connecting lines that send you back to an ear-

lier step — a construct that’s called a loop.

For example, Figure 11-8 shows a flowchart that includes both a decision that 

determines which of two steps should be taken next, as well as a couple of 

connecting lines that form loops.

 

Figure 11-8: 
A simple 

flowchart 
that 

includes a 
decision.

 

To create this flowchart from scratch, follow these steps:

 1. Create a flowchart from the Basic Flowchart template.

 2. Select the Start shape.

 3. Click the Add Below button and then type Do Some Work.

  The Do Some Work box is added.

 4. Choose the Decision shape on the SmartPanel.

 5. Click the Add Below button and then type Time for a Break?.

  The Time for a Break? decision box is added.



183 Chapter 11: Fashioning Flowcharts

 6. Choose the Process shape on the SmartPanel.

 7. Click the Add Right button and then type Take a Break.

  The Take a Break box is added.

 8. Click the Decision diamond, click Add Below, and type Sigh.

  The Sigh button is added.

 9. Click the line between the Time for a Break? diamond and the Take a 

Break box and then type Yes.

  The word Yes is added to the line.

 10. Double-click the line between the Time for a Break? diamond and the 

Sigh box and then type No.

  The word No is added to the line.

  11. Click the Line button in the Lines section on the SmartPanel, click the 

left edge of the Sigh box, and then click the left edge of the Do Some 

Work box.

  The connector line is added from the Sigh box back up to the Do Some 

Work box, creating the loop that you’re trapped in whenever it isn’t time 

to take a break.

  If the arrowhead appears on the wrong end of your line, use the Arrow-

heads command in the Tools section of the Home tab to reverse it.

 12. Click the Line button again, click the top edge of the Take a Break 

box, and then click the right edge of the Do Some Work box.

  The connector line is added from the Take a Break box back up to the 

Do Some Work box, creating the loop you must return to when you’re 

finished with your break.

Splitting a Path
An interesting way to create multiple paths based on a decision point 

is to use the Split Path commands found in the Split Path section on the 

SmartPanel. To use these commands, first select an existing shape in the 

flowchart from which you want the path to split. Then choose one of the 

shapes in the SmartPanel library and click one of the Split Path buttons. Two 

copies of the shape are inserted into the drawing, each with a connecting line 

to the shape you previously selected.

 You can use the Split Path buttons to create shapes arising from decision dia-

monds, but the results will look slightly different than when you use the tech-

nique described in the previous section. In particular, the connecting lines for 

both paths will arise from the same point on the decision diamond, as shown 

in Figure 11-9.
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Figure 11-9: 
A decision 

branch 
created 
with the 

Split Path 
command.

 

Here are the steps to create this flowchart from scratch:

 1. Follow the first five steps in the previous section (“Using Decision 

Symbols and Connecting Lines”).

  The flowchart contains a Start oval, a Do Some Work box, and a Time for 

a Break? decision diamond.

  2. Select the decision diamond, click the Process box shape in the 

SmartPanel library, and then click the Split Shape (Down) button.

  Two Process boxes are inserted beneath the diamond, with connecting 

lines that run diagonally from the top of each box to the bottom of the 

diamond.

 3. Click the box on the left and type Sigh.

 4. Click the box on the right and type Take a Break.

 5. Double-click the connecting line that connects to the left box and 

type No.

 6. Double-click the connecting line that connects to the right box and 

type Yes.

 7. Finish the flowchart by following Steps 11 and 12 in the previous 

section.
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Deleting a Shape
One of the best things about using the smart tools to create shapes in a flow-

chart is that SmartDraw automatically manages the arrangement of shapes 

in the flowchart. This becomes especially apparent when it comes time to 

delete a shape that you’ve decided is no longer necessary.

Deleting a shape is simple: Select the shape and press the Delete key. The 

surprise is that when you do, SmartDraw automatically sucks up the space 

that was occupied by the shape, rearranging the entire drawing, if necessary, 

to avoid having a big gaping hole where the shape once was.

Creating Swim Lanes
The final topic for this chapter is creating cross-functional flowcharts that 

utilize swim lanes. To be honest, SmartDraw doesn’t have a specific feature 

for swim lanes. Instead, the cross-functional templates cleverly use the layers 

feature (covered in Chapter 9) along with tables (covered in Chapter 7) to 

create the appearance of swim lanes.

Here’s how it works:

 ✓ A drawing with a cross-functional flowchart consists of two layers: one 

for the flowchart, the other for the swim lanes. Figure 11-10 shows how 

these layers are combined to create the cross-functional flowchart.

 ✓ The Flowchart layer contains the actual flowchart, but not the swim 

lanes. To make adjustments to the flowchart, you must work in this 

layer.

 ✓ The Swim Lanes layer uses a simple table to create the lines that mark 

off each swim lane. To make adjustments to the swim lanes, you must 

work in this layer.

 ✓ The trick to placing each flowchart shape in the correct swim lane is to 

work from the Flowchart layer and simply drag each shape into its cor-

rect lane. SmartDraw automatically adjusts all the connecting lines for 

you, although you may find that you’ll occasionally help it out by adjust-

ing the routes followed by the lines. If you need to adjust the widths of 

the lanes to accommodate the shapes, switch to the Swim Lanes layer 

and make the adjustments.
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Figure 11-10: 
A cross-

functional 
flowchart 
uses two 

layers.
 



Chapter 12

Crafting Organization Charts
In This Chapter
▶ Looking at organization charts

▶ Creating basic organization charts

▶ Changing the layout of an organization chart

▶ Adding pictures

▶ Looking at two variations of organization charts: project team charts and family trees

Organization charts — you know, those box-and-line charts that show 

who works for whom, where the buck stops, and who just got the lat-

eral arabesque — are an important part of just about every organization. At 

some point in the life of every organization, there comes a time when you 

need to formalize the organization’s structure. And an organization chart is 

the best way to do that.

Fortunately, SmartDraw is great at creating organization charts. This chapter 

shows you everything you need to know.

Creating a Basic Organization Chart
Figure 12-1 shows a basic organization chart that shows the chain of com-

mand for a small manufacturing company. Like most organization charts, this 

one shows who’s in charge and who each employee reports to. It also shows 

that the head guy has an assistant. The CD includes another example of an 

organization chart: Author/Chapter12/12-1.

SmartDraw lets you create many different variations on basic organization 

charts. For example, you can easily rotate the entire chart’s orientation. The 

most common orientation is top down; Figure 12-2 shows the same orga-

nization chart oriented left to right; the CD has another example: Author/

Chapter12/12-1.
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Figure 12-1: 
A simple 

organization 
chart.

 

 

Figure 12-2: 
An organi-

zation chart 
organized 

left to right 
instead of 
top down.

 

SmartDraw also provides several different ways that you can show subordi-

nates. For example, Figure 12-3 shows the same chart again, only this time 

the subordinates are all placed on the same horizontal level in the chart. As 

you can imagine, this arrangement can quickly become unusable in larger 

organizations.
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Figure 12-3: 
Another for-

mat for an 
organization 

chart.
 

SmartDraw has many other unique features for creating and working with 

organization charts, as you learn in the remaining sections in this chapter.

Creating an Organization Chart
To create an organization chart, start a new document using one of the 

built-in organization chart templates. You can find these templates on the 

New Document tab of the Document Browser in the Org Charts category, as 

shown in Figure 12-4. (To get to the Document Browser, click the New button 

in the Single-Click toolbar located to the right of the SmartDraw button.)

 

Figure 12-4: 
Creating 

a drawing 
from an 

organization 
chart 

template.
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The templates listed in the Org Charts category are divided into two 

subcategories:

 ✓ Basic Org Charts — Smart Templates: Contains two templates. The first 

is named Blank Org Chart. You usually use this template to create a new 

organization chart. The second, called Blank Project Team, is used to 

create a common variation on the organization chart called a team chart. 
For more information on creating team charts, see the section “Creating 

project team charts” later in this chapter.

 ✓ Examples: Contains seven additional examples of organization charts 

that you can use as starting points for your own organization charts.

Adding Boxes to a Chart
Here are the steps to add a box to an organization chart:

 1. Click the box you want the new box to be below or next to.

 2. Click one of the following buttons in the Add Shapes section of the 

SmartPanel:

  • Add Employee Below: Adds a new employee as a subordinate of the 

selected employee.

  • Add Employee to the Right: Adds a new employee as a peer of the 

selected employee. The new employee appears to the right of the 

selected employee.

  • Add Employee to the Left: Adds a new employee as a peer of the 

selected employee. The new employee appears to the left of the 

selected employee.

  • Add Employee Above: Adds a new employee as a manager to the 

selected employee.

  • Add Assistant: Adds the new employee as an assistant to the 

selected employee.

  • Add Co-Manager: Adds the new employee as a co-manager with the 

selected employee.

 3. Click the new box and then type whatever text you want to appear in 

the box.

Here are a few points to ponder when you add boxes:

 ✓ Always make sure the correct box is selected before you click one of the 

Add buttons to add a new box. For example, before you click the Add 

Employee Below button, make sure you first select the box that repre-

sents the new employee’s manager.
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 ✓ SmartDraw automatically adjusts the layout of the entire chart, if neces-

sary, to accommodate your new box.

 ✓ An Assistant box appears beneath and to the side of its manager box. 

For example, Figure 12-1 shows that Shannon Jones is an assistant to the 

company CEO, Cameron Johnson.

 ✓ Co-managers are separate individuals who share a single spot in the 

organization’s hierarchy. SmartDraw connects them with brackets above 

and below, as shown in Figure 12-5.

 

Figure 12-5: 
An organi-

zation chart 
with co-

managers.
 

Deleting Chart Boxes
To delete a box from an organization chart, select the box and press Delete. If 

the employee has any subordinates, all the subordinates are deleted as well. 

And, of course, if those subordinates have subordinates, they’re all deleted.

This makes it especially easy, for example, to update your organization chart 

if your company just laid off 10,000 people. Simply select the name of the 

managers, hit Delete, and bam! Restructuring was never so easy.

Changing the Chart Direction
As we mention earlier in this chapter, SmartDraw can automatically re-orient 

your organization chart into one of four directions: top down, bottom up, left 

to right, or right to left. Figure 12-6 shows a simple organization chart rotated 

to all four orientations.
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Figure 12-6: 
An organi-

zation 
chart can 

be rotated 
to four 

different 
orientations.

 

  To change the chart orientation, click the Chart Direction drop-down menu 

on the SmartPanel to reveal chart direction choices; then click the direction 

you want to apply to the chart.

Changing the Branch Style
Each of the branches in an organization chart can have one of five different 

branch styles. Figure 12-7 presents five variations of a simple organization 

chart in which a manager with three subordinates is shown with each of the 

five branch styles.

The two branch styles at the top of the figure arrange the subordinates in 

horizontal rows: The first style arranges all of the subordinates on a single 

row; the second style staggers the subordinates on two separate horizontal 

rows to save space. The three branch styles at the bottom of the figure stack 

the subordinates vertically: first to the left, then to the right, and finally on 

both sides.

  To change the branch style used for a given branch of your organization 

chart, first click anywhere on the branch to select it. Then, click the Branch 

Style drop-down menu on the SmartPanel to reveal a palette of branch style 

choices. Choose the one you want to use.
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Figure 12-7: 
Changing 

the branch 
style.

 

Changing the Box Format 
and Including Pictures

Each of the boxes in an organization chart can have one of three different 

exterior shapes (rectangle, rounded rectangle, and oval) and one of four dif-

ferent interior designs (basic box, photo at left, photo at top, or basic split). 

Combined, these choices result in a total of 12 different box formats, as 

shown in Figure 12-8.

  To change the style used for a box, first select the box. Then click the Box 

Format button to reveal the box format choices. You can then select one of 

the following three Box Shape options:

 ✓ Rectangle

 ✓ Rounded Rectangle

 ✓ Oval

In addition, you can choose one of four Box Inside options:

 ✓ Top Align Photo

 ✓ Left Align Photo
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 ✓ Basic Split Box

 ✓ Simple Box

 

Figure 12-8: 
Each box 

in an orga-
nization 

chart can 
have 1 of 12 
predefined 

formats.
 

The first three Box Inside options actually create a table inside the shape to 

partition the shape into two cells. If you want, you can use the commands on 

the Table tab on the main toolbar to further format these table cells.

If you choose either the Top Align Photo or Left Align Photo option, you can 

then click the Add Photo button to insert a photo into the shape. When you 

click this button, an Insert Photo dialog box appears to locate the photo you 

want to insert into the shape.

 If you don’t first convert the box to either Top Align Photo or Left Align 

Photo, clicking the Add Photo button automatically converts the box to Left 

Align Photo.

Other Types of Organization Charts
Besides the basic organization chart feature we’ve presented so far in this 

chapter, SmartDraw lets you create at least two variations on the basic orga-

nization chart: project team charts and family trees. These variations look a 

lot like organization charts, but they use different templates and have differ-

ent commands available on the SmartPanel.
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Creating project team charts
A project team chart is a special type of organization chart that you can use to 

organize teams that work together on specific projects. Although the project 

team chart has a hierarchical organization similar to a regular organization 

chart, it usually conveys a more egalitarian spirit by placing the project team 

at the center of the diagram, with sub-teams or departments emanating from 

the center in all directions, as shown in Figure 12-9. The CD includes another 

example of a project team chart: Author/Chapter12/12-9.

 

Figure 12-9: 
A project 

team chart.
 

SmartDraw includes three Project Team chart templates, both located in the 

Org Charts section on the New Document tab. The first, called Blank Project 

Team, begins with a single project box that you can use to build a project 

team chart from scratch. The other two, named Bettman Project Team and 

Internal-External Project Team, provide more complete project team charts 

from which you can start.

When you create a project team chart, the usual organization chart 

SmartPanel commands are replaced with the following commands:

 ✓ Add Team/Department: Adds a new box connected directly to the cen-

tral project box.

 ✓ Add Team Member: Adds a new box subordinate to the selected box.

 ✓ Demote: Moves the selected box down one level in the team hierarchy.

 ✓ Promote: Moves the selected box up one level in the team hierarchy.
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 ✓ Delete Team/Member: Deletes the selected box.

 ✓ Use AutoStyle: A check box that indicates whether SmartDraw should 

use its built-in style formats for the various levels of team members 

created for the project team chart.

Creating family trees
A family tree is a special type of organization chart used to trace a family’s 

genealogy. SmartDraw includes an entire section of templates called Family 

Trees, with a total of 18 different templates. Some of these templates are for 

forms that are helpful when compiling a family genealogy; others are various 

types of family tree, such as the one shown in Figure 12-10. The CD includes 

another example of a family tree chart: Author/Chapter12/12-10.

 

Figure 12-10: 
A family 

tree.
 

When you use a Family Tree template, the normal organization chart 

SmartPanel commands are replaced with the following commands:

 ✓ Add Ancestor: Adds a box above the selected box.

 ✓ Add Descendant: Adds a box beneath the selected box.

 ✓ Add Spouse: Adds a spouse box that is connected to the selected box; 

this is similar to the Add Co-Manager command in a regular organization 

chart. (Note that although you can have more than two co-managers in 

a regular organization chart, each box in a family tree can have only one 

spouse. Thus, SmartDraw doesn’t endorse or support polygamy.)

 ✓ Add Sibling: Adds a sibling for the selected box.

 ✓ Add Picture: Adds a picture to the selected box.
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Building Floor Plans
In This Chapter
▶ Using floor plans in your graphics

▶ Creating a basic floor plan

▶ Adding and knocking down walls

▶ Adding doors, windows, and other elements

▶ Dimensioning your floor plans

Let’s be clear on one point from the start: SmartDraw isn’t a precision 

drafting tool like AutoCAD. You wouldn’t want to use it to create the 

blueprints for a three-story building or a shopping mall. If you use it to design 

a bridge, and the bridge collapses, please don’t sue us.

That being said, SmartDraw does have many features in common with sophisti-

cated drafting programs. And these features lend themselves especially well to 

creating simple floor plans that you can use in a variety of handy business — 

and personal — graphics. For example:

 ✓ Every company should have an emergency evacuation plan; SmartDraw 

is the perfect tool for creating one.

 ✓ If you’re in the event-planning business, SmartDraw floor plans are great 

for planning the layout of an event venue. For example, you can create 

the exhibit hall layout for a trade show or the seating chart for a wedding 

reception.

 ✓ Moving your company into a new office? SmartDraw is ideal for planning 

the layout of people, furniture, and equipment at the new location.

 ✓ Are you in charge of your kids’ school carnival this year? SmartDraw can 

help you plan the layout.

 ✓ Setting up an amateur haunted house in your garage this fall? SmartDraw 

is the ideal tool to plan the layout of your maze and the exact position of 

all the spooks.

 ✓ Are you a crime or accident scene investigator? SmartDraw is a great 

tool for quickly creating a visual representation of a crime scene.
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In this chapter, you find out the ins and outs of creating floor plans like these 

with SmartDraw.

Fabulous Features for Floor Plans
Figure 13-1 shows a typical floor plan created in SmartDraw. This particular 

floor plan shows the layout for a house’s security system. Various symbols 

show the approximate position of various security gadgets such as keypads, 

door contact sensors, gas detectors, and so on.

 

Figure 13-1: 
A typical 

floor plan 
created in 

SmartDraw.
 

Although floor plans like this make use of many different SmartDraw features, 

there are basically four features that work together to make SmartDraw espe-

cially good at creating floor plans, as follows:

 ✓ Floor plan templates: SmartDraw comes with more than 50 sample 

floor plan templates that can get you started. These templates cover a 

variety of different floor plan types, including homes, kitchens, bath-

rooms, office buildings, churches, reception halls, restaurants, hotels, 
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classrooms, convenience stores, and grocery stores. Odds are that you 

can start your floor plan with a template that’s already close to what 

you need to create.

 ✓ Floor plan symbol libraries: SmartDraw includes hundreds of symbols 

for use in floor plans, including appliances, beds, bathroom fixtures, 

cars, computer equipment, drinking fountains, gym equipment, lighting, 

office furniture, sinks, tables, and vents. To find these libraries, click the 

Library tab in the SmartPanel. You see a few of the floor plan symbol 

libraries that are open by default. Then click More to browse for addi-

tional floor plan symbol libraries. (For more information about working 

with libraries, see Chapter 3.)

 ✓ Dimensioning: Any line in SmartDraw can have a dimension (also called 

a length label) that shows the actual length of the line. This feature is 

especially useful in floor plans, where you often want to show the exact 

size of specific features of your layout.

  Dimensions are a basic feature of SmartDraw that you can use in any 

drawing, not just in floor plans. However, you’re much more likely to 

need a dimensioning line in a floor plan than you are, say, in a pie chart 

or an organization chart. Thus, we saved the details of working with 

dimension lines for this chapter rather than Chapter 3.

 ✓ Layers: Many SmartDraw drawings utilize layers, but layers are espe-

cially important in floor plans. For example, even the simplest floor plan 

should incorporate several layers. Consider the layers you might use in 

an office floor plan. One layer can contain walls, windows, doors, and 

other immovable and permanent objects. A second layer can show fur-

niture. A third layer can show office equipment like copiers and comput-

ers. And a fourth layer can show text labels that indicate who occupies 

each space in the office.

  The great thing about using layers like this is that you can turn visibil-

ity on or off depending on your needs. And you can easily delete entire 

layers that you no longer need. For example, if you later need to use the 

same floor plan to create an emergency exit plan, you can save the origi-

nal drawing to a new drawing, then delete the furniture and label layers 

and add a new layer for the exit plan.

  For more information about working with layers, refer to Chapter 9.

 Besides floor plans, SmartDraw also includes templates for creating landscap-

ing plans. The main difference between the floor plan templates and the land-

scape templates is the symbol libraries: floor plans include symbols for 

architectural features such as doors and windows, while the landscape tem-

plates include symbols for landscape features such as trees, plants, and out-

door structures.
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Creating a Floor Plan
The first steps when creating a floor plan from scratch are to grab a mea-

suring tape and a pad of paper, and make a rough diagram of the actual 

dimensions of the space the floor plan will represent. After you have this 

information in hand, you can easily create the floor plan in SmartDraw.

SmartDraw comes with more than 50 templates for creating floor plans. 

These templates are found in the Document Browser in the Floor Plans cat-

egory, as shown in Figure 13-2.

The templates listed in the Floor Plans category are divided into the following 

subcategories:

Basic Gyms

Bathrooms Home Plans

Bedrooms Hotels

Building Plans Kitchens

Classrooms Living & Dining Rooms

Electrical Plans Office Plans

Emergency Plans Restaurant Plans

Event Plans Stores

 

Figure 13-2: 
Creating 

a drawing 
from a 

floor plan 
template.
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When you create a drawing using one of these templates, the Floor Plan 

SmartPanel shown in Figure 13-3 is displayed.

You find the following groups of commands on the Floor Plan SmartPanel:

 ✓ Construction: This section contains the Add Single Wall command, 

which lets you add a wall to a floor plan, as well as several commonly 

used symbol libraries for creating floor plans. For more information 

about these features, see the sections “Adding a Wall” and “Adding 

Doors and Windows” later in this chapter.

 ✓ Dimensions & Area: This section contains buttons for working with 

dimensions and calculating a room’s square footage. For more informa-

tion, see the following section, “Showing Dimensions.”

 ✓ Adjust: Contains commands for adjusting the walls and other elements 

of your floor plan. For more information, see the sections “Adding 

Corners” and “Busting Open a Wall” later in this chapter.

 ✓ SmartHelp: Provides access to SmartHelp information about creating 

floor plans.

 

Figure 13-3: 
The Floor 

Plan 
SmartPanel.
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Showing Dimensions
  Dimensions are lines that indicate the size of the walls in your floor plan. You 

can easily show or hide dimensions for an entire drawing by clicking the 

Show Dimensions button in the SmartPanel when nothing is selected in the 

drawing. This shows or hides the dimensions for every wall in the drawing. 

Figure 13-4 shows a floor plan both with and without dimensions.

 

Figure 13-4: 
A floor 
plan’s 

dimensions.
 

Without dimensions

With dimensions

You can show the dimensions for an individual wall by right-clicking the wall 

and choosing Show Dimensions from the context menu that appears. The 

Show Dimensions dialog box opens, as shown in Figure 13-5.

You can set the following options for the dimensions:

 ✓ Show Dimensions: Choose when to show dimensions. Your choices are 

Never, Only When Selected, or Always.

 ✓ Show: This setting lets you determine how SmartDraw measures the 

dimension. You have three choices for this setting:
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 • The distance between the end points of the line: Measures the actual 

distance between the two end points of the line (typically only 

useful for a line that is not straight).

 • The total length of the line: This measures the actual length of the 

line. If the line has more than one segment, the dimension adds all 

the segments together.

 • The length of each line segment: If you choose this option, a sepa-

rate dimension is shown for each segment of the line. This is the 

most common setting.

 ✓ Extension Lines: This check box determines whether SmartDraw 

includes the extension lines, which offset the dimension line from the 

main line. If you deselect this setting, the dimension is shown as simple 

text adjacent to the wall.

 

Figure 13-5: 
The Show 

Dimensions 
dialog box.

 

  At times, you’ll want to insert a dimension line in a floor plan to show some 

arbitrary distance that doesn’t correspond to a fixed wall, such as the width 

of a hallway or the distance between a file cabinet and a wall. To do that, 

click the Measure Distance button on the SmartPanel, click in the drawing 

where you want the dimension line to begin, and then click again where you 

want it to end. The dimension line is added to your drawing.

  The last button in the Dimensions & Area section of the SmartPanel lets you 

quickly determine the square footage of any rectangular area of your floor 

plan. To measure the square footage, click the Measure Area button on the 

SmartPanel. Then, drag a rectangle around the area of the floor plan that you 

want to measure.

As Figure 13-6 shows, this command actually inserts a rectangle object into 

the floor plan, specially formatted to show the square footage of the area it 

contains. In the figure, you can see that the office occupies 208 square feet.
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Figure 13-6: 
Measuring 

square 
footage.

 

Adding a Wall
Unless you’re incredibly lucky or just don’t pay much attention, odds are that 

the floor plans provided by the SmartDraw templates won’t match up exactly 

with the space your floor plan happens to represent. In that case, you have to 

modify the floor plan to more closely resemble your needs.

To do that, you’ll most likely need to add or remove walls.

First, check to see if the drawing has more than one layer by checking for tabs 

at the bottom of the drawing area. If the drawing does have more than one 

layer, click the one labeled Floor Plan; it’s the one that contains the walls.

Removing a wall is easy: Just click the wall to select it and then press the 

Delete key. Poof! The wall is gone.

Be careful, though: Sometimes deleting a wall deletes the entire structure! If 

that happens, just press Ctrl+Z to undo the overzealous deletion.

To add a wall, follow these simple steps:

  1. Click the Add a Single Wall button (shown in the margin).

 2. Click in the drawing where you want the wall to start.
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 3. Click in the drawing where you want the wall to end.

That’s all there is to it.

 If you draw a wall that starts at one of the end points of an existing wall, 

SmartDraw automatically combines the walls to create a single multi-

segment wall.

 You can change a wall’s angle by clicking the wall to select it, then dragging 

the rotate handle, which appears near the end point of the wall. Or you can 

drag one of the wall’s endpoints to a new location.

Adding Doors and Windows
Besides walls, the next two most important elements in a floor plan are doors 

and windows. Fortunately, SmartDraw makes it easy to add a door or window 

to a wall. Here are the steps:

 1. First draw the wall.

  When you initially draw your walls, pay no attention to the need for 

doors or windows: Draw your walls right through them. In SmartDraw, 

doors and windows are symbols that sit on top of the walls. So when 

you add a door or window, the solid line that represents the wall is 

overlaid by the open space represented by the door or window.

 2. Find the door or window shape you want to add to the wall.

  Near the top of the SmartPanel is a good selection of various types of 

doors and windows.

 3. Drag the door or window on top of the wall.

  As you approach the wall, the mouse pointer changes to an anchor 

shape. When it does, you can release the mouse button and the door or 

window snaps into place on the wall.

After you’ve snapped the door or window into place on the wall, you can 

adjust the door or window in one of the following three ways:

 ✓ To reposition the door or window along the wall, click the door or 

window and drag it to the correct position. As long as you don’t move 

the mouse too far away from the wall, the door or window remains 

snapped to the wall.

 ✓ If a door or window opens in the wrong direction, select the door or 

window and then click the Flip button on the Design tab on the main 

toolbar to flip the door or window to the correct side of the wall.
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 ✓ If the door or window is the wrong size, click the door or window to 

select it. The size appears adjacent to the door or window. Double-click 

the size and then type the correct size for the door or window. When 

you press Enter, the door or window is resized accordingly.

Adding Corners
  The Add Corner button (shown in the margin) lets you split a wall into two 

segments. To add a corner, click the Add Corner button on the SmartPanel. 

Then, click the wall you want to add the corner to, at precisely the spot 

where you want to add the corner. The line is split into two segments at the 

spot where you click.

You can then drag the end of the new segment to change its angle. Or for a 

more interesting effect, you can grab either segment in the middle and drag 

it to create a new wall segment that connects the original two segments at a 

right angle.

To see how this works, follow these steps:

 1. Create a new blank floor plan drawing.

  Click the New Drawing button in the Single-Click toolbar to the right of the 

SmartButton, then choose Blank Floor Plan from the Floorplans group.

 2. Click the Add Single Wall tool, and then draw a vertical wall.

  The size doesn’t matter: you aren’t drawing an actual scale floor plan 

here.

 3. Click the Add Single Wall tool again, then draw a horizontal wall that 

starts at the top of the wall you created in Step 2 and goes off the left 

for a ways.

  Your floor plan should now resemble Figure 13-7.

 4. Click the Add Corner button.

 5. Click about a third of the way down the vertical wall to create a corner.

  The dimension of the vertical wall changes to indicate that the wall seg-

ment has been split into two segments, as shown in Figure 13-8.

  Don’t panic if it doesn’t look like you’ve succeeded in adding a corner. 

You won’t see the actual corner until you complete the next step.
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Figure 13-7: 
Drawing 

a wall 
with two 

segments.
 

 

Figure 13-8: 
Creating 
a corner.

 

 6. Grab the middle of the upper segment of the vertical wall and move it 

to the left.

  A new horizontal segment is added to connect the upper vertical seg-

ment to the lower segment, as shown in Figure 13-9. Now you can see 

that you’ve succeeded in adding a corner to the wall.

  Pretty cool, eh?
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Figure 13-9: 
The corner 

is complete.
 

Busting Open a Wall
The Create Opening SmartPanel button lets you add an opening in the middle 

of an existing wall, without actually splitting the wall into two walls. To create 

an opening in a wall, follow these steps:

 1. Draw the wall.

  2. Click the Create Opening button.

 3. Click the wall at the location where you want the opening to appear.

  The opening appears in the wall. Initially, the opening is 4 feet in length.

 4. To adjust the size of the opening, drag either end of the opening.

  As long as the opening is selected, the dimensions of the opening appear 

in the drawing area, as shown in Figure 13-10.

 Another way to adjust the size of the opening is to double-click the size of the 

opening and then type the correct size. For example, if you want the opening 

to be exactly 7' 6", double-click the opening and type 7' 6". The size of the 

opening is adjusted accordingly.

 

Figure 13-10: 
A wall with 

an opening.
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Making Mind Maps
In This Chapter
▶ Looking at mind maps

▶ Creating a simple mind map

▶ Converting a mind map to an outline or an org chart

▶ Converting a mind map to a Gantt chart

A famous vice president once said, “What a waste it is to lose one’s mind. 

Or not to have a mind at all is very wasteful. How true that is.”

He wouldn’t have had to worry as much about losing his mind if he had just 

used SmartDraw to create a mind map.

Not that a mind map is a map that tells you where you left your brain. More 

than one vice president, and a few presidents, as well, could’ve used such a 

map. So could we, on occasion.

Instead, a mind map is a special type of business graphic that you can use for 

studying a problem, planning a course of action, making a decision, and so on.

Based on the fact that we included an entire chapter on making mind maps in 

this book, you might reasonably infer that SmartDraw is pretty good at creat-

ing mind maps. You would be correct in that inference.

Understanding Mind Maps
A mind map is essentially a visual representation of a traditional outline. But 

instead of presenting things linearly (as in an outline) or hierarchically (as in 

an organization chart), mind maps are organized radially. The central ques-

tion or concern is represented by a box in the middle of the page. Then, ideas 

that arise from that central box are arranged around it, connected with lines 

that resemble the spokes in a wheel. Figure 14-1 shows an example of a typi-

cal mind map.
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Figure 14-1: 
A typical 

mind map.

 Topic SubtopicMain topic

Types of boxes in a mind map
You can use the following three different types of boxes in a SmartDraw 

mind map:

 ✓ The main topic is the central box in the mind map, to which all other 

boxes are ultimately connected. A given mind map can have only one 

main topic box.

 ✓ A topic is a box that is connected directly to the main topic. Topic boxes 

are arranged radially around the main topic box.

 ✓ A subtopic is a box that is connected to one of the topic boxes, or to 

another subtopic box.

Mind maps versus outlines and 
organization charts
Notice that the mind map shown in Figure 14-1 could be represented in a 

simple outline form like this:

Computer Upgrade Decision
    Which Vendor?
        Price
        Quality
        Service/Support
    Buy vs. Lease
    Which Operating System?
        Which Vista Edition?
        32 bit or 64 bit?
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        Consider Linux?
    Which Hardware?
        CPU
        RAM
        Disk
        Video Card
        Monitor

However, the hierarchical nature of an outline can be stifling and can inhibit 

creativity. For starters, outlines imply that the order in which items are listed 

represents their importance — that is, the outline creates the impression 

that choosing a vendor is more important or should be done before deciding 

whether to buy or lease, which operating system to use, or which hardware 

to order.

In contrast, a mind map’s graphical orientation promotes brainstorming and 

creative thinking. Looking at the mind map in Figure 14-1, none of the boxes 

that connect to the central hub appear to be more or less important than any 

of the others.

We can also represent the mind map in Figure 14-1 in a more hierarchical 

manner using an organization chart, as shown in Figure 14-2.

 SmartDraw doesn’t have the direct ability to convert a mind map to an orga-

nization chart, but it does have the ability to export a mind map to a text file, 

then import the text file to an organization chart — effectively converting a 

mind map to an org chart. (See the “Exporting an Outline” section later in this 

chapter for more information.)

 

Figure 14-2: 
A mind map 
represented 

as an 
organization 

chart.
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However, the organization chart shares a similar inherent problem with the 

outline: The items nearer the top of an organization chart are implicitly more 

important than the items near the bottom. The implicit hierarchical ranking of 

items can cause you to draw conclusions that aren’t accurate or appropriate.

Mind maps and the sides of your brain
One theory on why mind maps are superior to outlines or organization charts 

for certain types of applications is that unlike rigid hierarchical outlines or orga-

nization charts, mind maps engage both sides of your brain. In case you don’t 

remember the details of the left-brain/right-brain breakdown, here’s a summary:

 ✓ The left side of the brain is used more for logic, facts, and details.

 ✓ The right side of the brain excels at feelings, philosophy, imagination, 

symbols, and images.

The theory, of course, is that people favor either the left brain or the right 

brain. In other words, one side of your brain is dominant over the other, 

and whether you are left-brain or right-brain dominant determines how you 

approach every aspect of life, including problem solving and reasoning.

We don’t know if all of that is true, but it may well be that the reason mind 

maps work well as problem-solving and analysis tools is that they incorpo-

rate both sides of the brain. The hierarchical part of a mind map engages the 

left side, which loves the logic and order of it all. But the graphic presenta-

tion of the mind map in which thoughts are shown emanating from the center 

of the chart instead of from the top helps to engage the right side.

And once you get both sides of your brain going, there’s no stopping you.

Creating a Mind Map
SmartDraw has several example templates that you can use to get a head 

start on your mind maps. But for the purposes of this chapter, we create one 

from scratch. Specifically, we create the Computer Upgrade Decision mind 

map that we show in Figure 14-1.

Fire up SmartDraw and then follow these steps:

 1. Click the New button in the Single-Click toolbar.

  The Document Browser opens, with the New Document tab showing.

 2. Select Mind Maps in the list of template categories.

  The mind map templates appear, as shown in Figure 14-3.
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Figure 14-3: 
The mind 

map 
templates.

 

 3. Click the Blank Mind Map template.

  SmartDraw creates a blank mind map, as shown in Figure 14-4. The blank 

mind map consists of just a single rectangle that represents the central 

starting point for the mind map.

  The Edit area of the SmartPanel includes several buttons that are 

designed to work with mind maps:

 • Add Topic: Adds a new box connected directly to the central box. 

Note that the new box is added to the center box regardless of 

which box is selected.

 • Add Subtopic: Adds a new subtopic box subordinate to the selected 

topic box.

 • Demote: Moves the selected box down one level in the mind map 

hierarchy.

 • Promote: Moves the selected box up one level in the mind map 

hierarchy.

 • Delete: Deletes the selected box. Note that if the box has any sub-

topic boxes connected to it, the subtopic boxes are deleted as well.

 • Use AutoStyle: A check box that indicates whether SmartDraw 

should use its built-in style formats to distinguish the various 

levels of topics and subtopics in your mind map.
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Figure 14-4: 
A blank 

mind map.
 

 4. Select the main topic box and then type the text for your main topic.

  In this example, type Computer Upgrade Decision.

  5. Click the Add Topic button for each topic you’d like to add.

  Click it four times to create four topic boxes, arranged radially around 

the main topic.

 6. Click each of the topic boxes and type the text for the topic.

  For the Computer Upgrade Decision mind map, name the topic boxes 

Which Vendor, Buy vs. Lease, Which Operating System?, and Which 

Hardware.

  Figure 14-5 shows what the mind map looks like at this point.

  7. Click the topic box that you’d like to add subtopics to and then click 

the Add Subtopic button on the SmartPanel for each subtopic you’d 

like to add.

  If you’re following along with the example, use the Which Vendor? topic 

box and click Add Subtopic three times. Three subtopic boxes are added 

to the Which Vendor box.
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Figure 14-5: 
A mind map 
after topics 
have been 

added.
 

 8. Click each of the new subtopic boxes and type the text for each 

subtopic.

  For this example, type Price, Quality, and Service/Support.

  Figure 14-6 shows how the mind map now appears.

 

Figure 14-6: 
A mind 

map with 
subtopics.

 

 9. Repeat Steps 7 and 8 for any remaining topic boxes that you’d like to 

add subtopics to.

  For the Which Operating System? topic, add three subtopics and label 

them Which Vista Edition?, 32 bit vs. 64 bit?, and Consider Linux?.

  For the Which Hardware? topic, add five subtopics and label them CPU, 

RAM, Disk, Video Card, and Monitor.

  When you’re finished, the mind map resembles the mind map shown in 

Figure 14-1.



216 Part III: Creating Business Graphics 

That’s all there is to it! You’ve created your first mind map. After you finish 

the first draft of your mind map, you can modify or embellish it in many 

ways. Here are but a few:

 ✓ You can rearrange the order of the topics cluster around the main topic. 

To do so, just grab one of the topic boxes and drag it to a new location.

  If you drag the topic too far away from the main topic, the topic box 

detaches from the mind map. You can easily reattach it by dragging it 

back close to the topic box.

 ✓ You can delete a topic or subtopic by selecting the box you want to 

delete and pressing the Delete key. Any subtopics beneath the box you 

delete are deleted.

 ✓ You can format your mind map. For example, you might want to change 

the color of some boxes to emphasize them. Or you might want to insert 

pictures into some of the boxes to illustrate their concepts rather than 

explain them with text.

Exporting an Outline
Because a mind map is really just a fancy way to represent an outline, 

SmartDraw includes the ability to save the outline represented by a mind 

map as a text file. You can then import this text file into other programs. For 

example, you can import the text file into Word to include the outline in a 

document.

To export an outline, follow these steps:

 1. Open your mind map.

  2. Click the Export Outline button found on the SmartPanel.

  The Export Org Chart as Text dialog box, shown in Figure 14-7, appears.

 3. Locate the folder where you want to save the file and type the 

filename.

 4. Click Save.

  The file is saved.

Just for kicks, Figure 14-8 shows a Notepad text file created with the Export 

Outline feature. After you export the outline, you can import it into any pro-

gram that can read simple text files.
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Figure 14-7: 
Exporting 

the outline 
of a mind 
map to a 
text file.

 

 

Figure 14-8: 
An exported 

outline.
 

Converting a Mind Map to a Gantt Chart
A Gantt chart is a special type of chart used to plan and track the progress of 

projects. Although SmartDraw isn’t a comprehensive project-management 

tool, you can use it to create simple Gantt charts. One of the more interest-

ing capabilities of SmartDraw is that it can convert a mind map directly to a 

Gantt chart at the click of a button.

To convert a mind map to a Gantt chart, first click the drop-down menu in 

the Change Diagram section on the SmartPanel. Then, choose Project (Gantt) 

Chart. SmartDraw responds by adding a separate layer to your drawing, 

called Project (Gantt) Chart, as shown in Figure 14-9.
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Figure 14-9: 
A mind map 

that has 
been 

converted 
to a Gantt 

chart.
 

Each box in the mind map is converted to a task item in the Gantt chart. Each 

item is scheduled with a start date, an end date, and a duration. Then, the 

schedule is graphically shown in the right-hand portion of the chart.

By default, the time schedule is shown in months. However, you can change 

that by using the Timescale drop-down menu on the SmartPanel. The options 

are Months with Days, Weeks with Days, Weeks, Quarter with Months, and 

Year with Months.

Initially, all of the items in the chart are assigned an arbitrary schedule. To 

finish the Gantt chart, you need to adjust the start date and either the end 

date or the duration for each item separately.

You can also create dependencies, which let you indicate that you can’t start 

a particular task until some other task is finished. To create a dependency, 

select the time bar for the task that’s dependent, press and hold the Shift 

key, and then select the time bar for the task that the first task is dependent 

on. Then, click the Add Dependency button on the SmartPanel. SmartDraw 

adjusts the schedule so that the first task you selected won’t start until the 

second task is finished.

 When you convert a mind map to a Gantt chart, the Gantt chart is added to 

the drawing on a new tab. The original mind map remains in the drawing, on 

a tab called Mind Map. Thus, you can return to the mind map at any time by 

clicking the Mind Map tab at the bottom of the drawing window.



Chapter 15

Working with Live Maps
In This Chapter
▶ Looking at all the map templates that come with SmartDraw

▶ Getting maps from Google Maps

▶ Adding data points to maps

Maps are important in many different types of business graphics, from 

the simplest example of a map that shows the location of your busi-

ness to more complex graphics that show sales regions, routes between loca-

tions, or perhaps even data associated with locations on the map, such as 

sales or demographic information.

SmartDraw actually has two distinct types of maps that you can work with. 

The first type includes simple templates that contain predrawn maps. The 

second are live maps, which you import from Google Maps or Google Earth 

and incorporate into your drawings. This chapter covers both features.

Working with Map Templates
SmartDraw comes with more than 200 templates containing maps of just 

about every part of the world. You’ll find maps of the United States, including 

county maps of each state of the union, plus maps of North America, South 

America, Europe, the United Kingdom, Asia, Africa, and Australia, as well as 

maps of the entire world.
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SmartDraw’s map templates are organized into several different categories, 

including these:

 ✓ Sales Maps: These maps are designed to represent regional sales areas. 

Some of them include tables you can fill out to provide the name of your 

sales representative for each area. For example, Figure 15-1 shows a 

map of a sales region comprising several states in the western United 

States, with a table that lists the representative and contact information 

for each state. This drawing was created from the Region — Western — 

2 template. The CD includes another example of a sales map: Author/

Chapter15/15-1.

 

Figure 15-1: 
A sales 

region map.
 

 ✓ County Maps: Show the counties for all 50 states in the United States. 

For example, Figure 15-2 shows the county map for the state of 

Louisiana.

  In the county maps, each county is a separate SmartDraw shape. Thus, 

you can select any county in the map and change its color or apply 

other formatting.

 ✓ Country Maps: Provide basic outline shapes of most of the countries of 

the world. For example, Figure 15-3 shows a map of Japan.

 ✓ World Maps: Provide various maps of the world or entire continents.

To create a drawing based on any of these templates, open the Document 

Browser by clicking the New button, select Maps from the list of template 

categories on the New Document tab, and then select your template.
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Figure 15-2: 
A map of the 

counties of 
Louisiana.

 

 

Figure 15-3: 
A map of 

Japan.
 

When you create a drawing from a map template, the SmartPanel includes two 

groups of library symbols: Legends and Pins & Stickers. The Legends group 

lets you create one of three kinds of legends on your map: a legend with four 

regions, a legend with six regions, and a legend with pushpins. Figure 15-4 
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shows all three of these legend symbols. (The legends are inserted as simple 

tables, so you can add or delete rows for additional symbols as needed. For 

more information about working with tables, see Chapter 7.)

 

Figure 15-4: 
Legends.

 

The Pins & Stickers group contains symbols that are useful on maps, includ-

ing pushpins, flags, compass points, dot stickers, arrows, and so on.

Introducing Live Maps
Live Maps is a SmartDraw feature that lets you incorporate maps directly 

from the Google Maps Web site into your drawing. With Live Maps, you aren’t 

limited to the 200+ map templates that come with SmartDraw; instead, you 

can use any map you can find on Google Maps.

For example, Figure 15-5 shows a drawing that incorporates a map of down-

town Clovis, California, and shows the finish of the fourth stage of the 2009 

Amgen Tour of California bicycle race. This is a Google Maps map, with the 

route on top of the map (courtesy of SmartDraw’s standard drawing tools).

To create a map like this, fire up SmartDraw and follow these steps:

 1. Click the New button to bring up the Document Browser and then 

choose the Blank Interactive Map template from the New Document tab.

  A blank live map appears, as shown in Figure 15-6.

 2. On the SmartPanel, click Insert Map.

  Google Maps opens in a special window, as shown in Figure 15-7.
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Figure 15-5: 
A live map 

that uses 
a map 

imported 
from Google 

Maps.
 

 

Figure 15-6: 
A blank 

live map 
drawing.
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Figure 15-7: 
Retrieving 

a map from 
Google 
Maps.

 

 3. Enter the location of your map in the text box and click Go.

  You can enter either a place name (such as a city, state, national park, 

or other landmark), a street address, or a zip code. However you iden-

tify the location, Google Maps finds it and displays the map.

 4. Use the Zoom control to zoom in to the location you want to include in 

your map.

  You can also zoom by spinning the scroll wheel on your mouse.

  You can move (pan) the map by holding the mouse button anywhere on 

the map and dragging the mouse.

 5. When you have isolated the area you want to include in your map, 

click Import to SmartDraw.

  The map is copied into SmartDraw, as shown in Figure 15-8.

 6. Add symbols, legends, or other features you want to include in 

your map.

  You can use any of SmartDraw’s standard drawing tools.

Here are a few additional points to keep in mind when you work with maps 

imported from Google Maps:

 ✓ The imported map is itself a picture. Thus, you can manipulate the map 

via the Picture tab. For example, if you need to crop the map, you can 

use SmartDraw’s Pan & Zoom tool.

 ✓ You can change the map imported from Google Maps by selecting the 

map and clicking the Edit Map command in the SmartPanel.
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Figure 15-8: 
A map 

imported 
into 

SmartDraw.
 

 ✓ If you prefer, you can use a satellite view instead of a map view, or you 

can use a hybrid view which includes both the street map and the satel-

lite view. Figure 15-9 shows the bicycle route road map with satellite 

view instead of street map view. (To use satellite or hybrid view, choose 

Satellite or Satellite + Roads from the Map Type drop-down menu in the 

Google Maps window.)

 

Figure 15-9: 
A map in 

SmartDraw 
using 

satellite 
view.
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Adding Data Points to a Live Map
Live Maps has an interesting feature that lets you plot data geographically on 

the map before you import it into SmartDraw.

One use of this feature might be to show the relative sales figures for several 

cities in a state. For example, suppose you have an Excel spreadsheet file that 

contains the following data:

City Sales

Los Angeles  300

San Francisco  250

San Diego  120

Sacramento  110

Fresno  75

Bakersfield  50

You could use this spreadsheet to automatically create the map shown in 

Figure 15-10. Here, the sizes of the circles on the map indicate the relative 

amount of sales from each city.

What makes this feature so cool is that not only is the size of each circle 

determined by the sales amount, but the position of each circle on the map 

is determined by Google Maps based on the name of the city. The location 

information can be the name of a city, state, or other well-known location, a 

specific street address, or even a specific position given in terms of latitude 

and longitude.

 

Figure 15-10: 
A map with 
data points 

inserted 
by Google 

Maps.
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To create points like this on a map, follow these steps:

 1. Create an empty map page using the Blank Interactive Map template.

 2. Click the Insert Map button on the SmartPanel.

  The Google Maps interface appears. Refer to Figure 15-7.

 3. Navigate to the map you want to import.

  For example, you can type California in the text box and click Go.

 4. Click Add Data & Markers.

  The first page of the Import Data to Map Wizard opens, as shown in 

Figure 15-11.

  This first page gives you the option of uploading the data to be plotted 

on the map from a file or typing the data in yourself.

 

Figure 15-11: 
Importing 
data into 

a map.
 

 5. Click the I Want to Import Data from a File option and click Next.

  The next screen of the Import Data to Map Wizard appears, as shown in 

Figure 15-12.

 6. Click Browse.

  The Choose File dialog box opens, letting you scour your hard disk for 

the file you want to upload.

 7. Select your file and then click Open.

  You’re returned to the Import Data to Map Wizard.
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Figure 15-12: 
Selecting 
the file to 

import.
 

 8. Click Next.

  The Wizard asks which sheet in your spreadsheet file you want to use, 

as shown in Figure 15-13.

  (Note that this step may not appear if the spreadsheet file has only one 

sheet.)

 

Figure 15-13: 
Selecting 

the sheet to 
import.
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 9. Select the sheet you want to import and then click Next.

  The wizard step shown in Figure 15-14 now appears.

 

Figure 15-14: 
Telling the 

wizard how 
to plot the 

data.
 

 10. From the first drop-down menu, select the spreadsheet column that 

contains the data you want to plot.

  The drop-down menu shows all of the columns in the spreadsheet. 

Choose the one that contains the data you want to use to determine the 

size of your markers. (In this example, the column is named Sales.)

 11. If you want to include labels next to the markers, choose the columns 

that contain the label text from the second drop-down menu.

  For this example, the City column will do.

 12. Place a checkmark in the check box for the column that contains the 

location information.

  In this example, only one column contains data that appears to be 

location information, so this column is already selected.

 13. Click Next.

  The final Import Data to Map Wizard screen appears, as shown in 

Figure 15-15.

 14. Click Finish.

  The markers are added to the map, as shown in Figure 15-16.

 15. Click Import to SmartDraw.

  The map is imported into SmartDraw.
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Figure 15-15: 
Ready to 
add data.

 

 

Figure 15-16: 
The data 
has been 
added to 
the map!

 



Part IV
Using SmartDraw 

with Microsoft Office 
and the Web



In this part . . .

SmartDraw drawings don’t usually stand by them-

selves. Instead, you often create a SmartDraw draw-

ing so that you can incorporate it into larger documents, 

such as a Word document or a PowerPoint slide show. Or 

you might want to display your work on your Web page. 

The chapters in this part show you how to accomplish 

these feats.



Chapter 16

Exporting SmartDraw Graphics
In This Chapter
▶ Moving drawings into Office

▶ Manipulating your drawings after you put them into Word

▶ Creating a PDF from a drawing

▶ Other options for exporting SmartDraw drawings

SmartDraw has excellent integration with Microsoft Office applications, 

including built-in tools that make it a snap to transfer your finished cre-

ations into Word, Excel, or PowerPoint. In addition, SmartDraw has a power-

ful export capability that lets you save your drawings in a variety of different 

file formats so that you can use them in other programs.

This chapter covers the basics of using SmartDraw alongside Microsoft 

Word, Excel, and PowerPoint, converting drawings to PDFs, and saving draw-

ings in Mac-friendly formats, as well as exporting drawings to common graph-

ics formats. The next chapter covers some advanced tools that are useful 

when exporting SmartDraw graphics to PowerPoint.

Transferring a SmartDraw Drawing 
to Microsoft Office

The following sections present four basic ways that you can transfer a 

SmartDraw drawing into Microsoft Office. We illustrate all four of these 

techniques using Microsoft Word; however, the procedures are the same for 

Excel and PowerPoint.
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Copying and pasting
By far the easiest way to transfer a SmartDraw drawing into Microsoft Office 

is to simply copy and paste the drawing. Here are the steps for Microsoft 

Word; the procedure for Excel or PowerPoint is the same:

 1. Fire up SmartDraw and open the drawing you want to insert into 

Microsoft Office.

 2. Open Microsoft Word and then open the document you want to insert 

the drawing into.

 3. Switch back to SmartDraw.

 4. Press Ctrl+A to select the entire drawing.

 5. Press Ctrl+C to copy the drawing to the clipboard.

  If you prefer to use the main toolbar, go to the Home tab, find the 

Clipboard group, and click Copy.

 6. Switch back to Word.

 7. Place the insertion point at the exact location where you want to 

insert the SmartDraw graphic.

 8. Press Ctrl+V to paste the drawing into the document.

  Or if you prefer, click Paste on the Home tab.

  Your drawing is inserted into your Word document.

While your SmartDraw drawing is in your Word document, you’re likely 

unhappy with the results. So you’ll need to manipulate the inserted drawing 

using the techniques covered later in this chapter, in the section “Fixing Up 

Your SmartDraw Drawings in Word.”

Dragging and dropping
You can also use the mouse to drag and drop a SmartDraw graphic into an 

Office program. Here are the steps for Microsoft Word; the procedure for 

Excel and PowerPoint is the same:

 1. Start SmartDraw and open the drawing you want to insert into 

Microsoft Office.

 2. Start Microsoft Word and open the document you want to insert the 

drawing into.

 3. Arrange the programs on the screen so that both are visible at the 

same time.
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 4. Switch to SmartDraw and press Ctrl+A to select the entire drawing.

  If you want to copy just part of the drawing, you can select just the parts 

you want to copy.

 5. Press and hold the Ctrl key, point to any part of the drawing that 

you’ve selected, press and hold the mouse, and drag the drawing to 

Microsoft Word.

  When you release the mouse button, the drawing is copied into the 

Word document.

You’ll probably need to fix up the drawing a bit in Word after you’ve pasted 

it in. For more information, see the section “Fixing Up Your SmartDraw 

Drawings in Word” later in this chapter.

Using the Insert menu
Word, Excel, and PowerPoint let you insert a SmartDraw file into your docu-

ments without the need to first open the drawing in SmartDraw.

Here are the steps for Word; again, the procedure for Excel and PowerPoint 

is the same:

 1. Start Microsoft Word and open the document you want to insert the 

drawing into.

 2. Move the insertion point to the location where you want to insert the 

drawing.

 3. Click the Insert tab on the main toolbar, find the Text group, and click 

the Object button.

  The Object dialog box appears. This dialog box has two tabs: Create 

New and Create from File. The Create New tab lets you create a new 

object from scratch; the Object Type box lists all of the different types 

of objects you can create. If you scroll down the list, you find SmartDraw 

listed among the choices.

  Although it’s technically possible, we don’t recommend that you create 

new SmartDraw drawings from within Word. Instead, create all of your 

SmartDraw graphics directly in SmartDraw.

 4. Click the Create from File tab.

  The Create from File tab of the Object dialog box appears, as shown in 

Figure 16-1. This tab of the Object dialog box lets you select an existing 

file to insert into your Word or other Office document.
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Figure 16-1: 
The Create 

from File 
tab of the 

Object 
dialog box.

 

 5. Click the Browse button.

  A standard Windows file browser appears.

 6. Locate and select the SmartDraw drawing you want to insert and then 

click Insert.

  You return to the Object dialog box.

 7. (Optional) Select the Link to File check box.

  We recommend that you leave this check box deselected. If you select 

it, any changes you later make to the SmartDraw drawing are automati-

cally incorporated into the copy of the drawing contained in your Word 

document.

  This linking might sound like a good idea at first, but in most cases, it 

isn’t. For starters, linking to the file slows down Word’s performance 

whenever you edit the document. And perhaps more importantly, you 

may return to the drawing months or even years from now and make 

changes to it, completely forgetting that you linked to it in a Word docu-

ment. Thus, when you change the SmartDraw drawing, you inadvertently 

change the Word drawing, too.

  Use the Link to File feature only in situations where you anticipate that 

you’ll edit the SmartDraw drawing and you’re certain that you want 

those edits automatically incorporated into the Word document.

 8. Click OK.

  Your computer whirs and grinds for a moment while it digs up the file 

and inserts it into your document.

  Don’t despair; it may take a few moments for the drawing to appear in 

your Word document, but it will eventually show up.
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 9. Rejoice when the drawing appears in your document.

  Marvel at the sophistication that’s going on under the covers, which 

enables a drawing created by a program written by a small company in 

San Diego to be inserted directly into a program written by the 100,000 

or so programmers who work for Microsoft up in Seattle.

  (Actually, you should marvel any time anything works in Microsoft 

Word. But that’s a story for another book.)

You probably won’t be happy with the appearance of your SmartDraw 

drawing. So you’ll need to brush it up a bit; see the section “Fixing Up Your 

SmartDraw Drawings in Word” later in the chapter.

Exporting to Office
SmartDraw includes three handy buttons, right at the top of the program on 

the Single-Click toolbar, that let you export a drawing directly to Word, Excel, 

and PowerPoint:

Button What It Does

 Exports the current drawing directly to Word.

 Exports the current drawing directly to Excel.

  Exports the current drawing directly to PowerPoint.

When you click one of these buttons, SmartDraw automatically exports the 

drawing to the appropriate Office program. If the program (Word, Excel, or 

PowerPoint) is already running, SmartDraw inserts the drawing at your most 

recent position within the open document. Otherwise, SmartDraw starts 

Word, Excel, or PowerPoint, creates a new document, and then inserts the 

drawing into the new document.

As an example, here are the steps to insert a SmartDraw drawing into an 

existing Word document:

 1. Fire up SmartDraw and open the drawing you want to insert into 

Microsoft Office.

 2. Open Microsoft Word, open the document you want to insert the 

drawing into, and place the insertion point at the exact location where 

you want to insert the SmartDraw graphic.
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 3. Switch back to SmartDraw.

 4. Click the Export to Word button.

  The drawing is inserted into the document at the location of the inser-

tion point.

You most likely need to polish up the drawing a bit in Word. Follow the steps 

outlined in the section “Fixing Up Your SmartDraw Drawings in Word,” which 

comes next.

Fixing Up Your SmartDraw 
Drawings in Word

Getting a SmartDraw graphic into Word is easy, but that’s only half the battle. 

After you get the drawing into Word, you’ll probably want to work with it 

a bit to incorporate it into your document exactly the way you want it. For 

example, you might want to move it, change its size, or allow your docu-

ment’s text to flow around it. For example, Figure 16-2 shows a SmartDraw 

graphic that has been resized and repositioned with text wrapped around it.

 

Figure 16-2:
A 

SmartDraw 
graphic in 

a Word 
document.

 



239 Chapter 16: Exporting SmartDraw Graphics

The following sections show you how to perform these tricks.

 If your SmartDraw graphic appears completely cut off at the bottom so 

that you see only the bottom half-inch or so of the drawing — as shown in 

Figure 16-3 — you probably have your paragraph spacing set to an exact 

value rather than single line spacing. You can quickly fix this problem by 

opening the Paragraph dialog box. (On the Home tab on The Ribbon, find 

the Paragraph group and click the dialog box launcher at the bottom-right 

corner.) Then change the line spacing to Single.

Wrapping text around your drawing
When you first insert a drawing, Word places it in line with the text. Any text 

that appears before or after the drawing is lined up with the bottom of the 

drawing; no text appears alongside the drawing.

In many cases, you want the text to wrap around the drawing. The text shown 

in Figure 16-3 is wrapped around a SmartDraw drawing.

 

Figure 16-3: 
Something 

seems to be 
wrong here.
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To apply a text wrapping around your drawing, right-click the drawing and 

choose Format Object. Then, click the Layout tab to bring up the layout 

options, shown in Figure 16-4. The only options you need to concern yourself 

with for now are the Wrapping Style options.

 

Figure 16-4: 
Text 

wrapping 
options.

 

Choose one of the following layout options:

 ✓ In Line with Text: This is the default wrapping option, and it’s the one 

you’re least likely to use. It places the drawing in line with your text. The 

height of the line on which the drawing appears is adjusted to match the 

height of the drawing. In most cases, this wrapping doesn’t look right.

 ✓ Square: Wraps the text squarely around the drawing. This is the option 

used in Figure 16-2.

 ✓ Tight: Word figures out where the actual edges of the drawing are and 

snuggles the text up as closely as possible.

 ✓ Behind Text: This option lets the text spill right over the top of the 

drawing, as if the drawing weren’t even there. The drawing appears 

behind the text.

 ✓ In Front of Text: This option places the drawing on top of the text. The 

drawing might obscure some of the text, so use this option only if that’s 

what you want.

 When you choose Tight wrapping (or any other type of wrapping besides In 

Line with Text), the drawing becomes a free-floating object and is no longer 

tied to a specific position within the text. You can drag the drawing to any 

location you want. You can even put it right in the middle of a paragraph, and 

Word wraps the text around both sides.
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Sizing and stretching a drawing
In most cases, you need to resize your drawing after you insert it. To do so, 

click the drawing to select it. Notice the eight handles that appear around 

the drawing. You can drag any or all of these handles to resize the drawing. 

When you click one of the corner handles, the proportion of the drawing 

stays the same as you change its size. When you drag one of the edge han-

dles (top, bottom, left, or right) to change the size of the drawing in just one 

dimension, you distort the drawing’s shape as you go.

Stretching a drawing by dragging one of the edge handles can dramatically 

change the drawing’s appearance. For example, you can stretch an object 

vertically to make it look tall and thin or horizontally to make it look short 

and fat. (If the drawing includes a picture of yourself, we recommend stretch-

ing it vertically.)

Cropping a drawing
Sometimes, you want to cut off the edges of a drawing so that you can 

include just part of the drawing in your document. When you insert a drawing 

object in Word, you can crop the drawing by right-clicking the drawing and 

choosing Format Object. Click the Picture tab in the Format Object dialog box 

to show the various picture options, as shown in Figure 16-5.

 

Figure 16-5: 
Picture 

options.
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To crop the drawing, you must manually set the amount of the drawing you 

want to remove from the left, right, top, and bottom. You’ll undoubtedly 

have to experiment a bit before you get the drawing cropped correctly, but it 

shouldn’t take you more than a few attempts to get it right.

Note that this dialog box also lets you change the image brightness and 

contrast.

 If you decide later that you don’t like the cropping, click the Reset button in 

the Format Object dialog box.

Applying a drawing border
You can apply a border to a drawing by right-clicking the drawing and choos-

ing Format Object. Click the Colors and Lines tab in the Format Object dialog 

box, as shown in Figure 16-6. You can then create a border by choosing the 

line color, style, and weight.

 

Figure 16-6: 
Creating a 

border.
 

Adding a caption
A caption is a bit of text that identifies a figure, table, chart, or other visual 

element you include in a document. Captions usually include a reference 

number (for example, Figure 58 or Table 293). Figure 16-7 shows a document 

with a captioned drawing imported from SmartDraw.
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Figure 16-7: 
A drawing 

with a 
caption.

 

To add a caption to a SmartDraw drawing (or any other picture, table, chart, 

or graphic goodie), follow these steps:

 1. If you haven’t done so already, insert the drawing you want to apply 

the caption to.

 2. Select the drawing that you want the caption attached to.

 3. Click the References tab on The Ribbon, find the Captions group, and 

then click the Insert Caption button.

  The Caption dialog box opens, as shown in Figure 16-8.

 

Figure 16-8: 
The Caption 

dialog box.
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 4. Type the caption.

  Word starts the caption for you by providing the reference number. 

Type the text you want to use to describe the figure, table, chart, or 

whatever.

 5. Change the Label field if it’s incorrect.

  Word keeps track of caption numbers for figures, tables, and equations 

separately. When you insert a caption, make sure the Label field is set to 

the type of caption you want to create.

 6. Change the Position field if you want to change the positioning.

  The two options are Above or Below the selected item.

 7. Click OK.

  Word inserts the caption.

Here are a few rapid-fire thoughts designed to inspire your use of captions:

 ✓ If you want to create captions for something other than figures, tables, 

and equations, click the New Label button in the Caption dialog box and 

type a label for whatever you want to create captions for; say, for exam-

ple, a limerick. Click OK, and from then on, Limerick appears as one of 

the Label types.

 ✓ When you create a caption, Word automatically applies the Caption 

style to the caption paragraph. You can control the format of all cap-

tions in a document by modifying the Caption style. If you aren’t sure 

how to modify a style in Word, now would be a perfect time to pick 

up a copy of Doug’s book, Microsoft Office Word 2007 All-in-One Desk 
Reference For Dummies (Wiley Publishing).

 ✓ You can create a table of figures, tables, equations, or limericks by 

clicking the Insert Table of Figures button on the References tab on The 

Ribbon. For more detailed information about this feature, pick up a copy 

of Doug’s book, Microsoft Office Word 2007 All-in-One Desk Reference For 
Dummies (Wiley Publishing). (Wow! Two plugs in a row!)

 ✓ At various and sundry times, caption numbers wander out of sequence. 

Fear not! Word can put the caption numbers back into sequence when 

you print the document. If you’re tired of looking at out-of-sequence 

numbers, press Ctrl+A to select the entire document and then press F9 

to recompute the caption numbers.

 ✓ If you want Word to always create a caption whenever you insert a 

particular type of object into your document, click the AutoCaption 

button in the Caption dialog box. The AutoCaption dialog box lists all 

the various types of objects you can insert into a Word document. Scroll 

down this list a bit and you’ll find SmartDraw lurking among the options. 

Select SmartDraw and any other object types you want to automatically 

create captions for and then click OK.
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Exporting to a PDF
SmartDraw includes the built-in ability to convert a drawing to one of the 

most popular document formats of all: Adobe PDF (Portable Document 

Format). Converting to a PDF is a simple procedure. Just follow these steps:

 1. Start SmartDraw and open the drawing that you want to convert to 

a PDF.

  2. Click the Export to PDF button (shown in the margin).

  The Export dialog box appears, as shown in Figure 16-9.

 

Figure 16-9: 
Exporting a 

drawing to a 
PDF file.

 

 3. Navigate to the folder you want to save the file in.

 4. Type a new filename if you don’t like the one SmartDraw suggests.

  Normally, you’ll leave the filename unchanged: SmartDraw by default 

uses the name of the original SmartDraw drawing file, changing the 

extension to .pdf.

 5. Click Save.

  The drawing is converted to PDF format.

After you convert a drawing to PDF, you should verify the results by opening 

a Windows Explorer window (press Windows+E on your keyboard), navigat-

ing to the folder where you saved the converted drawing, and double-clicking 

the PDF file. The file opens in Adobe Reader, as shown in Figure 16-10. (Note 
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that if you don’t have Adobe Reader installed on your computer, you can 

obtain it free from Adobe’s Web site at http://get.adobe.com/reader. 

Adobe Reader is also on the CD that accompanies this book.)

 

Figure 16-10: 
Viewing a 
converted 

PDF file 
in Adobe 
Reader.

 

Saving a Drawing in Other Formats
Besides PDF, SmartDraw has the ability to export your drawings to a variety 

of other graphics formats. SmartDraw can export to the formats listed in 

Table 16-1.

Table 16-1 SmartDraw’s Export Formats
Format What It Is

EMF An Enhanced Windows Metafile picture

WMF Windows Metafile, a format that many programs 
recognize

BMP Garden variety Windows bitmap file, used by 
Windows Paint and many other programs
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Format What It Is

PCX A variant type of bitmap file, also used by Windows 
Paint

TIFF Tagged Image File Format, another bitmap program 
most often used for high-quality photographs

GIF Graphics Interchange Format, a format commonly 
used for small Internet pictures

PNG Portable Network Graphics file, an image format 
designed for Internet graphics

JPG JPEG, a common format for photographs that 
includes built-in compression

HTM HTML format. For more information, please see 
Chapter 18.

EPS Encapsulated Postscript, a format used by some 
high-end drawing programs

CGM Computer Graphics Metafile

DXF A drawing interchange format used by AutoCAD

DRW Micrografx Designer or Micrografx Draw, two 
popular ooh-aah drawing programs

HGL The format used by Hewlett-Packard plotters

AI Adobe Illustrator, one of the most popular vector 
drawing programs

PDF Portable Document Format, used by Adobe Acrobat

There are two ways to export a drawing to a different format:

 ✓ Use the Save As command, located on the SmartDraw menu. Then use 

the Save As Type drop-down list to choose the file type.

 ✓ Use the Export command, also located on the SmartDraw menu. This 

command leads to a menu of export choices, as shown in Figure 16-11. 

Most, but not all, of the export formats available via the Save As dialog 

box are also available via the Export menu.
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Figure 16-11: 
Using the 

Export 
command.

 

Saving for AutoCAD
One of the great benefits of SmartDraw when 
compared with more technical computer-aided 
design (CAD) tools such as AutoCAD is that 
SmartDraw is so much easier to use. This isn’t 
to discount AutoCAD’s role in an engineering 
or drafting environment: AutoCAD or a tool like 
it is essential for creating advanced graph-
ics that require three-dimensionality and very 
stringent specifications. Yet AutoCAD is a very 
difficult program to learn — it can take a skilled 
computer user weeks to learn the basics of 
AutoCAD and years to master it.

Therefore, it makes sense that SmartDraw 
coexists in many organizations alongside 
AutoCAD or other drawing programs. This natu-
rally raises the question: Can SmartDraw share 
drawings with AutoCAD?

The answer is Yes, but with some limitations:

 ✓ SmartDraw currently supports the Drawing 
Interchange/Exchange Format (.dxf) in 

AutoCAD 14 or earlier; AutoCAD 2000 and 
later aren’t supported.

 ✓ SmartDraw currently supports the Drawing 
(.dwg) format in AutoCAD 13 or ear-
lier; AutoCAD Release 14 and later aren’t 
supported.

What happens if you have a CAD drawing that 
SmartDraw doesn’t support directly? You have 
two options. First, you can simply try to import 
the drawing into SmartDraw and see what hap-
pens. Depending on the complexity of the draw-
ing, it may open fine, or certain elements of the 
drawing may appear distorted or be missing 
altogether. A second option is to use AutoCAD 
to save the drawing in the version 13 format. 
Certain elements of the drawing may be lost, 
but you should then be able to open the draw-
ing in SmartDraw.
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Saving for the Mac
How do you share graphics from SmartDraw with a Mac? Simply export to a 

common file format that’s acceptable to a Mac. Any raster- or vector-based 

image should suffice. To bring your SmartDraw images into a Mac, export 

your image to any of the following: BMP, GIF, TIFF, PNG, PDF, or JPEG. You 

can select any of these options using the Export command on the SmartDraw 

button.

Here’s another little tip: You can save your file as an Encapsulated Postscript 

(EPS) or Adobe Illustrator (AI) file by using the Save As command, also found 

on the SmartDraw button. Both of these formats are widely supported by 

Mac software. Select Save As, then select the Save as Type drop-down menu, 

and choose either the EPS or AI format.
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Chapter 17

Animating Business Graphics 
in PowerPoint 2007

In This Chapter
▶ Understanding SmartDraw animation

▶ Animating your drawings for PowerPoint

▶ Exporting an animated drawing

▶ Enhancing animation options in PowerPoint

▶ Using a storyboard to create a PowerPoint presentation

As you find out in Chapter 16, SmartDraw is adept at integrating its 

drawings with Microsoft Office programs, including Word, Excel, and 

PowerPoint. However, SmartDraw really goes the extra mile when it comes to 

PowerPoint. In this chapter, you find out about two additional features that 

SmartDraw offers for working alongside PowerPoint. The first is its ability to 

animate a PowerPoint slide that contains an exported SmartDraw graphic by 

controlling the sequence in which various elements of the drawing appear 

during the presentation. And the second is the ability to create an entire 

presentation — not just one slide, but the entire show — from SmartDraw.

Introducing Animated 
SmartDraw Graphics

SmartDraw can automatically animate any and all of the elements in a draw-

ing when you export it to PowerPoint. Then, when you display the slide that 

contains the SmartDraw graphic in PowerPoint, the elements that you speci-

fied animation for appear one at a time, allowing you to discuss each of the 

animated elements as they appear on the screen without revealing to your 

audience what comes next.
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For example, suppose you’re asked to give a presentation at the local meet-

ing of the Halloween Haunters Guild. Your presentation is on using electronic 

components from your favorite microcontroller company (Doug’s is EFX-TEK 

at www.efx-tek.com) to create a computer-controlled Halloween prop: a 

creature that pops up by use of compressed air. The prop also plays sounds 

and flashes lights at the right time to create a scary effect.

Figure 17-1 shows a SmartDraw drawing created to show the electronics used 

to control the prop. The electronics include several distinct components, 

including these:

 ✓ A Prop-1 microcontroller, which is the computer that controls the entire 

show

 ✓ A relay board (called an RC-4), which turns the lights on and off and trig-

gers the solenoid to activate the pop-up mechanism

 ✓ A sound board (called an AP-8), which plays the sounds

 ✓ An infrared sensor (called a PIR) that triggers the prop when someone 

walks by

 

Figure 17-1: 
A 

Halloween-
prop plan.

 

To facilitate your discussion of these elements, you want them to appear on 

the screen one at a time, in four stages, as shown in Figure 17-2. Thus, you 

can talk a bit about just the Prop-1 microcontroller before any of the other 

components appear. Then, when you click the mouse, the relay board, lights, 

and pop-up mechanism appear, and you can talk about them. Another mouse 

click brings up the sound board, and a fourth mouse click completes the dia-

gram by introducing the PIR sensor.
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Figure 17-2: 
A 

SmartDraw 
drawing 

animated in 
four phases.

 

 Some SmartDraw templates — most notably the various chart templates such 

as bar charts and pie charts — have predefined animations that automatically 

animate the chart when you export to PowerPoint.

Animating a Drawing and Exporting 
It to PowerPoint

You could create an animation like the one shown in Figure 17-2 entirely from 

scratch using PowerPoint’s animation tools, but SmartDraw can handle the 

animation for you automatically. Then, SmartDraw can export the drawing 

along with your animations directly to PowerPoint. Here are the steps:

 1. Create a SmartDraw graphic that has elements you want to animate.

 2. Decide the sequence in which you want the elements animated.

  You can change the sequence later if you want, but it’s best to give it a 

few moments’ thought before you set up the animation.

  SmartDraw divides its animations into steps, and each step can include 

as many separate objects as you want. For example, the second step of 

the animation actually consists of 11 distinct objects: the rounded rect-

angle that represents the relay board, the symbols that represent the 

lights and the solenoid, four line segments, and three text labels.

 3. Click the PowerPoint tab.
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  The commands for creating PowerPoint animations appear, as shown in 

Figure 17-3.

 4. Select the objects you want to include in the first step of the animation.

  To select more than one object, hold down the Ctrl or Shift key while 

you click the objects you want to select.

 5. On the PowerPoint tab, find the Animation group and select 1 from 

the Step drop-down menu.

  The selected items are assigned to the first animation step.

  Note: The items in the first step are immediately visible when the slide is 

displayed.

 6. Select the objects that you want to include in the second step.

 7. Select 2 from the Step drop-down menu.

 8. Repeat Steps 6 and 7 for each additional step of your animation.

  Of course, choose the appropriate value from the Step drop-down menu 

for each animation step.

  9. To preview your animation, click the Preview button (shown in the 

margin) in the Animation group on the PowerPoint tab.

  All objects except the ones you selected for the first animation step are 

hidden.

 

Figure 17-3: 
Using the 

PowerPoint 
tab to 

animate a 
drawing.
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 10. Click the mouse button anywhere in the drawing to reveal the objects 

for the next animation step.

  For example, click once to reveal the objects for the second step, click 

again to see the objects for the third step, and so on until the animation 

is complete.

  You can also click the Next and Previous buttons in the Animation group 

on the main toolbar to move the animation forward or backward one 

step at a time. Or can press the left and right arrow keys if you prefer to 

control the animation via the keyboard.

 11. If the animation isn’t right, fix it by selecting the errant objects and 

assigning them to the proper steps.

  For example, if you discover an object that you should’ve included in the 

third step, select the object and then choose 3 from the Step drop-down 

menu.

  12. When you’re satisfied with the animation, make sure that the Include 

Animation check box is selected; then click the Send to PowerPoint 

button (shown in the margin).

  The drawing is exported to PowerPoint, as shown in Figure 17-4.

 

Figure 17-4: 
A 

SmartDraw 
drawing that 

has been 
exported to 

PowerPoint.
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Playing with Animated Drawings 
in PowerPoint

After you’ve exported the drawing into PowerPoint, you can use PowerPoint’s 

animation features to beef up the animation. For example, you might want 

to change the animation style so that instead of simply appearing out of thin 

air, the animated elements of your drawing fly in from the top, fade out of the 

background, or appear using any of PowerPoint’s myriad animation styles.

Before you start messing with the animation in PowerPoint, you need to real-

ize how SmartDraw exports the animation to PowerPoint. Each step in your 

SmartDraw animation is exported to PowerPoint as a separate picture that 

includes all of the objects included in the step. Thus, if you have four anima-

tion steps, the PowerPoint slide includes four separate pictures.

The first of these pictures isn’t animated in PowerPoint: It simply appears 

when the slide is displayed. Each subsequent step is then given a custom 

animation in PowerPoint. As a result, if you have four animation steps in 

SmartDraw, the resulting PowerPoint slide has just three steps. Step 1 in 

the PowerPoint slide corresponds to Step 2 in the SmartDrawing, Step 2 in 

PowerPoint corresponds to Step 3 in SmartDraw, and so on.

Now that you understand how the animation is exported to PowerPoint, here 

are the steps for changing the animation style used by a SmartDraw animation:

 1. In PowerPoint, navigate to the slide that contains the exported drawing.

 2. On The Ribbon, click the Animations tab, find the Animations group, 

and then click the Custom Animation button.

  The Custom Animation task pane appears at the right of the PowerPoint 

screen, as shown in Figure 17-5.

 3. In the Custom Animation task pane, click the animation step you want 

to change.

  For example, to change the step that reveals the PIR sensor, click the 

third step in Figure 17-5.

 4. Click the Change button to reveal a list of animation effects, click 

Entrance, then choose the effect you want to apply.

  The following seven animation effects are listed when you click 

Entrance:

 • Blinds

 • Box
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Figure 17-5: 
Adjusting 

the custom 
animation in 
PowerPoint.

 

 • Checkerboard

 • Diamond

 • Fade

 • Fly-In

 • Wedge

 5. If you don’t like any of the effects listed under the Entrance menu, 

choose More Effects, select an effect, and then click OK.

  Figure 17-6 shows the Change Entrance Effect dialog box, which lists all 

of the possible entrance effects you can use. In all, there are about 50 

effects to choose from.

 6. Repeat Steps 3 through 5 for each animation picture whose effect you 

want to change.

To preview the animation in PowerPoint, press F5 to start the slide show. 

Then navigate to the slide, and click the mouse or press the spacebar or 

Enter key to trigger the animations.
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Figure 17-6: 
Choosing 

an entrance 
effect.

 

Creating an Entire Presentation 
in SmartDraw

SmartDraw 2009 includes a new feature that effectively lets you create an 

entire PowerPoint presentation in SmartDraw. At first glance, you might 

wonder why you would want to do that. After all, SmartDraw is a graphics 

drawing program; PowerPoint is a presentation program. Doesn’t it make 

sense to use a presentation program to create presentations?

To a point, yes. But the problem with PowerPoint is that it gets you focused 

on the textual, linear thinking of bullet points followed by bullet points. 

SmartDraw’s alternative lets you create your presentation graphically, by first 

crafting a storyboard, which visually outlines your presentation. Figure 17-7 

shows an example of such a storyboard. It resembles a flowchart in which 

the boxes in the top row represent individual slides, and the smaller boxes 

beneath each slide represent the bullet points that appear on each slide. 

The storyboard approach encourages you to work on the big concepts — 

the slides themselves — before you start hammering out the details of what 

appears on each slide.

Notice that the fifth slide in the storyboard includes a graphic. It’s hard to 

tell from this small image, but the graphic is actually the SmartDraw graphic 

that was shown in Figure 17-1. SmartDraw’s storyboarding features make it 

easy to insert any SmartDraw drawing into the storyboard. When you do so, 

the animation that you’ve applied to the drawing is incorporated into the 

PowerPoint presentation.
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Figure 17-7: 
A story-

board.
 

To create a storyboard, follow these steps:

 1. Click the New button on the Single-Click toolbar.

 2. In the Category List panel, open the Storyboard template group and 

click the Blank Storyboard template.

  For more info on working with templates, refer to Chapter 2.

  A blank storyboard is created, as shown in Figure 17-8. The blank story-

board starts with one slide, which has one bullet point item beneath it.

  In most cases, you’ll want to start by deleting this bullet point (so you 

can create your own bullet points later). To do so, just click the bullet 

point and press Delete.

 

Figure 17-8: 
A blank 

storyboard.
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 3. Add slides to your storyboard.

   To add a slide, simply click the Add Slide button found in the Build sec-

tion on the SmartPanel. Each time you click this button, a new slide is 

added. Figure 17-9 shows how a storyboard appears after you’ve created 

several slides.

 4. To add text to a slide, just click the slide and start typing.

  The text you type appears as the title for the slide when you export the 

presentation to PowerPoint.

 

Figure 17-9: 
A story-

board with 
several 
slides.

 

  5. To add a bullet point, click the slide you want to add the point to and 

then click the Add Element button on the SmartPanel.

  The element is added beneath the slide. You can then immediately start 

typing to enter the text you want to appear for that bullet point.

 6. To continue adding bullet points to a slide, press the Enter key when 

you finish the first bullet point.

  Pressing the Enter key when entering text for a bullet point automatically 

inserts a new element for the current slide. Figure 17-10 shows a story-

board after several bullet points have been created for the first slide.
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Figure 17-10: 
A story-

board with 
several 

slides 
and bullet 

points.
 

  As you begin to flesh out your presentation, you can easily rearrange 

slides or individual bullet points simply by dragging them to a new loca-

tion. If you drag a slide, all its bullets move with the slide. Note that you 

can also drag a bullet point from one slide to another.

  7. To insert a finished SmartDraw drawing into a storyboard, first select 

the slide you want to add the graphic to. Then click the Add Graphic 

button in the Format section on the SmartPanel.

  A dialog box opens that lets you choose the drawing you want to add. 

Select the drawing and then click Open to insert the drawing into the 

slide.

  To remove a drawing, you must select the slide that contains it and then 

click Remove Graphic on the SmartPanel. If you try to remove a drawing 

by selecting it and pressing the Delete key, the entire slide is deleted.

 8. (Optional) Apply a PowerPoint theme to your storyboard before you 

export it to PowerPoint.

  To do so, click the Theme button in the PowerPoint section on the 

SmartPanel and then locate and select the PowerPoint theme you want 

to use.
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 9. To export the storyboard to PowerPoint, click the Build button in the 

PowerPoint section on the SmartPanel.

  The SmartPanel automatically starts PowerPoint and creates a new 

presentation with slides generated from your storyboard. Figure 17-11 

shows the result for the storyboard that’s shown in Figure 17-7.

  With your drawing imported into PowerPoint, you can use all of 

PowerPoint’s powerful editing features to further enhance the 

presentation.

 

Figure 17-11: 
A 

PowerPoint 
presentation 

created 
from a 

SmartDraw 
storyboard.

 

 If your storyboard includes any embedded SmartDraw drawings, be patient: 

PowerPoint may appear to have taken a nap for a few moments while the 

drawings are inserted.
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Taking Your Graphics to the Web
In This Chapter
▶ Exporting to HTML for the Web

▶ Adding hyperlinks to your drawings

The ultimate destination of many business graphics created with 

SmartDraw is none other than the Internet’s World Wide Web. If you’ve 

created a drawing that will live on the Web, this chapter’s for you. You find 

out how to export a drawing directly to HTML format. And, you discover how 

to add hyperlinks to your SmartDraw drawings so that users who view your 

SmartDraw drawings on the Web can click on various parts of the drawing to 

go to other Web pages.

Have fun!

Exporting to HTML
As you probably know, HTML (Hypertext Markup Language) is the lingua-

franca of the Internet. It’s the language used to create the billions of pages 

that appear on the Web.

To include a SmartDraw drawing on a Web page, you must first save the 

drawing to one of the many graphics formats that Web browsers can natively 

display. Fortunately, SmartDraw can export to just about all of these for-

mats. GIF, JPG, and PNG are the three most likely candidates; we suggest you 

use them. For information about how to export to one of these formats, see 

Chapter 16.
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However, to incorporate an exported drawing into an HTML document, you 

must also craft the HTML code necessary to display the exported drawing. 

The good news is that SmartDraw can save you that hassle, by creating said 

HTML for you automatically. Here are the steps:

 1. Start SmartDraw and open the file you want to export to the Web.

 2. Click the SmartDraw button and then choose Export➪HTML.

  The Export to HTML Files dialog box opens, as shown in Figure 18-1.

 

Figure 18-1: 
The Export 

to HTML 
Files 

dialog box.
 

 3. Review the Settings section of the dialog box.

  This section lists the settings that will be used to export the file — spe-

cifically, the target page size and the image format.

 4. If you want to change the settings, click Change. Change the settings 

however you wish and then click OK.

  Clicking Change brings up the Export HTML dialog box, as shown in 

Figure 18-2. This dialog box lets you control several settings related to 

the size of the intended Web page and the format of the graphic file to 

be created for the drawing.

 5. Review the location where the files will be stored. If you want to 

change the location, click Browse and select a new location.

 6.  Enter the name of the folder you want to create.

  The Export to HTML function always creates a new folder where it puts 

the HTML and graphic files.

 7. Click Export.
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Figure 18-2: 
Setting 

the HTML 
options.

 

  The files are exported. A dialog box similar to the one shown in Figure 

18-3 is displayed to confirm that the files were exported successfully and 

to let you know where the files were placed.

 

Figure 18-3: 
The files 

have been 
exported.

 

You’re done!

If you want to see how the graphic will appear in a Web browser, open 

Windows Explorer (press Windows+E on your keyboard) and navigate to the 

folder where the files are stored. Then, double-click the .htm file. The file is 

displayed in a browser window, as shown in Figure 18-4.

 The exported HTML and graphic files still reside on your computer. If you want 

to incorporate them into a Web site, you have to upload the files to your Web 

site host. Check with your host provider for information on how to do that.
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Figure 18-4: 
A 

SmartDraw 
graphic 

displayed 
in a Web 
browser.

 

Inserting Hyperlinks
In SmartDraw, a hyperlink is simply a bit of text or an entire object that you 

can click when viewing a drawing to summon another drawing, some other 

type of document, such as a Word document or an Excel spreadsheet, or a 

page on the World Wide Web.

For example, suppose that you have a drawing that shows the organization 

chart for your company. You can place hyperlinks on the boxes for each 

department manager that link to the Web pages for each department. Then, a 

user viewing the drawing can easily call up the departmental Web pages.

Or suppose that you’ve created a complicated flowchart that actually con-

sists of several separate drawings linked to each other with off-page connec-

tors. You can turn each off-page connector into a hyperlink that opens the 

drawing linked to it by the connector. For example, Figure 18-5 shows a por-

tion of a flowchart that includes a hyperlink to a second page that continues 

the flowchart. The number 2 in the off-page connector is underlined in typical 

hypertext style.
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Figure 18-5: 
A flowchart 

with a 
hyperlink.

 

Here are a few additional thoughts to ponder concerning hyperlinks:

 ✓ Hyperlinks aren’t limited to SmartDraw drawings. In SmartDraw, you 

can create a hyperlink that leads to other types of files, such as PDF files 

or Word or Excel documents. When the person viewing the drawing 

clicks one of these hyperlinks, SmartDraw automatically runs the appro-

priate program to display the linked file.

 ✓ A hyperlink can also lead to a page on the World Wide Web. When the 

user clicks the hyperlink, SmartDraw runs Internet Explorer to connect 

to the Internet and displays the Web page.

 ✓ A hyperlink can run a program. However, if you plan on publishing 

the drawing to the Web, this feature probably won’t work. For security 

reasons, most Web browsers are configured to prevent Web pages from 

running programs on users’ computers.

Adding a hyperlink to a drawing is easy. Just follow these steps:

 1. Select the text or object that you want to make into a hyperlink.

  The most common type of hyperlink is based on a word or two of text 

contained within an object.

  Note: If you select a shape rather than text, the hyperlink appears as 

a small blue box containing a + sign at the bottom right of the shape. 

When the user clicks that + sign, the hyperlink is activated.

 2. On the main toolbar, click the Insert tab and click Hyperlink.

  The Create a Hyperlink dialog box opens, as shown in Figure 18-6.
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Figure 18-6: 
The Create 
a Hyperlink 
dialog box.

 

 3. Select the type of hyperlink you want to create.

  You have four options:

 • SmartDraw Drawing: Lets you link one SmartDraw drawing to 

another.

 • Web Page: Links to an Internet Web page. You need to know the 

address of the page you want to link to.

 • Document: Links to any other type of document, such as a PDF file 

or a Word or Excel document.

 • Program: Lets you run a program when the user clicks the link. 

Note that if you intend to publish the drawing on your Web site, 

this option probably won’t work, as most Web browsers are con-

figured to prohibit Web page links from running programs on the 

user’s computer.

 4. Indicate the location of the document you want to link to.

  If you chose Web Page in Step 3, enter the address of the Web page in the 

text box. Otherwise, click Browse and select the file you want to link to.

 5. Click OK.

  The link is created.



Part V
The Part of Tens



In this part . . .

Article VI, Section 23, Paragraph 206.4 of the For 
Dummies Code states that all For Dummies books 

shall end with a chapter containing “various and sundry 

collections of tips, guidelines, applications, procedures, 

anecdotes, and otherwise useful tidbits of knowledge.”

Although many of For Dummies authors have interpreted 

the code to be more like guidelines than actual rules, we 

believe in maintaining the Tradition of the Tens. 

Therefore, this part presents several chapters that each 

cover ten things worth knowing about SmartDraw. 



Chapter 19

Ten SmartDraw Commandments

And the sorrowful computer user lamented, “Who am I to create yonder 
business graphic? For I am a user of small talent, and my sketches are like 
the doodlings of a child.” And immediately the heavens opened, and a voice 
said, “Fear not, for unto you this day is given a program, which you shall call 
SmartDraw, and it shall be unto you the creator of all business graphics.” 
And from that day forward the user created the most stunning business 
graphics in all the land. And the people were amazed at his drawings, 
saying “He charts with clarity and meaning, not as the Excel users do.”

— Graphications 1:1

And so it came to pass that these ten SmartDraw commandments were 

passed down from generation to generation. Obey these command-

ments, and it shall go well with you, with your bar chart, and with your mind 

map. So let it be written; so let it be done.

I. Thou Shalt Frequently 
Saveth Thy Work

Every two or three minutes, press Ctrl+S. It takes only a second to save your 

file, and you never know when you’ll be the victim of a rotating power outage 

(even if you don’t live in California).

II. Thou Shalt Storeth Each Drawing 
in Its Proper Folder

Whenever you save a file, double-check the folder that you’re saving it to. It’s 

all too easy to save a presentation in the wrong folder and then spend hours 

searching for the file later. You’ll wind up blaming the computer for losing 

your files.
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III. Thou Shalt Not Abuseth Thy 
Program’s Formatting Features

Yes, SmartDraw lets you set every word in a different font, use a different 

color for every shape in your drawing, and fill every last pixel of empty space 

with clip art culled from the thousands of images that you can find within 

the symbol libraries. If you want your business graphics to look like ransom 

notes, go ahead. Otherwise, keep things simple.

IV. Thou Shalt Not Stealeth 
Copyrighted Materials

Given a few minutes with Google or any other search engine, you can prob-

ably find just the right picture or snippet of clip art for any business graphic 

need that might arise. In fact, the Capture Web Image command on the 

Image tab makes it very easy to peruse the Web to find just the right image. 

But keep in mind that many of those pictures or clip art drawings are copy-

righted. Don’t use them if you don’t have permission.

V. Thou Shalt Abideth by Thy Scheme
SmartDraw hired a crew of out-of-work artists to pick the colors for the 

design themes and create beautifully crafted templates. Humor them. 

They like it when you use their stuff. Don’t feel chained to the prepackaged 

designs, but don’t stray far from them unless you have a good artistic eye.

VI. Thou Shalt Choose Thy 
Templates Wisely

When you create a new drawing in SmartDraw, you have a portfolio of nearly 

2,000 templates to choose from. Surely one of these templates is similar to 

the drawing that you’re attempting to create. Investing a few minutes up front 

looking for the right template to base your drawing on can save you hours of 

tedious work down the road. 
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VII. Keep Thy Computer Gurus Happy
If you have a friend or co-worker who knows more about computers than you 

do, keep that person happy. Throw him or her an occasional Twinkie or a bag 

of Cheetos. Treat computer nerds as if they’re human beings. After all, you 

want them to be your friends.

VIII. Thou Shalt Backeth Up 
Thy Files Day by Day

Yes, every day. One of these days, you’ll come to work only to discover a 

pile of rubble where your desk used to be. A FEMA agent will set up a wire-

less network in a tent, but he’ll just laugh when he sees what’s left of your 

computer’s keyboard. But if you back up every day, you won’t lose more 

than a day’s work. (At least, if you are careful to take the backups home with 

you every day. It doesn’t do you much good to back up your files religiously 

every day, but then leave the backups sitting right next to the computer. The 

fire that consumes your building will devour not only your computer but also 

your only backup.)

IX. Thou Shalt Fear No Evil, for 
Ctrl+Z Is Always with Thee

March ahead with boldness. Not sure what a button does? Click it! Click it 

twice if it makes you feel powerful! The worst that it can do is mess up your 

drawing. If that happens, you can press Ctrl+Z to set things back the way they 

should be.

 If you really mess things up, just close the drawing without saving. Then, open 

the previously saved version. After all, you did obey the first commandment, 

didn’t you?
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X. Thou Shalt Not Become Obsessed
Drawing programs have a way of bringing out the monk in us. It takes just a 

few minutes to copy some shapes from a symbol library and arrange them 

into roughly the layout your business graphic needs. But it’s very tempting 

to then spend a few hours experimenting with every possible combination of 

gradient fill, bevel or shine effects, and so on.

The good news is that SmartDraw has all kinds of features to make sure that 

everything in your drawing is lined up just right, spaced out evenly, and for-

matted attractively. Let SmartDraw do the hard work of attending to these 

little details. But don’t waste a lot of time tweaking every last snippet of your 

drawing to make sure everything is absolutely perfect.

One of the great strengths of SmartDraw is that it lets you quickly create busi-

ness graphics that look really good. You diminish that benefit if you spend an 

hour putting together a graphic that scores a 9.5 on some imaginary aesthetic 

score card, then spend another three hours trying to get it to 9.8. The extra 

time just isn’t worth the effort.
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Ten Odd and Unusual SmartDraw 
Templates

As we’ve said many times throughout this book, SmartDraw comes with 

nearly 2,000 templates that you can choose from to serve as the start-

ing point for your own creations.

With so many templates to choose from, it’s no surprise that some of them 

are a little . . . well, odd. Unusual at the least. And so, with no further ado, this 

chapter presents ten of our favorite oddball templates that are included with 

SmartDraw. You may never need any of these templates, but it’s comforting 

just to know that they’re there.

Nominating a Supreme Court Justice!
Template Name: Flowchart — Nomination & Confirmation Process

Where to Find It: Flowcharts➪Examples

If you’re ever elected POTUS (president of the United States), you’ll be happy 

to know that SmartDraw includes a template designed just for you. One of 

your most important jobs as chief executive will be to fill vacancies in the 

Supreme Court. When the opportunity arises, you’ll definitely want to consult 

this flowchart, shown in Figure 20-1.

 In our opinion, however, this template is lacking several key steps. For 

example:

 ✓ Nowhere does the flowchart indicate that the nominee has paid all of his 

or her past income taxes.

 ✓ Nowhere does the flowchart indicate that the nominee is disqualified if 

he or she has ever spoken on the phone to any governor from the state 

of Illinois, past or present.
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 ✓ Nowhere does the flowchart make the nominee promise that if he or 

she ever gets the opportunity to administer the oath of office to a future 

president, that he or she will actually read the oath from written notes 

rather than try to recite it from memory.

 

Figure 20-1: 
Flowchart — 

Nomina-
tion & 

Confirma-
tion 

Process.
 

If you find yourself in a position where you have a need for this template, we 

therefore suggest you add these items immediately. Or have your people add 

them for you.

The British Royal Family!
Template Name: Family Tree — British Royal Family

Where to Find It: Family Trees➪Examples

If ever there was a time when it was vital to keep up with the British Royal 

Family, now is it. And so, SmartDraw 2009 comes equipped with a template 

that documents the family tree of the British Royal Family, as shown in 

Figure 20-2.
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Unfortunately, the family tree doesn’t include a feature that tracks gossip 

about the royals, which is unfortunate because gossip is the primary reason — 

if not the only reason — that anybody actually cares.

 

Figure 20-2: 
Family Tree 

— British 
Royal 

Family.
 

 We do have one suggestion that might make this template more useful. Using 

the hyperlink feature described in Chapter 18, you could turn each of the 

boxes in the family tree into a link that would open a Google page that dis-

plays news stories for the selected royal. For example, to add such a link to 

the Prince William box, you could go to the Google page, do a search on Prince 
William gossip, and then create a hyperlink using the address of the results 

page.

Then you’d have something useful!

Chapter 13 Bankruptcy!
Template Name: Too many to list here

Where to Find Them: Accounting & Finance➪Chapter 13 Bankruptcy

Maybe it’s a sign of the times, but it seems that one of the biggest single cat-

egories in the entire SmartDraw template collection includes the templates 

for helping you file bankruptcy.
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Among the templates are flowcharts, forms, checklists, and mind maps that 

can help you with just about any step of the process. For example, Figure 20-3 

shows a mind map on how to classify debts. No wonder you have to hire a 

team of lawyers to file bankruptcy!

 

Figure 20-3: 
Just one 
of the 32 

bankruptcy-
related 

templates.
 

Just for your reference (because we know you want to know), here’s a com-

plete list of the bankruptcy templates:

Finding the Right Court Executory Contracts and Unexpired

Automatic Stay and Common   Leases

 Collection Actions Exempt Property

Avoiding Financial Problems Filing a Change of Address

Bankruptcy Code Sections Government Discrimination & 

Bankruptcy Estate  Bankruptcy 

Bankruptcy Forms Checklist Hardship Discharge

Budget How to File an Amendment

Chapter 13 Bankruptcy Process Median Family Income Chart

Classifying Debts Property Protected Against Money

Classifying Your Tax Debt Chart  Judgments

Common Codebtors 
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Consequences of a Property That Is Not Part of Your

 Dismissed Case  Bankruptcy Estate

Creditor Debts That Are Not Property Typically Not Exempt

 Discharged Under Hardship Real Property Interest

Debt Relief Agencies — Mandatory Reasonably Necessary Expenses

 Disclosures and Notices Sources of Bankruptcy Law

Debt Relief Agencies When Automatic Stay Does Not  

Debts That Are Not Discharged  Apply

 Under Hardship When Automatic Stay Protects  

Debts That Are Not Discharged  Against Evictions

Family Holiday Newsletters!
Template Name: Family Holiday Newsletter — 1 and 2

Where to Find It: Flyers➪Newsletters

Don’t you love those holiday newsletters from your friends who seem to be 

so much happier and better adjusted than you are? We know you’ve always 

wanted to send a holiday newsletter of your own but just haven’t had the 

right software to do it. Now, with SmartDraw, you can. Just use one of the 

two Family Holiday Newsletter templates, as shown in Figure 20-4.

The Family Holiday Newsletter template recommends that you replace the 

crude sketch of the happy family in the center of the page with a photo of 

your own. But be honest — wouldn’t it be more fun to leave the original 

sketch in place?
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Figure 20-4: 
A family 
holiday 

newsletter!
 

Coloring a Turtle!
Template Name: Math Activity — Coloring

Where to Find It: Education➪Subject — Math & Physics

If you ever get bored with the diagrams of atomic elements or the equations 

for calculating things such as the length of an arc, you can relax by coloring 

the friendly turtle in this template. See Figure 20-5.

If the turtle was already colored in when you bought this book, please return 

it to the bookstore and demand an unused copy so you can color the turtle 

yourself.
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Figure 20-5: 
Color the 

turtle!
 

Designing a Power Plant
Template Name: Power Plant Cycle

Where to Find It: Engineering➪Examples

Whether you’re an engineer working on a new power plant design or a 

member of congress trying to decide how to spend a trillion dollars on a new 

energy policy, you’ll love the power plant template shown in Figure 20-6. 

What you’ll like best about it is that it omits the only really important part in 

the design of any actual power plant: a source of energy!

The diagram clearly shows how water moves through the boiler, which turns 

it into steam, which drives the turbine, which turns the generator, which 

makes electricity. But it conveniently omits the part about where the energy 

to drive the boiler comes from. It could be coal spewing forth tons of par-

ticulate matter, solar panels covering hundreds of acres of wetlands, nuclear 

energy with a half-life of a billion years, or thousands of huge wind turbines 

placed right in the path of rare endangered migratory birds who need to be 

stopped anyway before they get sucked into an airplane engine.

Or maybe it’s just a cold-fusion plant, or just an ordinary old-fashioned per-

petual motion machine.

Either way, Al Gore probably invented it.
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Figure 20-6: 
The power-
less power 

plant.
 

Washing Your Hands
Template Name: Training — Hand Washing

Where to Find It: Storyboards➪Examples

Did you ever come to the dinner table when you were a kid with an unusu-

ally inordinate amount of grime on your hands, and your mother promptly 

grabbed you by the ear, walked you to the bathroom, and, without saying a 

word, scrubbed you hands almost until your skin fell off?

You mother could have just used the Hand Washing training storyboard tem-

plate, shown in Figure 20-7. This template provides a nice introduction to the 

art of hand washing, filled with important but often overlooked details such 

as holding your hands lower than your elbows and, once your hands have 

been rinsed, allowing the water to drip into the sink before drying your hands 

with a towel.
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Figure 20-7: 
How to 

wash your 
hands.

 

Comparing Video Games
Template Name: Gaming Systems

Where to Find It: Marketing Charts➪Feature Comparisons

In case you ever find yourself wondering which of several vintage video game 

systems (circa 2001) you should purchase, it is comforting to know that a 

detailed comparison of the most popular video game systems from that era 

has been assembled for you in the Gaming Systems template, as shown in 

Figure 20-8.

 

Figure 20-8: 
Video game 

systems 
compared.
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Comparing Coffee Shops
Template Name: Coffee Shop Comparison

Where to Find It: Marketing Charts➪Venn Diagrams

You never know when you might need to make a decision about which of 

three nearby coffee shops you should frequent. For example, one coffee shop 

might have a great atmosphere, but the others might use better ingredients.

A Venn Diagram is perfect for helping you see what the three coffee shops 

have in common and how they differ. Simply put, a Venn Diagram shows the 

relationships by categorizing items into a series of overlapping circles. Items 

that are common between two or more of the categories are drawn in the 

areas where the circles overlap.

Fortunately, the template shown in Figure 20-9 provides a starting point 

you can use to create your own Venn Diagrams to compare your own coffee 

shops.

 

Figure 20-9: 
Comparing 

coffee 
shops.
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Staying after School
Template Name: Detention Form

Where to Find It: Education➪Performance Forms

Among the many different forms that are available in SmartDraw’s pre-

defined templates is the Detention form, shown in Figure 20-10.

If your kid has detention a lot, you can set this up so that the top line already 

has his name written in.

 

Figure 20-10: 
Detention!
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Chapter 21

Ten Tips for Creating 
Great Graphics

This chapter presents ten, more or less random, tips and pointers that can 

help you create great graphics. These tips aren’t in any particular order 

of priority or importance; they’re all equally important and should be consid-

ered for every drawing you create.

Keep the Design Simple
In general, this guideline advises you to limit the number of variations in your 

design elements. In particular

 ✓ Avoid using too many different colors, or colors that clash and thus 

draw attention to themselves. The predefined, professionally chosen 

color schemes in SmartDraw have been carefully selected to create 

drawings that are easy on the eyes. If you venture from these colors, do 

so with care.

 ✓ Just because your computer has a thousand fonts installed on it doesn’t 

mean you should use them all in a single drawing. In fact, we recom-

mend you use only one font throughout your entire drawing, and avoid 

using variations such as bold or italic unless absolutely necessary.

 ✓ Likewise with design effects. SmartDraw lets you apply many different 

types of shadows, reflections, glows, bevels, and so on. Use them 

sparingly.

 ✓ Keep the background simple. Usually, the background should just be a 

simple color or a subtle gradient. If you must use a photograph for the 

background, consider adding transparency to make the background 

image subtle. For example, consider the background picture in the chart 

shown in Figure 21-1. This picture is muted so that it doesn’t draw atten-

tion away from the chart’s data.
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Figure 21-1: 
Effective 
use of a 

background 
picture.

 

Eliminate Extraneous Details
A few months ago, Doug helped plan a mass migration at his office: nearly 

30 employees were moved from their current offices or cubicles to different 

offices and cubicles, as part of a company reorganization.

The plan for this move was crafted by adding a layer over the top of the office 

floor plan that the building’s architects originally drew in AutoCAD. But soon 

he discovered that the floor plan had a lot of detail on it that wasn’t relevant 

to the move, like chairs and filing cabinets, room numbers (even the hallways 

have room numbers), and so on. So he replaced the detailed AutoCAD floor 

plan with a SmartDraw crude schematic. This schematic had the offices and 

cubicles positioned correctly, relative to each other, but it made no attempt 

to be architecturally correct. Instead, each office or cubicle was shown as a 

simple rectangle, with just the employee’s name.

The end result did a much better job of conveying who was moving where.

Get the idea? It’s tempting to include a lot of unnecessary detail in your busi-

ness graphics. Sometimes this detail just already exists, so you have to take 

extra steps to remove it. But more often, the detail is there because you went 

out of your way to put it in, because you have the mistaken notion that the 

more details you include, the more successful you’ll be at making your point.

In many cases, just the opposite is true.
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Look for Compelling Alternatives 
to Basic Shapes

Sometimes, you can use a picture to convey meaning more effectively than 

a simple rectangle. For example, Figure 21-2 is a simple bar chart that shows 

how much beer various countries around the world consume. But the bars 

usually used in a bar chart have been replaced by glasses of beer. The more 

beer the country consumes, the bigger the glass.

 

Figure 21-2: 
Effective 

use of a pic-
tures rather 
than bars in 
a bar chart.

 

SmartDraw is especially good at creating picture charts like this. For more 

information, see Chapter 10.

Be careful, however, not to go overboard with this idea. For it to work, you 

must have a picture that scales well and appropriately represents the quanti-

ties your chart illustrates.

Also, be aware that this guideline applies to many other types of drawings, 

not just charts. For example, suppose you’re working on a flowchart for an 

order fulfillment process that includes a credit card validation step. You 

could use an image of a credit card rather than a simple rectangle to repre-

sent this step — provided, of course, that the image doesn’t obscure the text 

that appears within the shape.

Be Consistent
Consistency is an important key to creating professional-looking graphics. 

For starters, you should be consistent in the formatting you apply to the 

shapes in your drawing. If you want to use effects such as shadows or reflec-

tion, use them consistently throughout the drawing.
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In addition, use consistent wording in the text that appears in your drawings. 

One sure sign of an amateur graphic is wording that is grammatically incon-

sistent. Consider these items that might appear in a mind map:

 ✓ Profits will be improved

 ✓ Expanding markets

 ✓ Reducing the amount of competition

 ✓ Production increase

Each item uses a different grammatical construction. Now consider the same 

points made with consistent wording:

 ✓ Improved profits

 ✓ Expanded markets

 ✓ Reduced competition

 ✓ Increased production

Focus on the Title
In most business drawings, the title is either the first item the viewer sees or 

the item the viewer settles on quickly after scanning the graphic. Therefore, 

you should pay careful attention to your title’s phrasing. It should immedi-

ately put the graphic into context and convey your intended message.

For example, consider the following titles for a chart that shows how many 

animals have been euthanized in animal shelters in the United States each 

year for a ten-year period:

 ✓ Annual Euthanasia in Animal Shelters (U.S.)

 ✓ Trends in Animal Euthanasia By Year

 ✓ The Euthanasia Crisis

The first two titles are technically precise, but they simply describe the 

content of the chart rather than convey a message. The third title conveys a 

message: We’re euthanizing too many dogs and cats. (If the title is ambiguous 

because it doesn’t mention animals specifically, you could solve that prob-

lem by using a muted picture of a dog as the chart background, rather than 

adding words to the title.)
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Choose the Right Type of 
Graphic for Your Purpose

This might sound obvious, but sometimes it’s a challenge to decide exactly 

what type of graphic best conveys your message and accomplishes your pur-

pose. This is especially true with charts: Should you use a bar chart, a line 

chart, an area chart, or a stacked bar chart? How should you group the data 

into series and categories?

There is no one right answer to this question. The answer depends entirely on 

the message that you’re trying to communicate and your reason for commu-

nicating it. Sometimes, the only way to know for sure is to try several different 

variations of your chart to see which one best communicates your intended 

message. Fortunately, SmartDraw makes it easy to change chart types.

Of course, before you can choose the right graphic for your purpose, you 

must be clear about what that purpose is. Suppose you’ve created a dia-

gram that shows the key features of your company’s new, improved deluxe 

model ChronoSimplastic Infindibulator. Never forget that your graphic’s real 

purpose isn’t to tell your audience that the new $65 million version of the 

Infindibulator has a completely redesigned Flux Capacitor. Rather, your pur-

pose is to get them to buy one.

Never forget the purpose of your drawing.

Consider the Audience
Always consider who the audience for your graphic is before you start. Are 

they detail-oriented engineers, or big-picture managers? Are they interested 

in the bottom line, or in the technical details? Are they skeptical of your 

intent, or are they on your side already?

After you’ve decided who the audience is, imagine how they’ll receive your 

graphic when they see it for the first time. What’s the first thing they’ll 

notice? Will they understand the title? Does it include terminology that isn’t 

familiar to them? Do you make assumptions that will confuse them?

Also, be sure to consider what unanswered questions your graphic might 

leave. Unanswered questions aren’t necessarily a bad thing, but you should 

try to anticipate them. Will the unanswered questions leave your audience 

skeptical, or curious?
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Give It the Hold-Your-Breath Test
This is one of our all-time personal favorite tips: Try holding your breath 

while you study your graphic. Its central message should become obvious 

before you start to turn blue. If it doesn’t, you need to either simplify your 

graphic or work out more.

You might think that this test works only for simple graphics with just a few 

elements. But we’d argue that the Hold-Your-Breath Test works well even 

for complicated graphics. For example, the main message of a complicated 

flowchart isn’t that, in Step 37, you need to send two copies of the requisition 

form to accounts payable; it’s that you have a carefully documented proce-

dure that employees should follow for this particular task. By the time you 

run out of breath and gasp for air, you should be able to identify the exact 

task that the flowchart documents, whether it’s relevant to you, and whether 

it appears to include an appropriate level of detail.

Give It the Squint Test
Here’s another way to validate for yourself your graphic’s impact: Stand back 

from it a bit and squint your eyes so it all goes out of focus. (Or, just take 

off your glasses.) This can help you focus on the big-picture balance of the 

graphic. Does your graphic still make sense when you can’t read the text or 

see all the fine details?

Show It to Someone Else
One final test of your carefully created business graphic remains: Show it 

to someone else. It’s always a good idea to get some objective feedback on 

your work.

We suggest that you start this review by letting your guinea pig look at the 

graphic for just 30 seconds or so. Then, take it away and ask the question, 

“What would you say is the most important, or central, message of the 

graphic?” If your colleague can’t come up with an answer, or comes up with 

an answer that you weren’t expecting, you learn that the graphic doesn’t 

effectively convey your basic message.

It’s also important, however, to allow a colleague to study your graphic in 

detail, looking for inconsistencies, errors, typographical errors, or things 

you’ve left out. A second set of eyes almost always discovers mistakes you’ve 

overlooked.
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Ten Things You Didn’t Think 
to Use SmartDraw For

SmartDraw is a business graphics program, so naturally the first thing 

you think of to use SmartDraw for is to create business graphics. But 

SmartDraw excels at creating many other types of graphics that you probably 

wouldn’t think of as business graphics.

As a result, this chapter presents ten or so nonbusiness projects where 

SmartDraw can definitely be of value. The ideas illustrated in this chapter 

should spark other ideas for your own novel ways to use SmartDraw.

Organizing Your Closet
Is your closet a mess? SmartDraw includes a template and a symbol library 

devoted especially to helping you organize your closet, as shown in Figure 

22-1. The Closet template (found in the Storage Design section) shows a typical 

closet space along with male and female figures to give you some perspective 

on size. And the Walls, Shelves & Cabinets symbol library provides symbols 

that you can use to design your closet space.

Here are a few tips to help you along with the process of organizing your 

closet:

 ✓ Measure your closet space carefully, and adjust the space shown in the 

closet template to match your actual closet.

 ✓ Start by emptying all of your clothes out of the closet and getting rid of 

everything you can. Donate to charity anything that’s worn out, doesn’t 

fit, or that you haven’t worn in years.
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Figure 22-1: 
Designing 

a closet.
 

 ✓ Fold items that are out of season and store them in a less accessible 

location.

 ✓ Buy or build some storage modules that are designed to store specific 

types of items, such as shoes, ties, and hats.

 ✓ Research organizing techniques on the Internet. The Web is full of 

advice for organizing your closets; just search organize closet and you’ll 

find dozens of sites packed with great advice.

Diagramming a Crime Scene
Are you addicted to crime shows? Always wanted to be a crime scene inves-

tigator? You’re in luck! You can get a special legal edition of SmartDraw that 

has templates and symbol libraries designed especially for diagramming 

crime scenes.
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Well, we suppose that if you can afford to actually purchase the legal edi-

tion, you could be just a wanna-be crime scene investigator, but more likely, 

you’re the real thing. But if you just want to dabble for your own amusement, 

you can download several example templates from the legal collection via the 

SmartDraw.com Web site. Just navigate your way to the Web site, click the 

Search button, and search for crime. You’ll find several sample templates you 

can download and examine, including the one shown in Figure 22-2.

 

Figure 22-2: 
Diagram-

ming a 
crime 

scene.
 

Planning a Wedding
Many aspects of wedding planning lend themselves well to SmartDraw’s 

capabilities. Here are just a few:

 ✓ You can plan the church layout using one of the Church floor plan 

templates.

 ✓ You can arrange the seating at the reception using one of the event hall 

floor plans or the Wedding Seating Chart template, shown in Figure 22-3.

 ✓ You can plan the menu using one of the menu templates found in the 

Flyers➪Menus category.
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Figure 22-3: 
Planning a 

wedding.
 

 ✓ You can create the wedding program using one of the templates in the 

Flyers➪Brochures category.

 ✓ If you need to create signs for the event, you can use one of the many 

signage templates located in the Flyers➪Signs category.

 ✓ You can use SmartDraw’s Live Map tool to create maps for your guests, 

pinpointing the locations of the church, reception hall, and even nearby 

hotels.

Remodeling Your Kitchen or Bathroom
Planning a kitchen or bathroom remodeling job? An architect will charge you 

an arm and a leg to do the design work. With SmartDraw, you can use any 

of the various kitchen or bathroom floor plan templates as a starting point 

to create your own remodeling plan. Figure 22-4 shows a SmartDraw kitchen 

design.
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Figure 22-4: 
Designing a 

kitchen.
 

 You’ll even find a page with tips for remodeling your kitchen with SmartDraw 

at the SmartDraw Web site. Just point your browser to www.smartdraw.
com/tutorials/kitchendesign.

As you work on a kitchen or bathroom remodeling project, we suggest that 

you take advantage of SmartDraw’s layers feature to keep different elements 

of your remodeling project on separate layers. For example, use one layer for 

the walls. Then, create another layer for the existing fixtures such as cabine-

try, islands, and so on. Use additional layers for plumbing, electrical, flooring, 

appliances, and other features you want to add.

In addition to creating a floor plan for your kitchen or bath, you can also 

use SmartDraw to diagram the cabinetry. For example, Figure 22-5 shows a 

kitchen cabinet design created with SmartDraw.

 

Figure 22-5: 
Designing 

kitchen 
cabinets.
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Planting a Garden
If you enjoy gardening, and have the space, you can use SmartDraw to help 

you create a simple layout for your garden. Start by creating a blank land-

scape layout. (Use the Blank Landscape template in the Landscaping sec-

tion of the New Document browser.) Then, rough-in your planting area, add 

a compass point (found in the Pins and Stickers symbol library) to remind 

yourself where the sun shines, and then start adding your crops.

Figure 22-6 shows a simple garden planted in four 3' x 12' raised beds, with 

tomatoes, onions, squash, and asparagus. Everything you need for a salad 

except the lettuce, the dressing, and the friends to share it with.

 

Figure 22-6: 
Planning a 

garden.
 

Planning Your School’s Science Fair
Let’s say that you’re in charge of your school’s science fair, and you’ll have 

the entire cafeteria at your disposal for the students to display their projects. 

SmartDraw is a great tool for planning how you’ll use the cafeteria space to 

arrange the students’ projects.
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Start by measuring the school cafeteria and noting the location of any doors 

and built-in furniture, the stage if there is one, and so on. While you’re at it, 

measure the size of the tables and get a count of how many are available 

to you.

Next, create a new drawing from the Banquet Room template, found in the 

Events and Hospitality section of the New Document browser.

Then, get rid of everything you don’t need for your science fair: all the buffet 

tables, the head table, the plants, and even the guest tables — but leave one 

guest table in place. Ungroup that table and delete all the place settings and 

the chairs, then resize the one remaining table according to the tables that 

are available to you.

Now zoom in close so you can work on that one table. Draw the exhibit space 

that you’ll allow for each student. (In Figure 22-7, we place four student 

exhibits on each 3' x 8' table.) Align the exhibit on one end of the table and 

then duplicate it for each end of the table. Now select everything on the table 

and group it. Then add a text box for each student’s name, select the table 

and the text boxes, and group again. You should now have a single object 

that represents each table’s layout.

Now turn your attention to the room. Resize the room according to the space 

you’ll be working in, and add or remove any doors and other permanent fix-

tures you’ll need.

 

Figure 22-7: 
Planning a 

science fair 
layout.
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After the room is the correct size, duplicate the table as many times as nec-

essary and arrange the tables into rows. Make sure you don’t use more than 

the number of tables that are actually available to you. Figure 22-7 shows a 

layout that allows for 64 student projects, arranged into four rows of four 

tables each.

When the tables are all arranged and aligned, select them all and then 

ungroup them. This separates the name text boxes from the tables so that 

you can type each student’s name in his or her correct location.

Creating a Menu
You might think of a menu as a simple word-processing application best done 

with Microsoft Word. Or if you want something more fancy, you could create 

it with Photoshop or a fancy design program like InDesign.

But it turns out that SmartDraw has several prebuilt templates that can help 

you create professional-looking menus. Figure 22-8 shows an example of one 

of these templates.

 

Figure 22-8: 
A menu 

template.
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 You can even find a page of tips for using SmartDraw in your restaurant busi-

ness at www.smartdraw.com/tutorials/restaurantdesign.

Coaching Your Kid’s Team
No matter what sport your kids find themselves playing, SmartDraw comes 

in handy if you want to help out with the coaching. You’ll find several pre-

defined templates for creating team rosters or keeping score at games. And 

you can easily create your own drawings to diagram plays, schedule the 

games for the season, plan a tournament bracket, and so on.

Figure 22-9 shows a simple drawing that outlines a football play, created with 

nothing more than a blank drawing template and the standard shapes and 

lines that are available from the main toolbar.

 

Figure 22-9: 
Diagram-

ming a 
football 

play.
 

Creating a Personalized Calendar
SmartDraw comes with a large collection of calendar templates, which you 

can easily find in the (you guessed it) Calendar section of the New Document 

tab in the Document Browser.

Several of these calendar templates include photos that you can easily 

replace with your own to create a custom calendar with pictures of you, your 

kids, and your strange relatives. For example, Figure 22-10 shows a calendar 

for March 2009 created from one of these templates.
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For more information about working with photographs in a SmartDraw draw-

ing, refer to Chapter 8.

 

Figure 22-10: 
A customized 

calendar.
 

Scaring Your Neighbors on Halloween
They say that as an adult your hobbies are often the things you never got to 

do as a kid. For me (Doug) it was building a haunted house. I create one every 

year at my home and scare the bejeebers out of hundreds of kids. We manage 

to scare a few of their parents too.

SmartDraw is a great tool for planning such an endeavor. Figure 22-11 shows 

how you might use a basic floor plan template to plan a haunted house in 

your garage. Here, I started with a base layer containing just the walls of the 

garage. Then I added a second layer containing the walls of the maze that 

will provide the structure for the haunted house. And finally I created a third 

layer to show where I will position the props and actors that will provide the 

scares.

For more information about creating floor plans like this, see Chapter 13.
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Figure 22-11: 
Planning 

a haunted 
house.
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Appendix

About the CD

System Requirements
Make sure that your computer meets the minimum system requirements 

shown in the following list. If your computer doesn’t match up to most of 

these requirements, you may have problems using the software and files on 

the CD. For the latest and greatest information, please refer to the ReadMe 

file located at the root of the CD-ROM.

 ✓ A PC running Microsoft Windows XP, Vista, or 2000

 ✓ 3GB of free hard disk space and a minimum of 256MB RAM

 ✓ An Internet connection

 ✓ A CD-ROM drive

If you need more information on the basics, check out these books from 

Wiley Publishing: PCs For Dummies, by Dan Gookin; Windows XP For Dummies 
and Windows Vista For Dummies, both by Andy Rathbone.

Using the CD
To install the items from the CD to your hard drive, follow these steps:

 1. Insert the CD into your computer’s CD-ROM drive.

  The license agreement appears.

  The interface won’t launch if you have autorun disabled. In that case, 

choose Start➪Run. (For Windows Vista, choose Start➪All Programs➪
Accessories➪Run.) In the dialog box that appears, type D:\Start.exe. 

(Replace D with the proper letter if your CD drive uses a different letter. 

If you don’t know the letter, see how your CD drive is listed under My 

Computer.) Click OK.

 2. Read through the license agreement and then click the Accept button 

if you want to use the CD.
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  The CD interface appears. The interface allows you to browse the con-

tents and install the programs with just a click of a button (or two).

What You’ll Find on the CD
The following sections are arranged by category and provide a summary of 

the software and other goodies you’ll find on the CD. If you need help with 

installing the items provided on the CD, refer to the installation instructions 

in the preceding section.

 ✓ Shareware programs are fully functional, free, trial versions of copy-

righted programs. If you like particular programs, register with their 

authors for a nominal fee and receive licenses, enhanced versions, and 

technical support.

 ✓ Freeware programs are free, copyrighted games, applications, and utili-

ties. You can copy them to as many computers as you like — for free — 

but they offer no technical support.

 ✓ GNU software is governed by its own license, which is included inside the 

folder of the GNU software. There are no restrictions on distribution of 

GNU software. See the GNU license at the root of the CD for more details.

 ✓ Trial, demo, or evaluation versions of software are usually limited either 

by time or functionality (such as not letting you save a project after you 

create it).

Author-created material
Many of the examples of graphics, diagrams, maps, and charts provided in 

this book are located in the Author directory on the CD, and they work with 

Windows XP, Vista, and 2000 PCs. These examples correspond to the exam-

ples from the book. The structure of the Author directory is

Author/Chapter1
Author/Chapter2

Reference materials
We included the Encyclopedia of Business Graphics poster (in PDF 

format) that shows the most commonly used business graphics and in 

what context they are typically used. We includes four best practice 
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PowerPoint presentations, created with SmartDraw. There is a sample busi-

ness plan, training, marketing and life sciences presentation that you can 

use to jump start your creativity.

We also included four SmartDraw PDFs from the popular “Working Smarter” 

series that show you how to be a better manager, give better presentations, 

grow your startup company, or market your product or service more effec-

tively using business graphics.

You’ll find all these materials in the Reference Materials directory.

SmartDraw 2009
Trial version.

For Windows OS.

SmartDraw 2009 is the latest release of SmartDraw, by SmartDraw.com. This 

30-day trial version is a fully functioning version that allows you to follow 

along in the book if you don’t have SmartDraw 2009. For more information 

about SmartDraw, visit www.smartdraw.com.

Adobe Reader
For Windows OS.

To view and print and PDF documents on the CD, Adobe Reader is required. 

If you don’t have Reader installed, visit www.adobe.com.

PowerPoint Viewer
Trial version.

For Windows OS

Microsoft PowerPoint Viewer 2007 lets you view full-featured presentations 

created in PowerPoint 97 and later versions. For more information, visit www.
microsoft.com.
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Troubleshooting
We tried our best to compile programs that work on most computers with 

the minimum system requirements. Alas, your computer may differ, and 

some programs may not work properly for some reason.

The two likeliest problems are that you don’t have enough memory (RAM) 

for the programs you want to use, or you have other programs running that 

affect installation or running of a program. If you get an error message such 

as Not Enough Memory or Setup Cannot Continue, try one or more of the fol-

lowing suggestions and then try using the software again:

 ✓ Turn off any antivirus software running on your computer. Installation 

programs sometimes mimic virus activity and may make your computer 

incorrectly believe that it’s being infected by a virus.

 ✓ Close all running programs. The more programs you have running, the 

less memory is available to other programs. Installation programs typi-

cally update files and programs; so if you keep other programs running, 

installation may not work properly.

 ✓ Have your local computer store add more RAM to your computer. This 

is, admittedly, a drastic and somewhat expensive step. However, adding 

more memory can really help the speed of your computer and allow 

more programs to run at the same time.

Customer Care
If you have trouble with the CD-ROM, please call Wiley Product Technical 

Support at 800-762-2974. Outside the United States, call 317-572-3993. You can 

also contact Wiley Product Technical Support at http://support.wiley.
com. Wiley Publishing will provide technical support only for installation and 

other general quality control items. For technical support on the applications 

themselves, consult the program’s vendor or author.

To place additional orders or to request information about other Wiley 

products, please call 877-762-2974.
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• Numerics •
3D charts, 149–150

24-bit pictures, 117

• A •
accessing symbol libraries, 41–42

active layers

changing, 137–138

overview, 136

Add Category button, 156, 160

Add New Layer dialog box, 137

Add New Table dialog box, 107–108

Add Series button, 156, 160

adding

arrowheads, 49–50

boxes to organization charts, 190–191

captions, 242–244

categories, 159–160

columns to tables, 109

corners, 206–208

data points to live maps, 226–230

doors, 205–206

rows to tables, 109

series, 159–160

shapes, 32–33

shapes to fl owcharts, 179–181

shapes from SmartPanel, 39–42

text to drawings, 63–65

text to lines, 64–65

text to shapes, 64

text to symbols, 64

text to tables, 108

walls, 204–205

windows, 205–206

adjusting

active layers, 137–138

box format, 193–194

branch styles, 192–193

cell size, 110

chart direction, 191–192

chart types, 157–158

custom animation, 257

exposure, 134

grid settings, 61–62

order within layers, 140

printers, 74

ruler settings, 61–62

Adobe Illustrator (AI) fi le format, 118, 247

Adobe Reader, 307

aligning

shapes, 57–58

text, 69

altering

active layers, 137–138

box format, 193–194

branch styles, 192–193

cell size, 110

chart direction, 191–192

chart types, 157–158

exposure, 134

grid settings, 61–62

order within layers, 140

printers, 74

ruler settings, 61–62

Alternate process symbol, 171

animated graphics, 251–253

animating

charts, 166

drawings, 253–255

applying

bullet lists, 68–69

drawing borders, 242

gradients, 90–92

shadows, 97–99

texture, 92–93

themes, 33, 84–85

area charts, 146–147

arrays, creating, 52

arrowheads, 49–50
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audience considerations, 291

AutoCAD, 248

AutoFill feature, 106, 112–114

axes (chart), 162

Axes control, 156

• B •
backup, 273

bankruptcy templates, 277–279

bar charts, 19–20, 144–145

bevel effect, 100–101

bitmap images. See BMP (bitmap) images

BMP (bitmap) images

drawing program, 12

fi le format, 246

overview, 116–117, 246

Picture tab, 119–120

borders, 242

box format, 193–194

boxes

adding to organization charts, 190–191

deleting chart, 191

branch styles, 192–193

Brightness control, 119

Browse For Folder dialog box, 124

building

arrays, 52

basic organization charts, 187–189

custom colors, 89–90

dashed lines, 96

dependencies, 218

doubled lines, 96

fl oor plans, 200–201

fl owcharts, 176–178

image charts, 164–166

menus, 300–301

mind maps, 212–216

new charts, 150–155

new layers, 137

organization charts, 189–190

personalized calendars, 301–302

presentations, 258–262

refl ections, 99–100

simple drawings, 25–27

swim lanes, 185–186

symbol libraries, 123–124

tables, 106–108

text objects, 65

bullet list, 68–69

Bullets button, 68–69

business graphics, 9–11. See also graphics

• C •
calculating square footage, 204

calendars, creating, 301–302

captions, 242–244

Capture Web Image command, 

119, 128–130

cast shadows, 98

categories

adding, 159–160

removing, 159–160

switching, 159

CDR (CorelDraw) fi le format, 118

cells

adjusting size in tables, 110

joining in tables, 110–111

locking table, 114

splitting in tables, 110–111

table, 104

CGM (Computer Graphics Metafi le) fi le 

format, 118, 247

changing

active layers, 137–138

box format, 193–194

branch styles, 192–193

cell size, 110

chart direction, 191–192

chart types, 157–158

exposure, 134

grid settings, 61–62

order within layers, 140

printers, 74

ruler settings, 61–62

chart boxes, 191

Chart Label dialog box, 163

Chart tab, 155–157

Chart Type button, 156
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chart values, 160–161

charts. See also organization charts

animating, 166

changing direction, 191–192

changing types, 157–158

Chart tab, 155–157

creating image, 164–166

creating new, 150–155

editing, 157–161

family trees, 196

formatting, 161–163

Gantt, 217–218

inserting into existing drawings, 152–153

overview, 143

project team, 195–196

rotating, 158

templates, 150–152

types, 144–150

checking spelling, 70–71

choosing

colors, 89

graphics, 291

shapes, 50–51

symbol libraries on SmartPanel, 40–41

clickable layers, 136

clipboard, 153–154

closing

drawings, 35–36

SmartDraw, 36

Coffee Shop Comparison template, 284

Collate option, 75

color

choosing, 89

creating custom, 89–90

depth, 117

fi lling shapes, 89–90

Color button, 67

columns

adding to tables, 109

deleting from tables, 109

Columns button, 105

combining table cells, 104

comparing SmartDraw to other programs, 

11–13

Computer Graphics Metafi le (CGM) fi le 

format, 118, 247

connecting lines, 182–183

Connector symbol, 174

connectors, drawing, 46–47

considering audience, 291

consistency, 289–290

Contrast control, 119

Convert to Table, 106

Convert to Text, 106

converting mind maps to Gantt charts, 

217–218

copying

drawings, 234

shapes, 51–52

copyrights, 272

CorelDraw (CDR) fi le format, 118

corners, adding, 206–208

country maps, 220

county maps, 220

Create a Hyperlink dialog box, 

267–268

Create Opening SmartPanel button, 208

creating

arrays, 52

basic organization charts, 187–189

custom colors, 89–90

dashed lines, 96

dependencies, 218

doubled lines, 96

fl oor plans, 200–201

fl owcharts, 176–178

image charts, 164–166

menus, 300–301

mind maps, 212–216

new charts, 150–155

new layers, 137

organization charts, 189–190

personalized calendars, 301–302

presentations, 258–262

refl ections, 99–100

simple drawings, 25–27

swim lanes, 185–186

symbol libraries, 123–124

tables, 106–108

text objects, 65

Crop button, 119
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cropping

drawings, 241–242

images, 133

cross-functional fl owcharts, 175–176

curved lines, 44

• D •
data

compression, 117

importing from Excel, 154–155

importing into maps, 227

pasting from clipboard, 153–154

Data button, 157

Data (Input/Output) symbol, 171

data labels (chart), 162–163

data points, 226–230

Database symbol, 172

decision box, 169

decision symbols

overview, 171

using, 182–183

Defi ne Footer dialog box, 77

Defi ne Layers dialog box, 139

Delay symbol, 173

Delete button, 105

deleting

chart boxes, 191

columns from tables, 109

rows from tables, 109

shapes, 185

dependencies, 218

design themes

applying, 33, 84–85

formatting, 84–87

overriding settings, 85–86

overview, 272, 287–288

detail, eliminating extraneous, 288–289

Detention Form template, 285

dimensions

defi ned, 199, 202

showing, 202–204

Disk storage symbol, 172

displacement, 49

Display symbol, 173

displaying

dimensions, 202–204

grid, 59–61

Distribute button, 105

Document Browser, 24–25

Document symbol, 171

doors, adding, 205–206

dots per inch (dpi), 116

dpi (dots per inch), 116

dragging graphics, 234–235

drawing area, 28

drawing(s). See also animated graphics; 

pictures

adding text, 63–65

animated PowerPoint, 256–258

animating, 253–255

applying borders, 242

basic shapes, 43

bitmap, 116–117

choosing, 291

closing, 35–36

connectors, 46–47

copying, 234

creating simple, 25–27

cropping, 241–242

editing, 32–34

editing in Word, 238–239

exporting to PowerPoint, 253–255

inserting charts into existing, 152–153

inserting pictures from, 124–130

lines, curved, 44

lines, freehand, 45–46

lines, straight, 43–44

opening existing, 35

pasting, 234

polygons, 47–49

printing, 73–74

printing multi-page, 78–79

printing parts of, 74–75

saving, 246–248

sizing, 241

stretching, 241

tips, 287–292

transferring to Microsoft Offi ce, 233–238

wrapping text around, 239–240
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drop shadows, 98

dropping graphics, 234–235

DRW fi le format, 118, 247

duplicating

drawings, 234

shapes, 51–52

DWG fi le format, 118

DXF fi le format, 118, 247

• E •
editing

chart values, 160–161

charts, 157–161

drawings, 32–34

shapes, 32

text, 32, 65–66

effects, 83

Effects button, 96–97, 106

eliminating extraneous detail, 288–289

EMF (Enhanced Windows Metafi le) fi le 

format, 118, 246

End symbol, 170

EPS (Encapsulated Postscript) fi le format, 

118, 247

Excel, importing data from, 154–155

exiting

drawings, 35–36

SmartDraw, 36

Export dialog box, 245

Export to HTML Files dialog box, 264

Export Org Chart as Text dialog box, 

216–217

exporting

drawings to PowerPoint, 253–255

to HTML, 263–266

to Microsoft Offi ce, 237–238

outlines, 216–217

to PDFs, 245–246

exposure, 134

extension lines, 203–204

• F •
Family Holiday Newsletter—1 and 2 

template, 279–280

Family Tree—British Royal Family 

template, 276–277

family trees, 196

Fill command, 87–94, 106

fi lling

overview, 83

shapes, 87–94

Find and Replace dialog box, 66

fl ipping shapes, 54

fl oating library, 42

Floor Plan (Metric) option, 61

Floor Plan (Standard) option, 61

fl oor plans

adding corners, 206–208

adding doors, 205–206

adding walls, 204–205

adding windows, 205–206

creating, 200–201

defi ned, 10

features, 198–199

opening walls, 208

overview, 20–21, 197–198

showing dimensions, 202–204

Flowchart—Nomination & Confi rmation 

Process template, 275–276

fl owcharts

adding shapes, 179–181

connecting lines, 182–183

creating, 176–178

creating swim lanes, 185–186

cross-functional, 175–176

decision box, 169

decision symbols, 182–183

defi ned, 10, 167

deleting shapes, 185

detail, 169

hyperlinks, 267

keyboard shortcuts, 181

overview, 15, 167–170

process box, 169

SmartPanel, 179–180

splitting paths, 183–184

symbols, 170–175

folders, 271

fonts, setting text, 66–67

Format Table dialog box, 111
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Format Table option, 106

formats

bitmap picture fi le, 117

save, 246–248

vector fi le, 118

formatting

charts, 161–163

design themes, 84–87

features, 272

lines, 94–96

table cells, 104

tables, 111

freehand lines, 45–46

freeware programs, 306

Freeze Properties command, 85–86

Freeze Properties dialog box, 86

From Camera control, 119

From Clipboard control, 156

From File control, 156

• G •
Gaming Systems template, 283

Gantt charts

converting mind maps to, 217–218

defi ned, 10

overview, 17–18

getting pictures

from cameras, 121–123

into drawings, 124

GIF (Graphics Interchange Format) fi le 

format, 117, 247

gloss effect, 101–102

glow, 100

Google Maps, 224

gradient fi ll, 90–91

gradients, applying, 90–92

Graphics Interchange Format (GIF) fi le 

format, 117, 247

grid

changing settings, 61–62

lines (chart), 163

showing, 59–61

snapping to, 61

Grid button, 106, 156

group, 55

grouping shapes, 55–56

guides, 59

• H •
hatch, 93–94

help, 37–38, 273

Hewlett-Packard Graphics Language 

(HPGL) fi le format, 118

HGL fi le format, 247

Hold-Your-Breath Test, 292

Horizontal Axis button, 157

HTM fi le format, 247

HTML (Hypertext Markup Language), 

exporting to, 263–266

hyperlinks

defi ned, 266

inserting, 266–268

• I •
Illustrator (Adobe), 247

image charts, 164–166

importing

camera images into symbol libraries, 

121–123

data from Excel, 154–155

data into maps, 227

including pictures in organization charts, 

193–194

infrared sensor, 252

Input symbol, 172

Insert Above option, 105

Insert Below option, 105

Insert Left option, 105

Insert menu, 235–237

Insert Picture dialog box, 125–126

Insert Right option, 105

Insert Symbol dialog box, 68

inserting

charts into existing drawings, 152–153

hyperlinks, 266–268

images into shapes, 126–128

pictures from library, 125
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single images, 125–126

special symbols, 68

inside shadows, 98

interface, user, 27–30

Internal storage symbol, 175

• J •
Join Cells option, 105

joining cells in tables, 110–111

JPEG fi le format, 117, 247

JPG fi le format, 117, 247

• K •
keyboard shortcuts, 181

• L •
launching

existing drawings, 35

Library panel, 42

SmartDraw, 23–24

layered area charts, 147–148

layers

active, 136–138

changing order within, 140

creating new, 137

defi ned, 135

fl oor plans, 199

managing, 138–139

moving objects between, 139–140

overview, 135–136

layout, page, 77–79

Legend button, 156

legends (chart), 162

length label, 199

Library panel, 42

line charts, 146

Line Spacing button, 70

lines

adding text, 64–65

connecting, 182–183

creating dashed/doubled, 96

drawing connectors, 46–47

drawing curved, 44

drawing freehand, 45–46

drawing straight, 43–44

extension, 203–204

formatting, 94–96

overview, 83

setting thickness, 95

spacing, 70

Live Maps

adding data points, 226–230

overview, 222–225

locking table cells, 114

Loop limit symbol, 173

• M •
Macintosh, 249

Magnetic tape symbol, 172

main toolbar, 28–29, 31

main topic, 210

managing layers, 138–139

Manual operation symbol, 173

maps

importing data into, 227

templates, 219–222

margins, setting, 78

Math Activity—Coloring template, 280–281

Max button, 157

measuring square footage, 204

megapixel, 116

Metric button, 61

Microfi lm symbol, 172

Micrografx Designer/Draw (DRW) fi le, 247

Microsoft Offi ce

exporting to, 237–238

PowerPoint Viewer, 307

transferring drawings to, 233–238

Microsoft Word, editing graphics in, 

238–239

Min button, 157

mind maps

converting to Gantt charts, 217–218

creating, 212–216

exporting outlines, 216–217

organization charts compared with, 

210–212
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mind maps (continued)

outlines compared with, 210–212

overview, 18–19, 209–210

relationship with brain, 212

types of boxes, 210

More Symbols dialog box, 41

moving objects between layers, 139–140

Multi-Document symbol, 171

• N •
name of layers, 136

New button, 156

New Drawing button, 206

Note symbol, 174

• O •
Object dialog box, 235–236

objects, moving between layers, 139–140

obtaining pictures

from cameras, 121–123

for drawings, 124

Off page down symbol, 174

Off page left symbol, 175

Off page right symbol, 175

Off page storage symbol, 175

Off page up symbol, 174

Offi ce (Microsoft)

exporting to, 237–238

PowerPoint Viewer, 307

transferring drawings to, 233–238

Open Picture button, 119

opening

existing drawings, 35

Library panel, 42

SmartDraw, 23–24

walls, 208

options

Collate, 75

print, 76–77

setting HTML, 265

Or symbol, 174

order of layers, 136

organization charts

adding boxes, 190–191

changing box format, 193–194

changing branch style, 192–193

changing direction, 191–192

compared with mind maps, 210–212

creating, 189–190

creating basic, 187–189

defi ned, 10

deleting boxes, 191

family trees, 196

including pictures, 193–194

overview, 15–17

project team, 195–196

orientation, setting, 78

outlines

exporting, 216–217

mind maps compared with, 210–212

overlapping shapes, 54–55

overriding theme settings, 85–86

• P •
page layout, setting, 77–79

Page Setup dialog box, 78

Pan & Zoom control, 119

panning images, 130–132

Paper tape symbol, 173

pasting

data from clipboard, 153–154

drawings, 234

paths, splitting, 183–184

PCX fi le format, 117, 247

PDF (Portable Document Format)

exporting to, 245–246

overview, 118, 247

Picture Folder control, 119

Picture tab, 119–120

pictures. See also images

bitmap, 116–117

inserting from drawings, 124–130

inserting from library, 125

inserting in symbol libraries, 120–124

overview, 115–116

vector, 118

Web site, 128–130
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pie charts, 148–149, 156

pixels, 116

PNG (Portable Network Graphics) fi le 

format, 117, 247

polygons, 47–49

Portable Document Format (PDF)

exporting to, 245–246

overview, 118, 247

Portable Network Graphics (PNG) fi le 

format, 117, 247

portrait, 78

positions, shape, 56–57

Power Plant Cycle template, 281–282

PowerPoint (Microsoft Offi ce)

animated drawings, 256–258

exporting drawings to, 253–255

Viewer, 307

Preparation symbol, 173

presentations, creating, 258–262

Print dialog box, 73–74

print options, 76–77

Print Preview command, 75–76

printing

changing printers, 74

drawings, 73–74

multi-page drawings, 78–79

multiple copies, 75

parts of drawings, 74–75

Printing Partner button, 79–80

process box, 169–170

project chart, 17–18

project team charts, 195–196

Punched card symbol, 172

• Q •
Quick Layouts control, 156

• R •
Reader (Adobe), 307

refl ections, creating, 99–100

relative value charts, 149

relay board, 252

removing series/categories, 159–160

resolution, 116

retrieving maps from Google Maps, 224

RGB values, 90

Rotate Chart button, 156, 158

rotating

charts, 158

shapes, 52–53

rows

adding to tables, 109

deleting from tables, 109

Rows option, 105

ruler

changing settings, 61–62

overview, 59

• S •
sales maps, 220

saving

for AutoCAD, 248

drawings, 246–248

frequency, 271

graphics, 34

for Mac, 249

scrolling, SmartPanel, 40

Select Texture dialog box, 93

selecting

colors, 89

graphics, 291

shapes, 50–51

symbol libraries on SmartPanel, 40–41

Selection button, 50

series

adding, 159–160

removing, 159–160

switching, 159

Set Line or Border Thickness dialog 

box, 95

Set Photo Destination dialog box, 122

Set Photo Source dialog box, 122

Set Printing dialog box, 77

Set Rulers and Grids dialog box, 62

setting

grid, 61–62

HTML options, 265
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setting (continued)

line thickness, 95

margins, 78

orientation, 78

page layout, 77–79

position and size for shapes, 56–57

print options, 76–77

ruler, 61–62

text fonts, 66–67

shadows, applying, 97–99

shape effects

bevel effect, 100–101

gloss, 101–102

glow, 100

overview, 96–97

refl ections, 99–100

shadows, 97–99

shapes

adding, 32–33

adding to fl owcharts, 179–181

adding from SmartPanel, 39–42

adding text, 64

aligning, 57–58

alternatives to, 289

deleting, 185

drawing basic, 43

duplicating, 51–52

editing, 32

fi lling, 87–94

fi lling with color, 89–90

fl ipping, 54

fl owchart, 170–175

grouping, 55–56

inserting images into, 126–128

overlapping, 54–55

rotating, 52–53

selecting, 50–51

setting position and size, 56–57

spacing, 58

shortcuts, keyboard, 181

Show Data Table control, 156

Show Dimensions dialog box, 203

showing

dimensions, 202–204

grid, 59–61

Single-Click toolbar, 29

size, shape, 56–57

sizing drawings, 241

SmartDraw

capabilities, 14–21

compared with other drawing programs, 

11–13

features, 13

SmartDraw button, 29

SmartHelp, 25, 37–38

SmartPanel

adding shapes from, 39–42

choosing symbol libraries on, 40–41

Floor Plan, 201

overview, 30

scrolling, 40

SmartTemplates, 25

snapping to grid, 61

sound board, 252

spacing

lines, 70

shapes, 58

spell checker, 70–71

Split Cells button, 105

splitting

cells in tables, 110–111

paths, 183–184

stacked bar charts, 145–146

Standard option, 61

Start symbol, 170

starting

existing drawings, 35

Library panel, 42

SmartDraw, 23–24

Stored data symbol, 171

storyboard, 258

straight lines, 43–44

stretching drawings, 241

Subroutine symbol, 172

subtopic, 210

Summing junction symbol, 174

Swap Series & Categories button, 156

swim lanes

creating, 185–186

defi ned, 175
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switching series/categories, 159

symbol libraries

accessing, 41

creating, 123–124

fl oor plan, 199

importing camera images, 121–123

overview, 120

symbols

adding text, 64

decision, 182–183

inserting special, 68

• T •
Table button, 105

Table tab, 105, 119

tables

adding columns, 109

adding rows, 109

adding text, 108

adjusting cell size, 110

creating, 106–108

deleting columns, 109

deleting rows, 109

formatting, 111

joining in tables, 110–111

locking cells, 114

overview, 103–106

splitting in tables, 110–111

tabs

Chart, 156–157

Table, 119

Tagged Image File Format (TIFF) fi le 

format, 117, 247

templates

bankruptcy, 277–279

charts, 150–152

Coffee Shop Comparison, 284

Detention Form, 285

Family Holiday Newsletter—1 and 2, 

279–280

Family Tree—British Royal Family, 

276–277

Flowchart—Nomination & Confi rmation 

Process, 275–276

Gaming Systems, 283

maps, 219–222

Math Activity—Coloring, 280–281

overview, 272

Power Plant Cycle, 281–282

Training—Hand Washing, 282–283

text

adding to drawings, 63–65

adding to lines, 64–65

adding to shapes/symbols, 64

adding to tables, 108

aligning, 69

editing, 32, 65–66

objects, 65

setting fonts, 66–67

wrapping, 104

wrapping around drawings, 239–240

Text Alignment button, 69

Text Editing button, 106

Text Editing Properties dialog box, 108

Text Symbol button, 68

texture

applying, 92–93

defi ned, 92

themes

applying, 33, 84–85

formatting, 84–87

overriding settings, 85–86

overview, 272, 287–288

3D charts, 149–150

TIFF (Tagged Image File Format) fi le 

format, 117, 247

tips (graphics), 287–292

title, 162, 290

toolbars

main, 28–29, 31

Pan and Zoom, 131–132

single-click, 29

Work Area, 30

topic, 210

Training—Hand Washing template, 

282–283

transferring drawings to Microsoft Offi ce, 

233–238

Transmittal tape symbol, 173
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transparency, 90

Trim to Shape button, 119

trimming images, 133

troubleshooting, 308

TrueColor pictures, 117

24-bit pictures, 117

• U •
user interface, 27–30

• V •
vector drawing program, 12

vector formats, 118

verifying spelling, 70–71

Vertical Axis control, 157

visible layers, 136

• W •
walls

adding, 204–205

opening, 208

windows, adding, 205–206

WMF (Windows Metafi le) fi le format, 

118, 246

Word (Microsoft Offi ce), editing graphics 

in, 238–239

Work Area toolbar, 390

world maps, 220

wrapping text around drawings, 239–240

• Z •
zooming, 33–34, 130–132
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